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Introduction

This User Guide introduces you to the DKAdmin/DKBackup programs (previously called 
280Admin/280Backup) which support the Strata DK14, DK16e, DK40 and DK424 digital 
telephone systems.

Note DKAdmin/DKBackup Release 4 software supports Strata DK14, DK16e, DK40, 
DK280 and DK424 systems.

It guides you step-by-step to mastering the few simple procedures that enable you to fully 
utilize DKAdmin/DKBackup. With this accomplished, you will find DKAdmin/DKBackup to 
be invaluable tools.

Organization
This guide contains the following information:

♦ Chapter 1 – The Grand Tour gives you a general description of the capabilities, screen 
conventions and basic operations of the DKAdmin/DKBackup programs.

♦ Chapter 2 – Installing DKAdmin  shows you how to install DKAdmin onto your PC.

♦ Chapter 3 – Installing DKBackup shows you how to install DKBackup onto your PC.

♦ Chapter 4 – Using DKAdmin/DKBackup explains how to log on and off of DKAdmin/
DKBackup, as well as how to use the pull-down menus, view and respond to system 
messages, and understand the keyboard conventions.

♦ Chapter 5 – File Menu provides easy step-by-step instructions for using DKAdmin/
DKBackup to program and update the Strata DK, including procedures for both new and 
existing customers. The chapter also includes instructions on how to transfer data to a 
floppy disk.

♦ Chapter 6 – Administration Menu (DKAdmin)  provides complete how-to instructions 
on using the Administration Menu options (e.g., flexible key and speed dial programming, 
system/station and ACD administration, etc.).

♦ Chapter 7 – Backup Menu (DKBackup) provides detailed instructions on checking the 
processor type, backing up and restoring system data, and upgrading processors. This 
menu is only available in the DKBackup program. The options available on this men
Check Processor Type, Backup/Restore Data, and View/Print Data — also appear o
DKAdmin Administration Menu.

♦ Chapter 8 – Options Menu explains how to change basic system parameters, maintain 
your communication setup, view and print data, reindex files, and view system files.

♦ Appendix A – Connecting to Strata DK shows how to connect a DKAdmin/DKBackup 
PC to the Strata DK telephone system.
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♦ Appendix B – DK424 RCTUE/F Upgrade Using DKAdmin

♦ Appendix C – Considerations for Upgrading DK Systems to DK424 Release 4.0

♦ Index

Conventions
This guide uses the following conventions:

Note Elaborates specific items or references other information. Within some tables, General 
Notes apply to the entire table and numbered Notes apply to specific items.

Important! Calls attention to important instructions or information.

CAUTION! Advises you that hardware, software applications or data could be damaged
if the instructions are not followed closely.

Courier shows a computer keyboard entry or screen display. “Type” indicates
entry of text. “Press” indicates pressing the designated key. Example
both:

Type prog then press Enter.

+ shows a multiple PC keyboard or phone button entry. Entries without
spaces between them show a simultaneous entry. Example: 
Delete+Enter. Entries with spaces between them show a sequenti
entry. Example: # + 5.

~   means “through.” Example: 1 ~ 5.

➤ denotes the beginning of a procedure.

➤ denotes the step in a one-step procedure.

Letters in [brackets] represent buttons which have Directory Numbers on them. For exa

[DN] Directory Number button (also known as an Extension or Intercom 
Number).

[PDN] Primary Directory Number button (the extension Number for your 
telephone).

[SDN] Secondary appearance of a [PDN]. A [PDN] which appears on anoth
telephone is considered an [SDN].

[PhDN] Phantom Directory Number button (an additional Directory Number).

Screen Variations
The DKAdmin/DKBackup screens may vary from those shown in this document as sele
items are periodically modified.
viii DKAdmin/DKBackup



––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Related Documentation
Related Documentation
The following documents can be used to reference more information about the Strata DK 
systems.

♦ Strata DK Programming Manual provides all instructions necessary to program the 
system and system record sheets.

♦ Strata DK Installation & Maintenance Manual provides installation instructions for 
configuring and installing the Strata DK14, DK16e, DK40 and DK424. It also includes 
T1/DS-1 interface installation and configuration instructions and fault finding provides 
flowcharts to troubleshoot the systems, and user guides for stations and peripherals. An 
ACD Section provides instructions for installing ACD into the Strata DK424 and includes 
all ACD programming instructions and record sheets.

♦ Strata DK Library CD-ROM – contains all current Strata DK documentation and 
enables you to view, print, navigate and search publications.

How To Use This Manual
You can use this guide in a variety of ways, depending on your level of experience with the 
system and your assigned password level.

If you are a new user of DKAdmin/DKBackup, you should attempt to read this entire guide. It 
introduces you to all the features and procedures of the system and will enable you to begin 
working with DKAdmin/DKBackup quickly.

If you are proficient in using DKAdmin/DKBackup, you may still have questions from time-
to-time about a particular function or procedure. Use the Index to locate a subject or item that 
you may have questions about, or scan the Contents. 
ix
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The Grand Tour 1

Important!

● DKAdmin/DKBackup support all releases of the Strata DK14, DK16e, DK40, DK280, and 
DK424 (all processors). This guide refers to these systems as Strata DK systems.

● DKAdmin/DKBackup programs do not support Strata DK8, DK16, or any DK24/56/96 
releases.

The Toshiba Strata DK systems are powerful, state-of-the-art modular digital key/hybrid/PBX 
telephone systems offering customers outstanding performance and flexibility. The advanced 
technology behind the Strata DK enables customers to configure a system based on their 
current telecommunications requirements. Small systems can be expanded over time through 
the addition of flexible modular units. As needs expand, so does the Strata DK.

DKAdmin/DKBackup are interactive software applications with user-friendly menus and 
screens that let you program, update, back up and restore Strata DK.

DKAdmin/DKBackup are DOS programs that run on your IBM-compatible personal 
computer. Although they are not Microsoft® Windows® programs, you can run them as a DOS 
session under Windows and configure them with an icon in Program Manager (see your 
Windows manual).

Capabilities
DKAdmin/DKBackup make the installation, programming and support process easier and 
more efficient. Among other functions, you can:

♦ Program, update, back up, restore and upgrade all Strata DK system databases from your 
IBM-compatible personal computer rather than from a programming telephone.

♦ Support DK14, DK16e, DK40 RCTUA, RCTUB, RCTUBA/BB, RCTUC/D, RCTUE/F 
processors (all releases).

Note Whenever a DKAdmin/DKBackup screen refers to Strata DK Release 3.0, Release 3, 
etc., the function will also work with Strata DK Release 3.10. DK16e, Release 1 is 
equivalent to the RCTUA3 feature set but does not provide Distributed Hunt.

♦ Backup, restore and upgrade station features, port locations and Strata DK individual 
customer data programs. This includes:

♦ Station and system speed dial numbers

♦ User names

♦ Voice mail ID codes
1The Grand Tour



Basic Operations –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
♦ Voice mail message waiting ID codes

♦ Station and system speed dial memos

♦ Station and system LCD messages

♦ Station feature options

♦ CO line to station ringing and access assignments

♦ Flexible button assignments

♦ Directory number call forward status (Release 3 or above)

♦ Directory number message waiting status (Release 3 or above)

♦ ANI/Caller ID lost call telephone numbers (Release 3 or above)

♦ Display existing station and port data in ASCII format.

♦ Control certain system menu access through menu-specific user passwords.

♦ Use advanced search features to locate customers, features and programs.

♦ Backup, restore, and upgrade existing Strata DK programmed customer data.

♦ Transfer DK data to/from the database on the DKAdmin/DKBackup PC hard drive and/or 
programmed databases from one PC to another, using a floppy disk.

♦ Upgrade automatically to a larger processor.

Note A customer database (PRGALL) that is backed up from one type of processor can be 
upgraded to a larger type of processor, but not to a smaller one. For example, a 
PRGALL file that is backed up for RCTUB cannot be restored RCTUA but it can be 
restored (upgraded) to a RCTUC/D type processor. 

Basic Operations
The DKAdmin and DKBackup Main Menu consists of the following menus:

Note The Backup Menu consists of three functions also available on the DKAdmin 
Administration Menu.

DKAdmin DKBackup

File Menu File Menu

Administration Menu Backup Menu

Options Menu Options Menu
2 DKAdmin/DKBackup



–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Basic Operations
The table below lists the options for each menu. A check mark (✓) appears next to the 
functions which are available on that menu:

Table 1 Main Menu Options

Main Menu DKAdmin DKBackup

File Menu

Select Customer 
Select a customer for whom you wish to program or update Strata 
DK system data.

✓ ✓

Maintain Customer File 
Create a new customer or update an existing customer’s basic file 
information.

✓ ✓

Dial DK 
Automatically select (program displays the Customer List screen) 
and dial to connect to a customer’s Strata DK to upload/download 
data to/from your PC.

✓ ✓

Hangup Connection 
Disconnect an online connection between your DKAdmin PC and a 
customer’s Strata DK.

✓ ✓

Transfer DK Data 
Transfer Strata DK customer data to/from your PC hard disk drive to 
a floppy disk.

✓ ✓

About 
Displays the version number of the DKAdmin program. ✓ ✓

Exit 
Exit DKAdmin and return to the C:\ prompt (or Program Manager, if 
configured to run under Windows).

✓ ✓

DKAdmin Administration Menu—DKBackup Backup Menu

View Cabinet Diagram
Shows PCB placement per Program 03. ✓

Check Processor Type 
Pulls and displays the processor type, Release and ROM/Flash 
Memory version from the installed Strata DK RCTU PCB.

✓ ✓

System/Station Administration 
Maintain system and individual stations/port features. ✓

Flexible Button Programming Section 
Maintain flexible button program assignments. ✓

Speed Dial Programming Section 
Maintain system and station speed dial assignments. ✓

ACD Administration Section 
Maintain ACD and ACD Agent programs. ✓

Program Administration Section 
Maintain individual DK programs. ✓

Security Maintenance Section 
Maintain DK program security levels. ✓

Directory Number Administration
Maintain your Directory Number assignments for PDNs and PhDNs. ✓

DNIS Administration
Maintain assignments for DNIS/DID/ANI lines. ✓
3The Grand Tour



Screen Conventions ––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
Screen Conventions
All DKAdmin/DKBackup screens are organized in a similar manner (see Figure 1).

Screen elements include:

♦ Screen title (at the top of the screen): tells you what screen is displayed.

Distributed Hunt Group Administration
Maintain Distributed Hunt Group assignments. ✓

E911/CAMA Trunk Programs (R4 Only)
Maintain E911/CAMA trunk assignments. ✓

ISDN Programs (R4 Only)
Maintain ISDN program assignments. ✓

Call Forward Assignments
Maintain call forward assignments. ✓

Backup/Restore Data 
Backup, restore and/or upgrade Strata DK customer databases. ✓ ✓

View/Print Data 
View or print existing customer Strata DK databases in ASCII format. ✓ ✓

Options Menu

System Installation 
Set up or change screen type/colors, printers, user passwords and 
communication settings.

✓ ✓

System Utilities 
ReIndex files. ✓ ✓

Table 1 Main Menu Options (continued)

Main Menu DKAdmin DKBackup

Select Local Printer

Available Printer Drivers

Local Printer

FIND: H

Screen Title

Scroll Arrows

Hewlett-Packard Laserjet Compatible
Hewlett-Packard Laserjet Series II
Hewlett-Packard Laserjet Series III
IBM 80 CPS Graphics
IBM 80 CPS Matrix
IBM 80 CPS/Epson LX-90
IBM Color Printer
IBM Proprinter

0903

Select Local Printer

F1-HelpFunction Keys

Find Feature

Message Line

Figure 1 Sample Screen
4 DKAdmin/DKBackup



–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Screen Conventions
♦ Find feature: Many of the screens in the DKAdmin/DKBackup programs have a Find 
feature for customer IDs, program numbers, or port numbers. To use the feature, highlight 
the number field you are searching (e.g., program number) and type the desired number. 
The DKAdmin/DKBackup programs move the highlighter to the field requested. If the 
number you have entered is incorrect, the program displays a dialog box telling you that it 
could not be found.

To repeat the search, press Esc, the highlighter moves back to the first number in the 
column and you can type in the new search number.

Note If the feature is available on the screen you have displayed, the word FIND appears at 
the bottom left corner.

♦ Scroll arrows: If scroll arrows appear in the bottom right-hand corner of the screen, 
additional screen information is available. Some screens cannot display all the information 
they contain within the boundaries of the screen display. Scroll arrows allow you to move 
the screen (vertically or horizontally). Tab and Shift+Tab keys enable you to move the 
bar up and down the screen vertically.

♦ Function keys (appear above the message line): tell you the processing options available 
from this screen.

♦ Message line (at the bottom of the screen): tells you important information about the task 
you are performing.
5The Grand Tour



Screen Conventions ––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
6 DKAdmin/DKBackup



d 
in 

g 

.11, 

se 
Installing DKAdmin 2

Step 1: Check System Requirements
For optimum performance, run DKAdmin on a personal computer with the following 
minimum specifications:

♦ IBM-compatible Pentium® personal computer

♦ 100MB or larger hard drive

♦ CD-ROM or 3.5" 1.44KB high-density floppy drive 

Note DKAdmin software is distributed on a CD-ROM disk. Installation can be performe
using the CD-ROM disk or from floppy disk(s) copied from the CD-ROM DKAdm
install program.

♦ VGA or SVGA monitor preferred

♦ 4MB RAM (minimum)

♦ Microsoft MS-DOS 6.22, Windows 3.11 or higher (Windows 95, 98 or Windows 
NT 4.0 recommended).

♦ A laser printer is recommended

♦ For network users, a minimum of 2MB of disk space is required for each person usin
DKAdmin on the network.

♦ DKAdmin hardware key (red)

DKAdmin is a MS-DOS program that can be installed and run under Microsoft Windows 3
95, 98 and NT or MS-DOS (6.22 or higher). The installation and run instructions in this 
chapter include both Windows and DOS installation information.

Important!

● If your PC has Windows 3.11 installed, setting your Windows SYSTEM.INI and DOS 
CONFIG.SYS files with the commands below may help DKAdmin run on your PC.

SYSTEM.INI
[NonWindowsApp]
COMMANDENVSIZE=1024

DOS CONFIG.SYS
SHELL=C:\COMMAND.COM /e:1024 /p

● If DKAdmin displays a “Run time error” message during installation or operation, era
all “ntx” files under the customer directory (XXX.DK) and the “data” directory.
7Installing DKAdmin



Step 2: Power Up DKAdmin PC –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
● From C:\280ADMIN\Data, type del *.ntx and press Enter.

● From C:\280ADMIN\XXX.DK, type del *.ntx and press Enter.

● Run ReIndex Files under Options/System Utilities Menu each time before you start to use 
DKAdmin.

● Always exit DKAdmin before you turn your computer off.

Step 2: Power Up DKAdmin PC
Note The DKAdmin Hardware Key must be installed on the PC LPT1 port, to enable the 

DKAdmin program to be used after it is installed. If you install DKAdmin without the 
key, it will not run.

1. Install the DKAdmin hardware key (red) on the LPT1 parallel printer port as shown in 
Figure 2.

Notes

● If you wish, you can install a printer on the end of the LPT1 Admin Hardware Key.

● The printer can be installed and used on the LPT1/Admin Hardware Key. But, it is not 
necessary to install a printer to enable DKAdmin to be installed or used.

2. Turn on your computer.
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LDKAdmin
IBM Compatible

Personal Computer
Printer

4ELVCH-B

LPT1 Parallel Printer
Connector on Back

Red DKAdmin Hardware Key (required for DKAdmin)

Parallel Printer
CableScrews

Parallel Printer Port

1994

Figure 2 DKAdmin Hardware Connections
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Step 3: (Optional) Make Installation Floppy Disks

From Windows
If you wish to install DKAdmin on a PC that does not have a CD-ROM, you will need to make 
installation floppies from a PC that has a CD-ROM. You can make installation disks that 
install the program using a Windows application (this works on all PCs with Windows 3.x, 95, 
98 or Windows NT) or you can make DOS only installation disks.

CAUTION! Do not use the DOS installation program on a Windows PC.

Note Be sure to exit all programs running in Windows before starting.

1. Insert the CD-ROM into your CD-ROM drive. The Main Menu appears.

...or if the Main Menu does not appear after you insert the CD-ROM, click Start, Run, then 
Browse. Select your CD-ROM drive from the Look in: pull down list. Locate and double-
click mainmenu.exe. The Main Menu opens.

2. From the Main Menu, select “Make Floppy Installation Disks” then select “DKAdmin 
Windows Installation Disks” or “DKAdmin DOS Installation Disks” (depending which 
target PC will get the installation). Follow the prompts.

From DOS Only PC
If you wish to install DKAdmin on a PC that does not have a CD-ROM, we recommend that
you use a Windows PC and the preceding instructions to make installation floppy disks. 
However, in the rare case you are using a DOS only PC that has a CD-ROM, follow thes
steps:

1. Place a blank floppy in floppy drive A: (or B:). Insert the CD-ROM into your CD-ROM
drive. Change the DOS prompt to the CD-ROM drive letter and type: 
cd\dkados\disk1 and press Enter.

2. Type: copy *.* A: (or B:) and press Enter.

3. Place a another floppy in floppy drive A: (or B:) and type: cd\dkados\disk2 and 
press  Enter.

4. Type: copy *.* A: (or B:) and press Enter.
9Installing DKAdmin



Step 4: Install DKAdmin –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
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Step 4: Install DKAdmin
DKAdmin is a DOS application program that can be installed and run in either DOS or as a 
Windows DOS session.

CAUTION! If any earlier DKAdmin (280Admin) release is already installed on the PC, 
do not delete it; install DKAdmin Release 4.XX over the existing DKAdmin 
(280Admin) version as described below. DKAdmin is always installed in the 
280Admin directory, overwriting the old DKAdmin (280Admin) operating 
software but not customer database directories. Existing 280Admin 
customer data can be used with DKAdmin Release 4.XX. 

Note DKAdmin software is also available from the Toshiba FYI Internet site.

Windows PC from CD-ROM

Notes

● When installing DKAdmin to run as a DOS session in Windows NT, the install program 
assumes that the default directory name (WINNT) and the default system drive (Drive C) 
contain the system files. The installation procedure looks for this directory (C:\WINNT) 
and, if found, copies the necessary drivers for Windows NT onto the hard disk.

● Be sure to exit all programs running in Windows before starting.

1. Insert the CD-ROM into your CD-ROM drive. The Main Menu appears.

...or if the Main Menu does not appear after you insert the CD-ROM, click Start, Run, then 
Browse. Select your CD-ROM drive from the Look in: pull down list. Locate and double-
click mainmenu.exe. The Main Menu opens.

2. From the Main Menu, select “Install DKAdmin” and follow the prompts.

Important! Remember that the “Install DKAdmin” selection in the Main Menu is a Windo
application, but the actual DKAdmin application is a DOS/Windows DOS 
session application.

Windows PC from Floppy Disks

Note Be sure to exit all programs before running the Setup program.

1. Insert Floppy Disk #1 into the floppy drive and click Start, then Run. Type a:\setup (or 
b:\setup). Click OK. Follow the prompts to install DKAdmin.

CAUTION! During installation, selecting “New Installation” overwrites the existing 
DKAdmin customer list if you already have DKAdmin or 280Admin installed on your PC.
Although the customer list is overwritten, you can still retrieve the existing customer data
associated to that name by adding that customer’s name using the “Maintain Customer”
selection on the newly installed DKAdmin. Do this for each customer name that is overw
on the list.

2. Reboot your PC when prompted at the end of installation.
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Notes

● If you installed DKAdmin for the first time, a 280ADMIN directory was created and the 
DKAdmin files copied to it. 

● If you upgraded an existing DKAdmin program, your customer database has been 
maintained in the 280ADMIN directory.

DOS Only PC from CD-ROM
In the rare case your DOS only PC has a CD-ROM, follow these steps:

1. Insert the CD-ROM into your CD-ROM drive. Change the DOS prompt to that drive and 
type: cd\dkados and press Enter.
Type: install and press Enter.

2. Go to Step 3 of the procedure entitled “DOS Only PC from Floppy Disks” below. 
Disregard procedures refering to Disk #2.

CAUTION! During installation, selecting “New Installation” overwrites the existing 
DKAdmin customer list if you already have DKAdmin or 280Admin installed on your PC.
Although the customer list is overwritten, you can still retrieve the existing customer data
associated to that name by adding that customer’s name using the “Maintain Customer”
selection on the newly installed DKAdmin. Do this for each customer name that is overw
on the list.

DOS Only PC from Floppy Disks
1. Insert the DKAdmin Disk #1 into drive A: (or B:).

2. Using DOS, type: a:\install (or b:\install) at the C: prompt and press Enter. 

The Toshiba Install DKAdmin System screen automatically displays. Follow the prompts 
to install DKAdmin.

3. During installation, if you have an existing customer file in an older version of DKAdmin 
(280Admin) on your PC, highlight the DKAdmin 4.0 Upgrade Installation 
Only selection and press Enter.

...or if you are installing for the first time, highlight the DKAdmin 4.0 New 
Installation selection and press Enter.

CAUTION! During installation, selecting “New Installation” overwrites the existing 
DKAdmin customer list if you already have DKAdmin or 280Admin installed on your PC.
Although the customer list is overwritten, you can still retrieve the existing customer data
associated to that name by adding that customer’s name using the “Maintain Customer”
selection on the newly installed DKAdmin. Do this for each customer name that is overw
on the list.

4. Remove the floppy disk from your floppy disk drive and reset the PC to initialize the 
changes made during installation.

5. Go to Step 3 in the “Run DKAdmin Program” on Page 12.

Notes

● If you installed DKAdmin for the first time, a 280ADMIN directory was created and th
DKAdmin files copied to it. 
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● If you upgraded an existing DKAdmin program, your customer database has been 
maintained in the 280ADMIN directory.

● If your Config.sys file is changed and you have problems with the new file when you 
reboot your computer, restore the original file (i.e., Config. bak).

Step 5: Run DKAdmin Program
Note Running the program under Windows 95, 98 or Windows NT is recommended for the 

best performance.

Start-up DKAdmin under Windows 98, 95 or Windows NT 4.0
➤ Click on the DKAdmin icon. The Toshiba Title screen displays.

Start-up DKAdmin in MS-DOS
1. From the C:\ prompt, type CD 280ADMIN and press Enter.

2. From the C:\280ADMIN prompt, type dkadmin and press Enter. The Toshiba Title 
screen displays.

Run DKAdmin

Note If the DKAdmin red hardware key is not installed, the following message displays: 
Hardware key Not Installed. Exiting to DOS. OK. Install the 
DKAdmin hardware key, then retry running the program.

1. Once the Toshiba Title screen displays, press any key to continue. This message appears: 
Please Enter Your User ID:

2. Type Master and press Enter. This message appears: Please Enter Your 
Password.

3. Type Master and press Enter. For security, your password does not display on the 
screen as you type it.

The default DKAdmin 
Password File 
Maintenance screen 
displays (shown right).

It is recommended that 
you change the MASTER 
password and create any 
other user passwords.

4. To change or add 
passwords, see “User 
Password Level Setup” on 
Page 121.

5. After completing your password setup, press Esc. The message Do You Want To 
Copy User File Back On The Installation Disk? displays.
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––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Step 5: Run DKAdmin Program
6. Highlight Yes and press Enter. If you choose No, your new passwords are not installed 
on the disk.

7. A “Copy to Drive”  dialog box displays. The box defaults to drive A: . If you do not 
want drive A: , type the drive letter to which you wish to copy the installation information. 
Press Enter . A dialog box displays asking you to insert the DKAdmin Installation Disk 
#1 into the appropriate disk drive.

8. Insert DKAdmin Installation Disk #1 into the floppy-disk drive and press any key to 
continue. When complete, a message Process Successful  displays and your new 
passwords are now available on your DKAdmin Installation Disk #1.

9. Press any key to display the 
DKAdmin Main Menu 
screen (shown right).

You are now ready to use 
DKAdmin and can use your:

♦ Modified installation 
disks to install 
DKAdmin on additional 
workstations.

♦ New passwords to log in 
to DKAdmin.

Set Windows DKAdmin Program Properties
Set these properties when running DKAdmin as a DOS session under Windows:

1. Right click on the DKAdmin desktop icon, 
then click on Properties.

The DKAdmin Properties dialog box displays 
(shown at right).

2. Select the Program Tab screen (shown at 
right). You should see:

Cmd line: C:\280ADMIN\DKADMIN.BAT

Working: C:\280ADMIN

3. In the Run box, select Maximized  from the 
drop-down menu.

4. Click Apply.

5. On the same screen, click Advanced. The 
Advanced Program Settings screen displays.
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Step 5: Run DKAdmin Program –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
6. From Advanced Program Settings screen 
(shown at right), check only the Suggest 
MS-DOS mode as necessary option. 
Click on OK.

Note Other screen settings should not be selected.

7. Select the Memory Tab screen (shown at 
right). All fields should read Auto. If you 
make changes, click on OK.

8. Select the Screen Tab screen (shown at right). 
The selected settings should be:

Usage: Full-screen

Window: 

Display toolbar
Restore settings on startup

Performance:

Fast ROM emulation
Dynamic memory allocation

If you make changes, click on Apply.
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9. Select the Misc Tab screen (shown at right).

10. Only the items in the Termination, Other and 
Windows shortcut keys boxes should be 
selected.

NoteIt is best not to allow screen savers.

If you make changes, click on Apply.

11. Close the DKAdmin Properties dialog box 
and return to Step 3 of “Start-up DKAdmin 
under Windows 98, 95 or Windows NT 4.0” 
on Page 12.

Step 6: Connect to the Strata DK Telephone System
➤ To program or update a Strata DK, you must be connected to the Strata DK telepho

system. For procedures on connecting your PC to the Strata DK, see Appendix A – 
Connecting to Strata DK.
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Installing DKBackup 3

Step 1: Check System Requirements
For optimum performance, run DKBackup on a personal computer with the following 
minimum specifications:

♦ IBM-compatible 386/486 personal computer or higher level

♦ 20MB or larger hard drive

♦ CD-ROM or 3.5" 1.44KB high-density floppy drive 

Note DKBackup software is distributed on a CD-ROM disk. Installation can be performed 
using the CD-ROM disk or from floppy disk(s) copied from the CD-ROM DKBackup 
install program.

♦ VGA or SVGA monitor preferred

♦ 640KB RAM (minimum)

♦ Microsoft MS-DOS 6.22, Windows 3.11 or higher (Windows 95, 98 or Windows 
NT 4.0 recommended).

♦ A laser printer is recommended

♦ For network users, a minimum of 2MB of disk space is required for each person using 
DKBackup on the network.

♦ DKBackup hardware key (green or red)

DKBackup is a MS-DOS program that can be installed and run under Microsoft 
Windows 3.11, 95, 98, NT or MS-DOS (6.22 or higher). The installation and run instructions 
in this chapter include both Windows and DOS installation information.

Important!

● If your PC has Windows installed, setting your Windows SYSTEM.INI and DOS 
CONFIG.SYS files with the commands below may help DKBackup run on your PC.

SYSTEM.INI
[NonWindowsApp]
COMMANDENVSIZE=1024

DOS CONFIG.SYS
SHELL=C:\COMMAND.COM /e:1024 /p

● If DKBackup displays a “Run time error” message during installation or operation, era
all “ntx” files under the customer directory (XXX.DK) and the “data” directory.
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Step 2: Power Up DKBackup PC ––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

t to 
● From C:\280BCKUP\Data, type del *.ntx and press Enter.

● From C:\280BCKUP\XXX.DK, type del *.ntx and press Enter.

● Run “ReIndex Files” under Options/System Utilities Menu each time before you star
use DKBackup.

● Always exit DKBackup before you turn your computer off.

Step 2: Power Up DKBackup PC
Note The DKBackup or DKAdmin Hardware Key must be installed on the PC LPT1 port, 

to allow the DKBackup program to be used after it is installed. If you install 
DKBackup without the key, it will not run.

1. Install the DKBackup hardware key (green or red) on the LPT1 parallel printer port as 
shown in Figure 3.

Figure 3 DKBackup Hardware Connections

Notes

● If you wish, you can install a printer on the end of the LPT1 Admin Hardware Key.

● The printer can be installed and used on the LPT1/Backup Hardware Key. But, it is not 
necessary to install a printer to enable DKBackup to be installed or used.

2. Turn on your computer.
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Step 3: (Optional) Make Installation Floppy Disks

From Windows
If you wish to install DKBackup on a PC that does not have a CD-ROM, you will need to 
make installation floppies from a PC that has a CD-ROM. You can make installation disks that 
install the program using a Windows application (this works on all PCs with Windows 3.x, 95, 
98 or Windows NT) or you can make DOS only installation disks.

CAUTION! Do not use the DOS installation program on a Windows PC.

Note Be sure to exit all programs running in Windows before starting.

1. Insert the CD-ROM into your CD-ROM drive. The Main Menu appears.

...or if the Main Menu does not appear after you insert the CD-ROM, click Start, Run, then 
Browse. Select your CD-ROM drive from the Look in: pull down list. Locate and double-
click mainmenu.exe. The Main Menu opens.

2. From the Main Menu, select “Make Floppy Installation Disks” then select “DKBackup
Windows Installation Disks” or “DKBackup DOS Installation Disks” (depending which
target PC will get the installation). Follow the prompts.

From DOS Only PC
If you wish to install DKBackup on a PC that does not have a CD-ROM, we recommend tha
you use a Windows PC and the preceding instructions to make installation floppy disks. 
However, in the rare case you are using a DOS only PC that has a CD-ROM, follow thes
steps:

1. Place a blank floppy in floppy drive A: (or B:). Insert the CD-ROM into your CD-ROM
drive. Change the DOS prompt to the CD-ROM drive letter and type: 
cd\dkbdos\disk1 and press Enter.

2. Type: copy *.* A: (or B:) and press Enter.

3. Place a another floppy in floppy drive A: (or B:) and type: cd\dkbdos\disk2 and 
press  Enter.

4. Type: copy *.* A: (or B:) and press Enter.
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Step 4: Install DKBackup
DKBackup is a DOS application program that can be installed and run in either DOS or as a 
Windows DOS session.

CAUTION! If any earlier DKBackup (280Backup) release is already installed on the PC, 
do not delete it; install DKBackup Release 4.XX over the existing DKBackup 
(280Backup) version as described below. DKBackup is always installed in 
the 280Backup directory, overwriting the old DKBackup (280Backup) 
operating software but not customer database directories. Existing 
280Backup customer data can be used with DKBackup Release 4.XX. 

Note DKBackup software is also available from the Toshiba FYI Internet site.

Windows PC from CD-ROM

Notes

● When installing DKBackup to run as a DOS session in Windows NT, the install program 
assumes that the default directory name (WINNT) and the default system drive (Drive C) 
contain the system files. The installation procedure looks for this directory (C:\WINNT) 
and, if found, copies the necessary drivers for Windows NT onto the hard disk.

● Be sure to exit all programs running in Windows before starting.

1. Insert the CD-ROM into your CD-ROM drive. The Main Menu appears.

...or if the Main Menu does not appear after you insert the CD-ROM, click Start, Run, then 
Browse. Select your CD-ROM drive from the Look in: pull down list. Locate and double-
click mainmenu.exe. The Main Menu opens.

2. From the Main Menu, select “Install DKBackup” and follow the prompts.

Important! Remember that the “Install DKBackup” selection in the Main Menu is a 
Windows application, but the actual DKBackup application is a DOS/Window
DOS session application.

Windows PC from Floppy Disks

Note Be sure to exit all programs before running the Setup program.

1. Insert Floppy Disk #1 into the floppy drive and click Start, then Run. Type a:\setup (or 
b:\setup). Click OK. Follow the prompts to install DKBackup.

CAUTION! During installation, selecting “New Installation” overwrites the existing 
DKBackup customer list if you already have DKBackup or 280Backup installed on your 
Although the customer list is overwritten, you can still retrieve the existing customer data
associated to that name by adding that customer’s name using the “Maintain Customer”
selection on the newly installed DKBackup. Do this for each customer name that is overw
on the list.

2. Reboot your PC when prompted at the end of installation.
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Notes

● If you installed DKBackup for the first time, a 280BCKUP directory was created and the 
DKBackup files copied to it. 

● If you upgraded an existing DKBackup program, your customer database has been 
maintained in the 280BCKUP directory.

DOS Only PC from CD-ROM
In the rare case your DOS only PC has 
a CD-ROM, follow these steps:

1. Insert the CD-ROM into your CD-
ROM drive. Change the DOS prompt to that drive and type: cd\dkados and press 
Enter.
Type: install and press Enter.

2. Go to Step 3 of the procedure 
entitled “DOS only PC from Floppy Disks” below. Disregard procedures refering to Dis
#2.

CAUTION! During installation, 
selecting “New Installation” overwrites the existing DKBackup customer list if you alread
have DKBackup or 280Backup installed on your PC. Although the customer list is overwr
you can still retrieve the existing customer data associated to that name by adding that 
customer’s name using the “Maintain Customer” selection on the newly installed DKBac
Do this for each customer name that is overwritten on the list.

DOS only PC from Floppy Disks
1. Insert the DKBackup Disk #1 into drive A: (or B:).

2. Using DOS, type: a:\install (or b:\install) at the C: prompt and press Enter. 

The Toshiba Install DKBackup System screen automatically displays. Follow the prompts 
to install DKBackup.

3. During installation, if you have an existing customer file in an older version of DKBackup 
(280Backup) on your PC, highlight the DKBackup 4.0 Upgrade Installation 
Only selection and press Enter.

...or if you are installing for the first time, highlight the DKBackup 4.0 New 
Installation selection and press Enter.

CAUTION! During installation, selecting “New Installation” overwrites the existing 
DKBackup customer list if you already have DKBackup or 280Backup installed on your 
Although the customer list is overwritten, you can still retrieve the existing customer data
associated to that name by adding that customer’s name using the “Maintain Customer”
selection on the newly installed DKBackup. Do this for each customer name that is overw
on the list.

4. Remove the floppy disk from your floppy disk drive and reset the PC to initialize the 
changes made during installation.

5. Go to Step 3 in the “Run DKBackup” on Page 22.
21Installing DKBackup
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Notes

● If you installed DKBackup for the first time, a 280BCKUP directory was created and the 
DKBackup files copied to it. 

● If you upgraded an existing DKBackup program, your customer database has been 
maintained in the 280BCKUP directory.

● If your Config.sys file is changed and you have problems with the new file when you 
reboot your computer, restore the original file (i.e., Config. bak).

Step 5: Run DKBackup Program
Note Running the program under Windows 95, 98 or Windows NT is recommended for the 

best performance.

Start-up DKBackup under Windows 3.11, 95, 98 or Windows NT 4.0
➤ Click on the DKBackup icon. The Toshiba Title screen displays.

Start-up DKBackup in MS-DOS
1. From the C:\ prompt, type CD 280BCKUP and press Enter.

2. From the C:\280BCKUP prompt, type dkbackup and press Enter. The Toshiba Title 
screen displays.

Run DKBackup

Note If the DKBackup red or green hardware key is not installed, the following message 
displays: Hardware key Not Installed. Exiting to DOS. OK. Install 
the DKBackup hardware key, then retry running the program.

1. Once the Toshiba Title screen displays, press any key to continue. This message appears: 
Please Enter Your User ID:

2. Type Master and press Enter. This message appears: Please Enter Your 
Password.

3. Type Master and press Enter. For security, your password does not display on the 
screen as you type it.

The default DKBackup 
Password File 
Maintenance screen 
displays (shown right).

It is recommended that 
you change the MASTER 
password and create any 
other user passwords.

4. To change or add 
passwords, see “User 
Password Level Setup” on 
Page 121.
22 DKAdmin/DKBackup



–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Step 5: Run DKBackup Program
5. After completing your password setup, press Esc. The message Do You Want To 
Copy User File Back On The Installation Disk? displays.

6. Highlight Yes and press Enter. If you choose No, your new passwords are not installed 
on the disk.

7. A “Copy to Drive”  dialog box displays. The box defaults to drive A: . If you do not 
want drive A: , type the drive letter to which you wish to copy the installation information. 
Press Enter . A dialog box displays asking you to insert the DKBackup Installation Disk 
into the appropriate disk drive.

8. Insert the DKBackup Installation Disk into the floppy-disk drive and press any key to 
continue. When complete, a message Process Successful  displays and your new 
passwords are now available on your DKBackup Installation Disk.

9. Press any key to display 
the DKBackup Main Menu 
screen (shown right).

You are now ready to use 
DKBackup and can use 
your:

♦ Modified installation 
disks to install 
DKBackup on 
additional 
workstations.

♦ New passwords to log 
in to DKBackup.

Set Windows DKBackup Program Properties
1. Right click on the DKBackup desktop icon, 

then click on Properties.

The DKBackup Properties dialog box displays 
(shown at right).

2. Select the Program Tab screen (shown at 
right). You should see:

Cmd line: C:\280BCKUP\DKBCKUP.BAT

Working: C:\280BCKUP

3. In the Run box, select Maximized  from the 
drop-down menu.

4. Click Apply.

5. On the same screen, click Advanced. The 
Advanced Program Settings screen displays.
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6. From Advanced Program Settings screen 
(shown at right), check only the Suggest 
MS-DOS mode as necessary option. 
Click on OK.

Note Other screen settings should not be selected.

7. Select the Memory Tab screen (shown at 
right). All fields should read Auto. If you 
make changes, click on OK.

8. Select the Screen Tab screen (shown at right). 
The selected settings should be:

Usage: Full-screen

Window: 

Display toolbar
Restore settings on startup

Performance:

Fast ROM emulation
Dynamic memory allocation

If you make changes, click on Apply.
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9. Select the Misc Tab screen (shown at right).

10. Only the items in the Termination, Other and 
Windows shortcut keys boxes should be 
selected.

NoteIt is best not to allow screen savers.

If you make changes, click on Apply.

11. Close the DKBackup Properties dialog box 
and return to Step 3 of “Start-up DKBackup 
under Windows 3.11, 95, 98 or Windows NT 
4.0” on Page 22.

Step 6: Connect to the Strata DK Telephone System
➤ To program or update a Strata DK, you must be connected to the Strata DK telepho

system. For procedures on connecting your PC to the Strata DK, see Appendix A – 
Connecting to Strata DK.
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Using DKAdmin/DKBackup 4

This chapter shows you how to log on and off DKAdmin/DKBackup, use the pull-down 
menus and select system options, respond to system and error messages, and describes the 
keyboard conventions used in the programs.

Before You Start
Before using DKAdmin/DKBackup, you must:

♦ Connect your personal computer to a Strata DK in order to send/receive data between the 
DKAdmin/DKBackup PC and a Strata DK (see Appendix A – Connecting to Strata DK 
for procedures).

♦ Properly install the DKAdmin/DKBackup hardware key (see Chapter 2 – Installing 
DKAdmin and Chapter 3 – Installing DKBackup for procedures).

♦ Correctly set your communications (see Chapter 8 – Options Menu).

Logging On

DKAdmin

➤ To log on to DKAdmin

1. After powering up your 
computer, at the C:\ 
prompt type CD 
280ADMIN and press 
Enter.

2. From the C:\280ADMIN 
prompt, type dkadmin 
and press Enter. The 
Toshiba start-up page 
displays (shown right).

3. Type your User ID and 
press Enter.

4. Type your password and 
press Enter.
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in/
ing 
If you have entered 
your User ID and 
password correctly, the 
DKAdmin Main Menu 
displays (shown right).

All DKAdmin activity 
originates from the 
DKAdmin Main 
Menu.

The three items across 
the DKAdmin Main 
Menu bar (i.e., File, 
Administration, 
Options) enable you to perform the many functions shown in Figure 5. Some items may 
not be available for selection, depending on your assigned User ID and password. The 
menus shown here depict DKAdmin Master password Level 9 options.

Important! It is recommended to run “ReIndex Files” each time you start to use DKAdm
DKBackup. If files are not indexed correctly you may encounter problems us
some functions of DKAdmin/DKBackup.
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Figure 4 DKAdmin Main Menu Options
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DKBackup

➤ To log on to DKBackup

1. After powering up 
your computer, at the 
C:\ prompt type
CD 280BCKUP and 
press Enter.

2. From the 
C:\280BCKUP 
prompt, type 
dkbckup and press 
Enter. The Toshiba 
start-up page displays 
(shown right).

3. Type your User ID and 
press Enter.

4. Type your password 
and press Enter.

If you have entered your User ID and password correctly, the DKBackup Main Menu 
displays (shown right).

All DKBackup activity 
originates from the 
DKBackup Main 
Menu.

The three items across 
the DKBackup Main 
Menu bar (i.e., File, 
Backup, Options) 
enable you to perform 
the many functions 
shown in Figure 5. 
Some items may not 
be available for 
selection, depending 
on your assigned User ID and password. The menus shown here depict DKBackup Master 
password Level 9 options.
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Keyboard Conventions
While working within DKAdmin/DKBackup, you can use the following keys to:

Esc
Escapes from the current screen/menu and returns you 
to the previous screen/menu.

Page Up/Page Down Moves to the previous/next questions screen.

Enter Executes a screen selection/transaction.

Left/Right Arrow Moves the selection highlighter left/right.

Up/down Arrow Moves the selection highlighter up/down.

Spacebar Depending on the screen, toggles between selections 
for the field or selects the list item and places a check 
mark next to it.

1088DK

File

Backup

Options

Select Customer

Maintain Customer File

Dial DK

Hangup Connection

Transfer DK Data

About

Exit

Check Processor Type

Backup/Restore Data

View/Print Data

System Installation

Systems Utilities

Screen Type/Color Installation
Printer Type Selection
System Miscellaneous Variables
User Password Level Setup
Communications Setup

ReIndex Files

Figure 5 DKBackup Main Menu Options
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Using the Pull-Down Menus
You can perform all basic operations from the Main 
Menu’s menu bar. When you select an item in the menu 
bar, a “pull-down” options menu appears, listing all the 
functions which you can perform (shown right).

➤ To use a pull-down menu

1. Use the left/right arrow keys to highlight the item 
and press Enter. Or, if you prefer, you can type the 
highlighted letter for the item you wish to “pull 
down”:

F = File
B = Backup
O = Options

2. Once in a pull-down menu, you can use the same 
keyboard conventions you do to make a menu 
selection (use the up/down arrow keys or type the highlighted letter).

3. To close a menu, press Esc.

System Messages
At the bottom of each DKAdmin/DKBackup screen is a message line (see Page 5). Pay 
particular attention to this line as you work, since it displays important system information
processing options for the application or screen in which you are currently working.

Error Messages
If you make an incorrect entry while working in DKAdmin/DKBackup, you are sometime
prompted with an error message. This tells you why DKAdmin/DKBackup cannot proces
attempted transaction. By reviewing the error message, you will be able to determine yo
error and successfully execute the desired transaction.

On-Line Help
DKAdmin/DKBackup offers you on-line help for many system operations. Should you ha
question, press F1 (F1-Help must appear at the bottom of the screen to be active) to disp
an explanation of the operation in which you are currently working. To close the Help win
press Esc.
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––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Logging Off
Logging Off

➤ To exit the DKAdmin/DKBackup system

1. Return to the DKAdmin/DKBackup Main Menu by pressing Esc until the Main Menu 
displays.

2. Highlight the File Menu option and press Enter, or type f.

3. Highlight Exit and press Enter, or type x.

DKAdmin/DKBackup shuts down and returns the screen to a DOS prompt.

CAUTION! Always exit the program properly before turning off your DKAdmin/
DKBackup PC. Turning off your PC before exiting the program, creates an 
indexing problem and produces run-time errors. (See Page 7 for information 
on correcting run-time errors.)
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File Menu 5

This chapter gives you step-by-step instructions on using the options available on the File 
Menu. The options are:

♦ Select Customer

♦ Maintain Customer File

♦ Dial DK

♦ Hangup Connection

♦ Transfer DK Data

♦ About

♦ Exit

Quick-start Procedures for Using DKAdmin

For an Existing Customer

➤ To quickly use DKAdmin with a previously programmed Strata DK

1. Create a new customer record, using the Maintain Customer File option from the File 
Menu.

2. Select the newly created customer, using the Select Customer option from the File Menu.

3. If you will be Uploading/Downloading data between the DKAdmin PC and a Strata DK 
and you must dial via modem or Toshiba DIU to connect, use the Dial DK option to select 
and dial the customer; or, connect the DKAdmin PC directly to the DK system (see 
Appendix A – Connecting to Strata DK).

4. When the DKAdmin PC first connects to the Strata DK, verify that the selected custo
processor is the same type as the one installed in the DK system. Highlight the Che
Processor Type option under the Administration Menu and press Enter. Enter the 
applicable DK code. The Strata DK sends the processor type and version to the DKA
PC. 

5. Back up (download) the customer’s original data using the Backup option (F2) and (F3) 
from the Backup/Restore Data option under the Administration Menu.

6. Update the customer DK data, using options from the Administration Menu.

7. Restore (upload) the new data to the customer’s Strata DK, using the Restore optionF2) 
and (F4) from the Backup/Restore Data option under the Administration Menu.
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For a New Customer

➤ To quickly use DKAdmin with a new installation of Strata DK

1. Create a new customer record, using the Maintain Customer File option from the File 
Menu.

2. Select the newly created customer, using the Select Customer option from the File Menu.

3. Program the customer DK data, using the ACD Administration Section and Program 
Administration Section options from the Administration Menu.

4. Dial the Strata DK, using the Dial DK option from the File Menu, or connect the 
DKAdmin PC directly to the Strata DK (see Appendix A – Connecting to Strata DK).

5. When the DKAdmin PC first connects to the Strata DK, verify that the selected custo
processor is the same type installed in the DK system. Highlight the Check Processo
option in the Administration Menu and press Enter. Enter the applicable DK code. The
Strata DK sends the processor type and version to the DKAdmin PC. 

6. Initialize the Strata DK processor PCB by running Program 91-9 from the Initializatio
Programs option located in the Program Administration Menu (this option will interru
service and drop all calls).

Note If initializing from a remote location, the DKAdmin PC must be connected to the 
Strata DK via modems as shown in Figure 18 on Page 132 only.

7. Restore (upload) the new data to the customer’s Strata DK, using the Restore optionF2) 
and (F4) from the Backup/Restore Data option in the Administration Menu.

Maintain Customer File
Using this option, you can insert a new customer, review and update a customer’s inform
delete a customer or upgrade a customer’s processor.

Note In the procedures for upgrading a customer’s processor, the word “original” desc
the existing processor and “new” describes the upgraded processor.

➤ To access the Maintain Customer File option

1. Type m and the Customer 
List displays (shown 
right).

The list shows each 
customer’s ID, name, 
assigned directory, and 
the last date the 
customer’s Strata DK 
data was downloaded 
and uploaded. If 
upgrading a processor, 
you should always create 
a new customer, 
selecting the “original” processor (e.g., RCTUA,B, C/D, E/F) and the original softwar
release (1, 2, 3 or 4).
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➤ To create a customer record or upgrade a customer’s processor

1. Press Ins to insert a 
record. A blank 
Customer File 
Maintenance Screen 
displays (shown right).

2. See Table 2 for a 
description of the 
fields on this screen. 
Press Enter after 
each entry.

Table 2 Customer File Maintenance Screen Fields 

Field Description

Customer ID Enter a unique customer ID, using up to eight alphanumeric characters. If you 
attempt to enter an existing customer ID code, the system displays an error 
message: Record exists.

Customer Name Enter the full customer name.

Address Enter the customer’s street address.

Address The second address line may be used to enter a suite or PO number.

City, State, Zip Enter the customer’s city, state and ZIP code.

Country Code Enter the three character country code.

Contact Name Enter a contact name, as applicable.

Country Ph. Code Enter the three character foreign country telephone code.

Phone No., Ext Enter the customer telephone number (of the customer contact), including area 
code, and extension. This telephone number does not automatically dial out 
when using the Dial DK option and is only used as a reference for the customer 
telephone number.

DIU String The first part of the DIU string is automatically entered. You must enter the 
extension number (XXXX) of the DIU (modem pool or TTY PDIU-DS) after the 
ATDD option. This string is used when DIUs are used to connect DKAdmin/
DKBackup to the DK TTY port (see Figure 18 on Page 132 and Figure 20 on 
Page 135). The DIU String is sent to the DIU when pressing F2 or F3 from the 
Custom List screen of the Dial DK option.

Modem Dial String Enter the complete modem string number when modems are used to connect to: 
an external modem connected to the TTY port, or the RMDS or IMDU built-in 
modems (see Figures 18 ~ 22 on Pages 132 ~ 139). This string is sent when 
using (F3)–DID/DIU/modem, (F4)–modem initial + modem dial string, or (F5)–
modem dial string only .
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After Connect Enter the After Connect String when calling into a Strata DK modem pool (see 
Figure 20 on Page 135). It is recommended that you enter AT~~~ATDDYYY as 
the After Connect string (where YYY is the extension number of the PDIU-DS 
connected to the Strata DK TTY port).

Notes

● If you are not using the modem pool function, the DK security code can be set 
on the After Connect line in each Customer File setup so it will be sent 
automatically to the Strata DK after connecting the DKAdmin/DKBackup PC to 
the Strata DK remotely via modems. Setting the DK security code in the After 
Connect String is optional.

● In some cases, when connecting to older Release 1 processors or during heavy 
traffic conditions, the After Connect string may be sent and not recognized by 
the Strata DK. If this should occur, do not enter the DK security code in the After 
Connect string.

DK Model, Release Press Enter and the DK Model, Release dialog box appears. Highlight the 
appropriate processor type and software release number and press Enter.

Important!

● For proper operation, be sure you select the appropriate software release.

● If creating a new customer to upgrade a processor, select the current release 
level (i.e., if upgrading from RCTUB2, select Release 2).

● To upgrade a Release 1 or Release 2 processor to Release 3 or Release 3.10, 
select Release 1 or 2; the upgrade process converts this line to Release 3.

● To upgrade Release 3 to Release 3.10 processors, select Release 3.

Data Directory The customer directory automatically defaults to the assigned customer ID. You 
may change the directory as desired. This is the directory in which all customer 
data is stored on the DKAdmin/DKBackup PC disk drive. DKAdmin/DKBackup 
automatically adds the “.DK” extension on the end of the directory.

Table 2 Customer File Maintenance Screen Fields  (continued)

Field Description

DK14, WMAU, R1

DK16e, TMAU , R1

DK40, TMAU, R1

DK    , RCTU-A, R1/R2

DK    , RCTU-A, R3.1

DK    , RCTU-A, R4

DK    , RCTU-B, R1/R2

DK    , RCTU-B, R3

DK    , RCTU-B, R4

DK    , RCTU-CD, R1/R2

DK    , RCTU-CD, R3

DK    , RCTU-CD, R4

DK    , RCTU-EF, R3

DK    , RCTU-EF, R4
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Note See Appendix A – Connecting to Strata DK for DIU, modem, and After Connect dial
settings.

3. When you have finished, press Enter to scroll to the bottom of the screen. Press Enter 
again to save the information. DKAdmin/DKBackup creates the necessary default D
files for this processor type and customer. When complete, the new customer has be
added alphabetically by the Customer ID to the customer list and the DKAdmin/
DKBackup Main Menu is displayed. 

Note If upgrading a processor, select the original processor from which you are upgra
For example, if you are upgrading from RCTUB to RCTU C/D, select RCTUB.

➤ To modify a customer record

1. Highlight a customer, press Enter and the Customer File Maintenance screen display

2. Use the up/down arrow keys to highlight a field and update the information.

3. When you have changed the information, press Enter to scroll to the bottom of the 
screen. Press Enter again to save the information or Esc to exit without saving your 
changes.

➤ To delete a customer record

1. Highlight a customer, and press Del. A Delete Record confirmation window appears on
the screen.

2. Highlight Yes, press Enter, and the customer is deleted from the Customer List.

3. Press Esc to close the Customer List screen and return to the DKAdmin/DKBackup M
Menu.

Select Customer
Important! Before you can use any of the options in the Backup Menu, you must first select a 

customer. If you attempt to select an option from the menu without first selecting 
a customer, the following message displays: Please select a customer 
first!

➤ To select a customer

1. Type f and the Select Customer option is highlighted.

Important! If you are uploading/downloading data between the DKAdmin/DKBackup PC 
and a Strata DK and you must dial via modem or Toshiba DIU to connect, use the 
Dial DK option to select and dial the customer. If the PC is connected directly to 
the Strata DK, use the Select Customer option (not the Dial DK option) to select 
the customer (see Appendix A – Connecting to Strata DK).

280BCKUP 1.0 
Conversion Directory

If you chose “Upgrade Installation Only” when installing the DKAdmin/DKBackup 
program, this field appears on your screen. It is no longer supported by the 
programs and should not be used.

Table 2 Customer File Maintenance Screen Fields  (continued)

Field Description
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2. Press Enter and the Customer List displays.

3. Highlight the desired customer, and press Enter. The DKAdmin/DKBackup Main Menu 
displays.

Note If you have multiple customers, you can use the Find function to move quickly to 
another customer by typing the first letter of the Customer ID number. The program 
highlights the first customer which matches your entry. Press Enter to select the 
highlighted customer or re-enter.

After selecting a customer, the bottom of the DKAdmin/DKBackup Main Menu displays a 
box along the bottom of the screen. This box displays important information about the 
customer, including the customer name, processor type, processor software version level, 
feature key installed on the processor, and the disk directory (see Figure 6).

Notes

● If the new customer is selected, the default database for the customer’s processor is
into DKAdmin/DKBackup.

● Software version Release 3 applies to Release 3 and Release 3.1 processors.

You now may use the options in the Backup Menu to check the DK Processor or Backup
Restore Data.

Dial DK
The DKAdmin/DKBackup to Strata DK communications link can be made via modems, 
Toshiba PDIUs or RPCIs, using the DKAdmin/DKBackup dialing strings (DIU, modem, a
or After Connect).

Dialing strings are not necessary if the DKAdmin/DKBackup PC is connected directly to
Strata DK TTY Port (see Figure 16 on Page 130). Dialing Strings are set using the Maintain 
Customer or Dial DK menus. DIU and Modem Initialization Strings are set from the Opti
System Installation/Communications Setup. (See Appendix A – Connecting to Strata DK to 
establish communications between the Strata DK and the DKAdmin/DKBackup PC.) 
DKAdmin/DKBackup cannot be used to send or receive customer database information u
physical communication path has been established between the Strata DK and the DKA
DKBackup PC.

Customer 
Name

Processor 
Type

Processor
Software

Version

Feature Key 
Installed on 
Processor

Disk
Directory

1085DK

Figure 6 On-screen Customer Information
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Important!

● In order for the DKAdmin/DKBackup Backup/Restore Data option to operate if you are 
using an IMDU or RMDS modem, Program 77-1, LED 14 must be “ON.” (See Prg 77
LED 15 for RMDS bps rate in the Strata DK Programming Manual.)

● The DKAdmin/DKBackup hardware key (green or red) must be installed whenever u
the DKAdmin/DKBackup program (see the figure in Substep 6 on Page 2-4).

● The modem/TTY port must be enabled (see Program 03 codes 41 and 49 and Progr

➤ To access the option

1. Type f and the File Menu displays.

2. Type d and the Customer List displays.

➤ To dial a Strata DK to upload/download data

1. After selecting a customer from the Dial DK Customer List, press one of the following 
function keys to establish communications:

♦ F2 DIU/DIU: Sends the DIU Initialization String (in Communications Setup) and 
the DIU String (in the Customer file) to the DKAdmin/DKBackup COM port (see 
Figure 17 on Page 131). 

♦ F3 DIU/DIU Modem: Sends the DIU Initialization String, the DIU String, the 
Modem Initialization String, and the Modem String to the DKAdmin/DKBackup PC 
COM port in the order described here (see Figure 21 on Page 137 and Figure 22 on 
Page 139).

♦ F4 Modem Initial + Modem Dial String:Sends both the Modem 
Initialization String from the Communications Setup Menu and the Modem String 
from the Customer File to the DKAdmin/DKBackup PC modem (see Figures 18 ~ 20 
on Pages 132 ~ 135).

♦ F5 Modem Dial String only: Switches from a voice call that is transferred 
to the DK maintenance modem. The Modem String from the customer file is sent to 
the DKAdmin/DKBackup PC modem (see Figure 19 on Page 133). You can also use 
F5 to dial the remote DK modem from the DKAdmin/DKBackup PC modem without 
initializing the DKAdmin/DKBackup PC modem.

DKAdmin/DKBackup establishes communications with the Strata DK per the procedures 
in Appendix A.

2. When complete, the DKAdmin/DKBackup Main Menu displays again. You may now 
download or upload DK data using the options in the Backup Menu (see “Upgrade” on 
Page 107).

➤ To update any of the available communication dialing strings

1. Highlight the customer from the Customer List screen, and press Enter.

Note If you have multiple customers, you can use the Find function to move quickly to
another customer by typing the first letter of the Customer ID number. The progr
highlights the first customer which matches your entry. Press Enter to select the 
highlighted customer or re-enter.

2. Highlight the field, enter the new information and press Enter.
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3. Pressing Enter from the last field on the screen, saves the new information and returns 
you to the Customer List screen. Pressing Esc, exits the screen without saving the 
changes and returns you to the Customer List screen. 

Hangup Connection
➤ To close the DK communications link

1. Type f and the File Menu displays.

2. Type h and DKAdmin/DKBackup sends +++ ATZ H from the DKAdmin/DKBackup PC 
COM port, closing the communication link to the DK.

Note The escape sequence of the modem or DIU connected to the DKAdmin/DKBackup 
PC must be set as +++ using the modem command ATS2=43.

Transfer DK Data
➤ To transfer DK data to a floppy disk to/from the DKAdmin/DKBackup PC hard drive database

1. From the File Menu, type 
t to display the Transfer 
DK Program Data screen 
(shown right).

2. Enter the drive/directory 
path you wish to transfer 
the data from (for example, 
C:\280ADMIN\XXX or 
C:\280BCKUP\XXX) 
and press Enter. (To 
switch the drive and 
directory, press F2.)

Note XXX = The customer directory. It is not necessary to add the.DK extension onto the 
customer directory when transferring data or creating customers from the Maintain 
Customer option.

3. Enter the drive/directory you wish to transfer data to (for example: A:\XXX).

4. Press Enter and follow the screen prompts to transfer the data.

5. Press Esc to close the Transfer DK Program Data dialog box.

About
➤ To access the option

1. Type f and the File Menu displays.

2. Type a and a pop-up dialog box displays, listing the name of the program, the release 
number and date, and the copyright date(s).

Exit
For information on exiting DKAdmin/DKBackup, see “Logging Off” on Page 33.
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Note The Administration Menu is only available in the DKAdmin program. The Check 
Processor Type, Backup/Restore Data, and View/Print Data appear in both the 
DKAdmin Administration Menu and the DKBackup Backup Menu. These functions 
are identical (e.g., screens, operations, commands, etc.) whether you use DKAdmin or 
DKBackup.

This chapter gives you step-by-step instructions on using the options available on the 
Administration Menu. The options are:

♦ View Cabinet Diagram

♦ Check Processor Type (see Page 100)

♦ System/Station Administration

♦ Flexible Key Programming Section

♦ Speed Dial Programming Section

♦ ACD Administration Section

♦ Program Administration Section

♦ Security Maintenance Section

♦ Directory Number Administration

♦ DNIS Administration

♦ Distributed Hunt Group Administration

♦ Call Forward Assignments

♦ E911/CAMA Trunk Programs (R4 Only)

♦ ISDN Programs (R4 Only)

♦ Backup/Restore Data (see Page 99)

♦ View/Print Data (see Page 115)

Important! In order to use any of the options in the Administration Menu, you must have first 
selected a customer in the File Menu, Select Customer option.
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View Cabinet Diagram
The base and expansion cabinet diagram displays the current Printed Circuit Board (PCB) 
configuration for the customer’s Strata DK system. The diagram varies based on the Stra
model and processor listed in the Customer File Maintenance screen.

➤ To view cabinet diagram

1. Select a customer 
using the Select 
Customer option in the 
File Menu.

2. From the 
Administration Menu/
Backup Menu, press g 
or Enter to display 
the PCB Placement per 
Program 03 screen for 
the selected customer 
(example shown at 
right).

3. Use the left/right 
arrow, CTRL, Home, End, Page Up and Page Down keys to scroll the screen.

Check Processor Type
For the Check Processor Type option, see “Check Processor Type” on Page 100.

System/Station Administration
The System/Station Administration option in the Administration Menu enables you to 
program or update system ports and stations. Depending on your password level, you ca
complete control over assignments of such items as:

♦ Logical ports assignments

♦ Telephone locations

♦ PDN/Intercom numbers

♦ DID numbers

♦ LCD user names

♦ Voice mail forward ID codes

♦ Voice mail message waiting codes

♦ System speed dials

♦ System messages

♦ Station attributes (40 individual telephone options)
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to the 
While you can assign these attributes to individual ports, station attributes cannot be copied 
from one port to another, or set for a range of ports from this menu. However, range 
programming for ports can be completed on a program level using the Program 
Administration option.

Some features (Intercom/DID numbers and VMID codes) enable you to set a range of values 
(default values) which can be applied to all ports, making programming quick and easy.

Note It is recommended, if you are updating station attributes and have not performed a 
system backup recently, that you do so before updating system information. For 
information, see Chapter 7 – Backup Menu (DKBackup).

➤ To access the option

1. Type a and the 
Administration Menu 
displays (shown right).

2. Type s and the 
System/ Station 
Administration screen 
displays.

The System/Station 
Administration screen 
displays the entire 
system as it currently 
exists. For each 
physical port, you can:

♦ Enter the location (room or office name) of each telephone or device connected 
Strata DK.

♦ Transfer telephone attributes to another telephone by changing the logical port 
number.

♦ Enter a PDN/Intercom number.

♦ Enter a DID number.

♦ Enter a user name.

♦ Enter a voice mail call forward ID code.
● Enter a voice mail message waiting code.

● Assign speed dial numbers.

● Assign system messages.

Important! The DKAdmin PC must be connected to the Strata DK to upload any changes to 
this data (see Appendix A – Connecting to Strata DK for procedures on 
connecting the DKAdmin PC to a Strata DK).

You can also:

♦ Print the information for all system ports.

♦ Print the attributes for a particular port.

♦ Print the Strata DK cabinet configuration.
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Programming/Updating System

➤ To program or update the entire system or an individual port

1. Highlight the Telephone Location field of the physical port with which you wish to work. 
Enter the physical telephone location (for example, main conference room, VP office, 
lunch room, etc.).

2. Highlight the Log. Port No. field of the physical port.

Note Logical port number assignments are the same as the physical port unless you wish to 
relocate (swap) telephone attributes.

This enables you to utilize the telephone attributes (voice mail, speed numbers, messages, 
etc.) of a particular telephone at a different location. For example, you might wish to 
transfer your office telephone attributes to a conference room.

3. Type the logical (Log.) port number of the telephone containing the attributes you wish to 
transfer and press Enter. The ports relocate after you press F9 to save and upload.

Important! Ports only relocate to the same Port Type (PT).

4. Highlight the Int/PDN No. field. This field enables you to change a telephone’s interc
number. If you attempt to enter a number already assigned to another telephone, an
message displays: Conflict found in Int./DN numbering

Note You cannot duplicate DNs/intercom numbers. 

...or

if you would like to change the DNs/intercom numbers on all of the ports at one time
press F5. A message displays.

Press any key to continue. A Change dialog box displays.

Enter the Starting Int./DN Number you wish to assign and press Enter. A pop-up screen 
displays: This operation will modify DN numbers. Go ahead?

Press Enter to continue or highlight No and press Enter to discontinue the procedure.
The DNs/intercom numbers for all of the ports are changed if you enter Yes.

5. Highlight the DID No. field. This field enables you to enter a dial-in-direct extension 
number. If you attempt to enter a number already assigned to another telephone, an
message displays: Conflict found in DID Extension numbering

Please review Program 05 either before or after making 
your changes as conflicts may arise from inserting Int./
DN numbers which start with the same digit as the access 
codes in Program 05.

In a default DK setting, digits 8 and 9 are used in Pro-
gram 05 and therefore should not be used as the first 
digit of Int./DN numbers.

PDN Port Ref. From 000 to 031, Starting DN:_________.

Blank entry does not change value, “0” indicates blank.
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Note You cannot duplicate DID numbers. 

...or

if you would like to change DID numbers for a range of ports, press F5. A Change dialog 
box displays similar to the one shown above.

Type the Starting DID Number you wish to assign and press Enter. A pop-up screen asks 
you to confirm the change. The DID numbers for the range of ports you specified are 
changed if you enter Yes.

6. Highlight the Telephone LCD User Name field. Enter the name of the user assigned this 
physical port

...or

if you prefer, you may use DNs/intercom numbers in this field rather than names. To insert 
DNs/intercom numbers into this field for all ports, press F5.

7. Highlight the VM MW ID Code field. This field enables you to assign a voice mail call 
pick-up ID code (enabling users to pick-up their voice mail messages)

...or

you may set a starting default ID prefix for all ports by pressing F5. A Change dialog box 
displays. Type the voice mail ID prefix number (example: 92) you wish to begin the 
sequence and press Enter. A confirmation message displays: All Ports Will Be 
Reset To Default Values. Go Ahead?

Press Enter to assign the VM MW ID code. The prefix is added to each mailbox (DN/
Intercom) number. If you change your mind, and wish to cancel the operation, highlight 
No and press Enter.

8. Press F9 to save and upload your changes to the Strata DK, or F10 to save the data to the 
customer database file.

Printing Port/Station Information (F3)

➤ To print port and station information

1. Press F3. The Select 
Printout screen 
displays (shown right).

2. Highlight the desired 
report and press 
Enter. The Printer 
Selection screen 
displays (shown right).

Note The current port is 
the port that is 
highlighted on the 
System/Station 
Administration 
screen.

3. Press Enter to print the selected information.
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em 
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 Bin 
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For information on selecting printers, see Chapter 8 – Options Menu. See Figure 8 for a 
System/Station Administration printout example.

System Speed Dial Number (F7)

➤ To set or change available system speed dial numbers

Note You may assign system speed dial numbers to individual ports for up to 800 syst
speed dial numbers for the RCTUE/F processor, 100 for RCTUBA/BB, RCTUC/D
processors, and 40 for TMAU and RCTUA processors.

1. From the System/
Station Administration 
Menu, press F7. The 
System Speed Dial 
Numbers screen 
displays (shown right). 

2. Highlight the System 
Speed Dial No. field. 
Enter the speed dial 
telephone number, 
including area code 
(example: 
7145559696). Do 
not enter dashes.

3. Highlight the System Speed Dial Memo field and enter a description of the speed di
number (up to 12 characters). This memo displays on the telephones LCD when the
Number is selected by an LCD telephone, using the MODE 8XXX function (where X
is the speed dial bin number).

4. Press F10 to save the speed dial assignments and return to the System/Station 
Administration screen.
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System LCD Messages (F8)

➤ To set or change available system LCD messages

Note You may create up to 40 system messages which may be used by all LCD telephone 
ports. Each message may contain two lines using up to 32 characters.

1. From the System/Station 
Administration Screen, 
press F8. The System 
Messages screen 
displays (shown right). 

2. Highlight the Message 
Line 1 field and type the 
message you wish 
displayed on the first 
message line of the 
LCD.

3. Highlight the Message 
Line 2 field and type the 
message you wish displayed on the second message line of the LCD. 

4. Press F10 to save the message assignments and return to the Station Administration 
screen.

Station Port Attributes (Ctrl Enter)

➤ To program or update individual station port attributes

1. On the System/Station 
Administration Screen, 
highlight the port you 
wish to program and 
press Ctrl+Enter. 
The Port Attributes 
screen displays (shown 
right).

This screen lists all the 
features available for 
an individual 
telephone. 
Additionally, you can 
view CO Line 
information, or assign personal Speed Dial and LCD Messages to this telephone. The 
definitions of each program item are listed in Table 3 on Page 50.

2. Highlight the Attribute field.

Note Pay close attention to the message bar at the bottom of the screen. It will tell you what 
options are available for each program.

3. Depending on the attribute you can either:
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♦ Press the spacebar to toggle between available options, or enable (indicated by a check 
mark)/disable (indicated by a blank) the attribute.

♦ Enter a value.

4. Press F10 to save the changed data to the customer database file. 

Note After saving the data, press F9 to update the Strata DK with the changes. The 
DKAdmin PC must be connected to the Strata DK to upload changes to port attributes 
(see Appendix A – Connecting to Strata DK).

Table 3 Attribute Definitions

Attribute Description

Telephone 
Keystrip Type

Four default telephone button arrangements are provided. Changing the keystrip type 
writes/overwrites existing button assignments.

Ring Tone Distinctive system ringing sends a different ring tone for CO (loop, DID, or ground) line 
ringing than that for intercom, tie ringing. In addition, CO line (loop or ground) ringing can 
be different from one telephone to another.

Volume Level This program sets the initial off-hook volume level for each digital telephone handset and/
or headset.

Speakerphone 
Enabled

Any electronic or digital full speakerphone operation can be disabled by assignment with 
this program. If disabled, a speakerphone will act as a handsfree electronic or digital 
telephone. Initialized data enables all speakerphones.

MIC Key Lock 
Enabled

An electronic or digital telephone microphone can be turned on or off by using the Mic 
button. A button lock operation enables an alternate action Push On/Push Off of the Mic 
button.

MIC on at Start 
of Call

The microphone, as well as the MIC LED, can be selected to be on or off at the start of a 
call if the Push On/Push Off mode is chosen.

Call Pkup 
On=AC, Off= 
AC, GP & STA

If ON, a station or group of stations (Pickup Group) can pick up a call that is ringing 
another stations’s [PDN] or [PhDN], a call placed on hold at another station and other 
types of calls.

Speed Dial 
Allowed

A station may be denied the use of Speed Dial (Station and System) with this program.

ABR Access 
Enabled

The ABR feature can be enabled or denied for each station. The system selects the last 
line in the originating line group each time ABR is initiated.

OCA/Busy 
Override 
Automatic

A busy digital or electronic telephone can receive a second voice communication on 
intercom via Handsfree Answerback if the OCA feature is installed. If a calling station does 
not have an automatic function, the user must dial an extra digit of 2 after hearing busy 
tone in order to gain access to OCA.

Forced Account 
Code

If this feature is selected, a station or Direct Inward System Access (DISA) CO line user 
using a line with a Forced Account requirement must enter an Account Code before the 
call can be completed.

Change TR 
Override Code

If selected for this feature, a station can change Toll Restriction (TR) override codes.

Change DISA 
Security Code

This enables a selected station to change the DISA security code.

SLT 
ANTI-Bounce

SLT Hookflash Anti-Bounce Guard (LED 12 ON) in Program 30 prevents false recalls due 
to hookflash bounce during SLT hang-up on outside calls.

Account Codes 
Verified

If the system is set for Verified Account Codes in Program 69, station users must enter 
specific codes when entering Forced or Voluntary Account Codes. 
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Change Verified 
A.C.

If selected for this feature, a station can change the Verified Account Codes established in 
Program 69. 

Change T.C.O. 
Code

If selected for this feature, a station can change the Toll (Restriction) Class Override 
codes. 

DND Override 
Allowed 

If selected for this feature, a station can override other stations that are in the DND mode.

Executive 
Override 
Allowed

This program enables a station to break into and overhear an existing station conversation 
by dialing the digit 3 after the busy station number. A warning tone may be set optionally.

Private Override 
Allowed

Privacy Override enables a station to enter into and overhear an existing CO line 
conversation by pressing a common CO line button.

Page Group 
Assignments
(A ~ D)

Digital and electronic telephones can be assigned to intercom page groups with this 
program. Each group can have as many as 120 stations. The RCTUC/RCTUD common 
control unit can support as many as eight groups, and the RCTUB and the RCTUA units 
can support up to four. Telephones can be a member of more than one group. Station 
users can access each group separately by dialing access codes.

Handsfree 
Disabled 

It is possible to disable the intercom handsfree function on any digital or electronic 
telephone.

Handsfree No 
Warning

Normally, a one-second warning tone is sent to a handsfree digital or electronic telephone 
to inform its user that someone is calling and that they can be heard. If the warning tone is 
not desired, this assignment can disable it. 

OCA Enabled 
(Receive)

A busy digital or electronic telephone can receive a second voice communication on 
intercom via Handsfree Answerback if the OCA feature is installed. If a calling station does 
not have the automatic function, the user must dial an extra digit of 2 after hearing busy 
tone in order to gain access to OCA.

All Call Page 
Allowed

Assigns the station to be included in the All Call Paging group. A maximum limit of 120 
telephones (Toshiba digital or electronic) can be assigned to receive all call page.

BOV Tone
(Off = 2 Beeps, 
On = 
Continuous)

If a digital or electronic telephone [DN] is busy and it receives a call on an idle [DN] or CO 
button from another station or an outside line, the telephone receives two muted-ring 
bursts three seconds apart or continuously repeating muted-ring bursts every three 
seconds on the idle [DN].

Pooled Line
(On = No Flash if 
No Ring)

If on, incoming line calls in pooled line groups only flash on pooled line buttons.

HS-OCA
WNT (Off = No 
WNT, On = S-
OCA WNT)

Activates/deactivates 2-way voice path to Off-hook Call Announce caller. Available only on 
digital telephones.

OCA
(Off = Speaker, 
On = Handset)

A busy digital or electronic telephone can receive a second voice communication over the 
telephone handset/headset or over the telephone speaker.

Block Exec/
Privacy Override

If selected, executive and privacy override to the selected station is not allowed.

Group Pickup 
Assignments
(1 ~ 20)

Stations can be divided into as many as 20 pickup groups. Station users can pick up calls 
that are ringing any station within their group by dialing a single access code for a flexible 
button, and pick up calls that are ringing stations in other groups by dialing selected 
access codes. Stations can belong to more than one group.

Table 3 Attribute Definitions (continued)

Attribute Description
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Ringing Line 
Preference 

A user, by going off-hook (or by pressing the Speaker button) may be automatically 
connected to the lowest line ringing in without having to press a CO line button or dial an 
access button.

Automatic 
Preference 

Automatic Preference via handset off-hook or the Speaker button is the automatic 
connection to lines or the intercom under various conditions. 

Hunt to 
Directory 
Number [DN]

If a station is busy, Station Hunting enables the ringing of an alternate station as defined by 
the assignments in this program. If the “hunt-to” station is busy, the system tries to ring the 
next “hunt-to” station, and so on.

Standard 
Telephone 
Camp-on Tone

Camp-on tone is sent when the busy standard telephone receives a transferred CO line 
call. Camp-on tone is two one-second bursts of 1209Hz/interrupted by 160ms bursts, 
three-seconds apart.

Hold/Park Recall 
Time 

Each station can have a different time (from 011 to 160 seconds) from the point of placing 
a call on hold or park to the point of recall.

MW Lamp
(Off = No Lamp, 
On= With Lamp)

Turns on and off a message waiting LED for EKT and flash button.

LCD Personal 
Messages (10-
19) Allowed 

This option enables LCD digital and electronic telephones to store up to ten personal 
messages and offers the option of entering alphanumeric memos for each of the LCD’s 
Station Speed Dial numbers.

Hold Display 
Scroll 
(On=Enabled)

Disables/enables the Hold Display Scroll feature independently for each telephone. When 
more than one call is on hold on a telephone, the Hold Display Scroll feature enables a 
user to scroll through the held lines.

Key 13-TR/14-TR 
After Answer

Determines whether or not a toll restricted telephone user is allowed to dial additional 
digits after answering an incoming CO line call. Initialized data sets both LEDs off for all 
telephone users. Both LEDs should be turned on for Toll Restricted telephones that must 
answer incoming CO line calls and use speed dial buttons programmed to Hold or Park 
calls and access the page system automatically.

No CF/NA 
Handsfree 

A Handsfree Answerback call to an idle station in the Call Forward No-Answer or Call 
Forward-Busy/No Answer mode does not forward if this feature is activated. This prevents 
the call from being forwarded 8 ~ 60 seconds after the called party has been talking in the 
handsfree talk mode (handset on-hook). Outside calls and busy intercom calls to the 
station continues to forward with this feature set.

DKT2000 Cont. 
DTMF Tones Off 

2000-series Digital Telephones can send DTMF tones for as long as station users press 
their buttons (80 msec. minimum). This feature can be disabled with LED 17. If disabled, 
DTMF tones sent by these telephones are either 80 or 160 milliseconds, depending on the 
selection made with Program 10-1, LED 04 and Program 10-2, LED 06.

Automatic Hold If this feature is allowed, station users with CO line buttons can place a CO line or intercom 
call on hold automatically by pressing another CO line button, or the DN/intercom button 
and dialing the number.

Busy Station 
Ringing/Busy 
Station Transfer

Busy Station Ringing (BSR) and Busy Station Transfer (BST) operate together to ensure 
that a busy station always receives transferred line calls along with LED and tone 
indications. The station or Voice mail (VM)/auto attendant device that transfers the call 
must be programmed with BST (LED 20 ON) and the one that receives it must have BSR 
(LED 19).

Fixed Call 
Forward to 
Station Port

Fixed Call Forwarding is different from other station Call Forwarding options. It is fixed in 
terms of the destination station number which is assigned in this program. The station user 
cannot change the Fixed Call Forward destination, unlike the other station Call Forwarding 
options. 

Ring Transfer 
(Camp-on) Time 

If a busy or ringing station does not answer a call sent to it via call transfer (CO line or over 
tie lines), the station originating the transfer is recalled after an amount of time determined 
with this program.

Table 3 Attribute Definitions (continued)

Attribute Description
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Copy Range (F2)

➤ To copy a range of attributes 

1. Press F2 from the Port 
Attributes screen and a 
pop-up dialog box 
displays (shown right), 
warning you of the 
consequences of using 
this feature.

2. Press any key to continue and a pop-up box requesting port numbers displays: Copy to 
Port(s): 000 to 079.

3. Enter the port numbers in the from and to fields. A warning message appears if you enter a 
number out of range. A pop-up dialog box displays asking you to confirm the copy 
request.

4. Highlight Yes and press Enter to continue or press Enter to discontinue and return to 
the Port Attribute screen.

5. If you answered Yes in Step 4, another pop-up dialog box displays: Do You Want to 
Copy PRG38/PRG39-Flexible Key Assignments Also?

Highlight Yes and press Enter to copy to the PRG38/39 Key Assignments and range of 
ports. Press Enter to only copy to the range of ports.

LCR Station 
Group

This option assigns the station to a particular LCR group routing scheme. The Least Cost 
Routing (LCR) feature enables the system to automatically route each outgoing voice call 
over common carriers and selected lines. The customer chooses these lines for the 
specific time of day, and for system users with varying priorities.

Station T.R. Digit 
Restriction 

Digit Toll Restriction involves the system analyzing the area and office codes, and 
selectively enabling/disabling outgoing calls following the criteria defined in Area Code 
Tables and Office Code Tables. If T.R. Digit Restriction is enabled, a station cannot dial 
digits after dialing a telephone number.

Station T.R. 
Restriction 
Code

Each of the Toll Restriction classes established in Program 46 can be assigned a code 
with this program. If one of these codes is entered at a station, the station assumes the 
code’s class for that call. When the call is complete, the station returns to its regular class 
assigned in Program 48.

Table 3 Attribute Definitions (continued)

Attribute Description
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Flexible Button Assignments (F5)

➤ To view or change flexible button assignments

1. Press F5 from the Port 
Attributes screen and the 
Port Flexible Key 
Assignments screen 
displays (shown right).

2. To change a flexible 
button assignment, 
highlight the Flexible 
Key Assignment and 
press:

♦ F5–Pause to 
deactivate or blank 
out a key 
assignment.

♦ F9–Increment SD to add multiple speed dial key assignments.

Important! You can only use this key when you are assigning more than one speed dial key at 
a time. If you have not just added a speed dial key assignment, the message Must 
Assign System/Station Speed Dial First displays.

If you leave the cursor in the same field and continue to press F8, the speed dial 
key number increments. To add consecutive speed dial key assignments, you must 
continue to highlight the next field before pressing F8.

3. Press Esc to return to the Port Attributes screen.

Important!

● After restoring flexible keys (Program 39) data, turn the DK system off for five seconds, 
then turn it back on to apply the changes made.

● If you change the keystrip type (Program 38) from the station attribute screen, all keystrip 
buttons will be set to Program 38 default assignments. If you wish to change a keystrip 
type (from 20 to 10, for example) and save the existing (first 10) key button assignments, 
operate Program 38 from the Program Administration Section option.

➤ To copy selected keys to selected ports

1. Press Ctrl+F2 and a pop-up dialog 
box displays (shown at right).

2. Press any key to continue.

3. Highlight a key and press the spacebar 
to select. An asterisk appears next to 
your selection. Continue until all the 
keys you want to copy have been 
selected.
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4. Press Ctrl+F2 again. A pop-up 
dialog box displays (shown at right).

5. Type the desired ports and press 
Enter. Another pop-up dialog box 
displays asking you confirm the 
change.

6. Highlight Yes and press Enter to make the change or No to cancel the changes.

7. Press F10 to save the changes you just made.

CO Line Assignments (F6)

➤ To view CO line assignments

1. Press F6 from the Port 
Attributes screen. The 
Port CO Line 
Information screen 
displays (shown right).

2. To turn any program 
on/off, highlight the 
program number for 
the CO Line and press 
the spacebar. A check 
mark indicates the 
program is on.

3. Press Esc to return to the Port Attributes screen.

Speed Dial Assignments (F7)

➤ To assign speed dial assignments

➤ Press F7 from the Port 
Attributes screen. The 
Port Speed Dial 
Numbers & Memos 
screen displays (shown 
right). Refer to Page 
68 for procedures.
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System Messages (F8)

➤ To assign system messages

➤ Press F8 from the Port 
Attributes screen. The 
Port Personal 
Messages screen 
displays (shown right). 
Refer to Page 49 for 
procedures.

Saving/Uploading Programmed Data (F9)

➤ To upload programmed data
➤ After completing your programming, press F9 to save the information and begin the 

uploading process. See “Restore Data” on Page 102 for complete procedures.
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Printout Examples

Customer Name
PCB Placement Per Program 03 Assignments

CABINET 1 R11 RCTU S11 S12 S13 S14 S15 S16

PCB Type RCTUB PDKU PDKU RSTU RATU RDTU PIOU

Port Nos. 000~007 008~015 016~023 024~027 028~035

Line Nos 001~008

Option RRCS-8 OCA OCA 8-TDGL TTY/MDU

CABINET 2 S21 S22 S23 S24 S25 S26 S27 S28

PCB Type RSTU RCOU RSTU PIOU RDTU PDKU

Port Nos. 036~043 044~051 052~059 060~067

Line Nos 009~016 017~924

Option RCOS ACD/MIS 8-TDGL

Figure 7 Cabinet PCB Installation Printout

Figure 8 System Speed Dial Numbers
(prints out with System/Station Administration Report)

CUSTOMER NAME
System Speed Dial

System Speed Dial
Bin Number

System
Speed Dial Number

System
Speed Dial Memo

600
601
602
603
604
605
6....

17145833700
13124675889
1723727173721
4773938
4737473
4789994
434...

TOSHIBA
CHICAGO
NEW YORK
DOWN
TOWN
DEALER A
DEALER B

Figure 9 System Telephone LCD Messages
(prints out with System/Station Administration Port)

CUSTOMER NAME
System Messages

System LCD
Message Number

Message
Line 1

Message
Line 2

060
061
062
063
064
06...

OUT TO LUNCH
IN A MEETING
CALL BOB AT 3:00
BACK AT 7 PM
RETURN ON MONDAY

UNTIL 1:00PM
UNTIL 2:30PM
583-1111
OR 8PM I HOPE
OR TUESDAY
57Administration Menu (DKAdmin)



System/Station Administration –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
Figure 10 Basic Telephone/Port Assignments 
(prints out with System/Station Administration Report)

System/Station Administration

➊
C
S
N

➋
Phy. 
Port 
No.

➌
PT

     ➍
Telephone 
Location

➎
Log 
Port 
No.

➏
Int. 
No.

➐
DID 
No.

        ➑
Telephone LCD 
User Name

  ➒
VM CF 
ID Code

  ➓
VM MW 
ID Code

001
002
003
004
005
006
007
008
009

001
002
003
004
005
006
007
008
009

DO
DO
DO
DO
DO
DO
DO
DO
DO

OFFICE #114
OFFICE #112
OFFICE #109
OFFICE #87
OFFICE #107
CAFETERIA
SHIPPING DOCK
CONFERENCE
PHONE ROOM

000
001
002
003
004
005
006
007
008

3200
3201
3202
3203
3204
3205
3206
3207
3208

3200
3201
3202
3203
3204
3205
3206
3207
3208

SALLY 3200
LINDA 3201
GARDEN 3202
HARDWARE 3203
FRED C 3204

91200
92201
92202
92203
92204
92205
92206
92207
92208

92200
93201
23202
93203
93204
93205
93206
93207
93208

➊ Cabinet Slot Number in which the port is installed.

➋ Physical Port Numbers: RCTA = 001~031; RCTUB = 000~079; RCTUC/D = 000~239; RCTUE/F = 000~335
Port Type: DKAdmin scans Program 03 and identifies all physical ports and reads other programs as shown by (   ) to
identify special ports.

➌ Port Identification Codes
AC - Attendant Console Port (Prog 03, code 51)
DL - DID Line Port (Prog 03, code 71~73 and *41-2)
DD - Digital Port with DSS (Prog 03, code 63, 64)
DO - Digital Port with OCA (Prog 03, code 62, 64, 28)
DT - Digital Port (Prog 03, code 61, 63, 27)
ED - Electronic Port with DSS (Prog 03, code 23, 24)
EO - Electronic Port with EOCU (Prog 03, code 22, 24,
         26)
ET - Electronic Port (Prog 03, code 21, 23, 25)
ST - Standard Port (Prog 03, code 25~31)
TL - TIE Line Port (Prog 03, code 71~73 and *41-2)
VA - Vacant Port (Prog 03, code DO)
PT - Port Type

Special Ports
AG - ACD Announcement Port (Prog 14-3)
AM - ACD Music Port (Prog 14-3)
AP - AA Primary Announcer (Prog 23)
AS - AA Secondary Announcer (Prog 24)
BM - Background Music Port (Prog 03, 10-2/LED 09/10, 19)
DI - PDIU-DI Port (Prog 20)
DS - PDIU-DS Port (Prog 20)
DP - Doorphone Port (Prog 77-1)
EA - External Amplifier Port (Prog 10-3)
MP - Modem Pool (Prog 21)
VM - Voice Mail Port (Prog 31, LED 17 ON)

➍ This is a test field in which the location of the physical port wiring termination point (telephone jack) may be entered.

➎ Logical Port associated with physical port.

➏ Intercom number associated with logical port.

➐ Direct-in-Dial number associated with logical port. (Column not available in DKAdmin R4 or higher software.)

➑ LCD User Name associated with logical port.

➒ Voice Mail Call Forward (#656) code.

➓ Voice Mail Message Retrieve (#657) code.
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Figure 11 Station Attributes by Station 
(prints out with current port attributes)

CUSTOMER NAME
Intercom 202/Port 002 Attributes for BRIAN No: 202

PRG KEY Feature Description Attribute

38
80
27
30
30

01
02

Telephone Keystrip Type
Ring Tone
Volume Level
Speakerphone Enabled
MIC Key Lock Enabled

20-Button (A)
3
3
✓

✓

Figure 12 Flexible Key Assignments by Station 
(prints out with current port attributes)

CUSTOMER NAME
Intercom 202/Port 002 Flexible Key Assignments for BRIAN No: 202

Key
No.

Flexible Key Assignment Flexible Key Assignment
Key 
No.

10
 9
 8
 7
 6
 5
 4
 3
 2
 1

ACD - Log In/Out
Station Speed Dial 011
Station Speed Dial 010
ACD - Agent Not Available
ACD - Pickup
ACD - Wrap Up
ACD - Record Account
Speed Dial Select (*Key)
Pooled Line 302
Intercom

ACD - End of Shift
System Speed Dial 605
System Speed Dial 604
ACD - Cancel Queue Alarm
ACD - Monitor Call
System Speed Dial 600
System Speed Dial 601
System Speed Dial 602
System Speed Dial 603
ACD - Help

20
19
18
17
16
15
14
13
12
11

Figure 13 Station Speed Dial/Memos by Station 
(prints out with current port attributes)

CUSTOMER NAME
Intercom 202/Port 002 Speed Dial Numbers & Memos for BRIAN No: 202

Speed Dial
Bin Number

Speed Dial
Number

Speed Dial
Memo

010
011
012
013

7584930
5849605
5840396

HOME
MARY
DOCTOR JONES
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Figure 14 Station Personal LCD Messages by Station 
(prints out with current port attributes)

CUSTOMER NAME
Intercom 202/Port 002 Personal Messages for BRIAN No: 202

Personal
Message Number

Message
Line 1

Message
Line 2

010
011

CALL BRIAN ASAP
OUT OF OFFICE UNTIL AUG. 15

Figure 15 Station CO Line Ringing and Access Assignment by Station 
(prints out with current port attributes)

CUSTOMER NAME
Intercom 202/Port 002 CO Line Information for BRIAN No: 202

CO
Line

81 82 83 84 85 86 87 88 89 40 41 43 *81 *84 *87

001
002
003

✓

✓

✓

✓

✓

✓

81 - Program 81 - DAY Immediate Ring
82 - Program 82 - DAY 12 Second Delay Ring
83 - Program 83 - DAY 24 Second Delay Ring
84 - Program 84 - DAY 2 Immediate Ring
85 - Program 85 - DAY 2 12 Second Delay Ring
86 - Program 86 - DAY 2 24 Second Delay Ring
87 - Program 87 - NIGHT Immediate Ring
88 - Program 88 - NIGHT 12 Second Delay Ring
89 - Program 89 - NIGHT 24 Second Delay Ring
40 - Program 40 - Station CO Line Access (Incoming/Outgoing)
41 - Program 41 - Station Outgoing Call Restriction
43 - Program 43 - 0+ Credit Card Dialing Option
*81~*87 - Programs *81~*87 - Ground/Loop/Start/CO Line to [DN] LED

 Flash Assignments
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Flexible Button Programming Section
The Flexible Key Programming Section option in the Administration Menu enables you to 
maintain flexible button assignments for telephones, add-on modules, DSS consoles and 
attendant consoles. 

➤ To access flexible button assignments

1. Type a and the 
Administration Menu 
appears.

2. Type u and the Flexible 
Key Program 
Administration screen 
displays (shown right).

Telephone Flexible Button Assignments

➤ To access the option

➤ Press Enter and the 
Telephone Flexible Button 
Key Assignments screen 
displays (shown right).

This screen enables you to 
assign features to 10 or 20 
telephone buttons for each 
of your logical ports, 
individually or by range. 
You can also copy buttons 
from one port to another or 
to a range of ports for 
quick and easy feature editing.

When copying keystrips, you can choose to copy (or not copy) over existing PDNs and/or 
PhDNs on the “Copy to” port or port range.

➤ To change an assigned button

1. Highlight the port you 
want to change, press F5, 
and the Port Flexible Key 
Assignments screen 
(shown at right) for that 
port displays.

2. Highlight the key you wish 
to change.
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3. Press F2 to make the key a Primary DN, F3 a Secondary DN, F4 a Phantom DN, or F6 to 
change the key feature.

If you press F3 or F4, a pop-up list appears and you must enter a primary or secondary 
number. If the number you enter does not exist, the following warning message appears 
and you must re-enter the number.

DN Does Not Exist. Please Refer to Program *04.

...or

press F5 to deactivate or blank out a key assignment

...or

if you press F6, a 
feature pop-up list 
displays (shown right).

Highlight the feature 
you want to assign to 
the button and press 
Enter. Some entries 
(such as the CO Line 
feature) require you 
enter a value when 
making an assignment. 
The selected feature 
replaces the previous 
feature.

Note You can only assign a feature to one button within a port. If you attempt to assign a 
feature already assigned, an error message displays.

...or

press F8 to add multiple speed dial key assignments.

Important! You can only use this key when you are assigning more than one speed dial key at 
a time. If you have not just added a speed dial key assignment, the message Must 
Assign System/Station Speed Dial First displays.

If you leave the cursor in the same field and continue to press F8, the speed dial 
key number increments. To add consecutive speed dial key assignments, you must 
continue to highlight the next field before pressing F8.

➤ To copy selected keys to selected ports

1. Press Ctrl+F2 and a pop-up dialog 
box displays (shown at right).

2. Press any key to continue.

3. Highlight a key and press the spacebar 
to select. A asterisk appears next to 
your selection. Continue until all the 
keys you want to copy have been 
selected.
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4. Press Ctrl+F2 again. A pop-up 
dialog box displays (shown at right).

5. Type the desired ports and press 
Enter. Another pop-up dialog box 
displays asking you confirm the 
change.

6. Highlight Yes and press Enter to make the change or No to cancel the changes.

7. Press F10 to save the changes you just made.

Add-On Module Button Assignments

➤ To access the option

1. Highlight the Add-On Module Button Assignments option and press Enter.

If you have not yet assigned an add-on module to any of your ports, a message displays: 
No Ports Have Add-on Modules. Do You Want To Add A Port?

♦ To add a port, press Enter. A Port Number pop-up box displays: Port Number 
000.

♦ Type the port 
number for which 
you wish to edit add-
on module button 
assignments. The 
Add-On Module 
Button Assignments 
screen displays 
(shown right).
This screen enables 
you to assign 
features (CO Line, 
Direct Station, 
Station Speed Dial or System Speed Dial) to 20 LED buttons on two add-on modules 
(for a total of 40) to any of the physical ports. You can also copy features from one 
port to another for quick and easy feature editing.

➤ To make assignments to another port

1. Press F2 and a Port Number pop-up dialog box displays.

2. Type the port number that you wish to work with. If you have not assigned an add-on 
module to the specified port, a message displays:

Port does not have add-on module. Add?

3. Press Enter to add an Add-On Module

...or

scroll through the current Add-On Modules by pressing the + key to display the next port, 
or the - key to display the previous port.
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➤ To copy the features from one port to another

1. Highlight the LED you wish to copy and press F4. The Copy to Port dialog box displays.

2. Type the range of port numbers that you wish to copy TO.

3. Highlight the Button Assignment Column of Add-On Module 1 or 2 for the LED you wish 
to change and press F3. A message displays at the top of the screen:

Current template copied from port XXX.

Press Enter to display the Feature pop-up box. 

4. Highlight the feature you want to assign to the button and press Enter. A value entry 
pop-up box displays.

5. Enter the appropriate number or code for the selected feature. The feature is copied from 
this port to the ports specified in Step 2.

6. Repeat Steps 1 ~ 5 for each button you wish to copy.

7. Press F10 to save your changes and return to the Flexible Key Program Administration 
screen.

➤ To clear the port

1. To clear the port and return to the default settings for all options, press F5. A message 
displays: Are you sure?

2. Press Enter to clear the port.

➤ To change an assigned feature

1. Highlight the Button 
Assignment column 
for either Add-On 
Module 1 or 2 for the 
LED you wish to 
change and press F6. 
A feature pop-up list 
displays (shown right).

2. Highlight the feature 
you want to assign to 
the button and press 
Enter. A value entry 
pop-up displays.

3. Enter the appropriate 
number or code for the selected feature.

Note You can only assign a feature to one button per port. If you attempt to assign a feature 
already assigned, an error message displays.
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➤ To assign more than one speed dial number

1. Follow the procedure for changing an assigned feature and assign a station/system speed 
dial number.

2. Press F8– + SD to add additional speed dial key assignments.

Important! You can only use this key when you are assigning more than one speed dial key at 
a time. If you have not just added a speed dial key assignment, the message Must 
Assign System/Station Speed Dial First displays.

If you leave the cursor in the same field and continue to press F8, the speed dial 
key number increments. To add consecutive speed dial key assignments, you must 
continue to highlight the next field before pressing F8.

DSS Console Button Assignments

➤ To access the option
➤ Highlight the DSS 

Console Button 
Assignments option 
and press Enter. The 
DSS Console Button 
Assignments screen 
displays (shown right) 
which enables you to 
assign features to 20 
DSS console key 
buttons.

➤ To reset all keys and return them 
to their default settings

1. Press F5. A message displays: Are you sure you want to reset flexible 
keys?

2. Highlight Yes and press Enter to reset the keys or press Enter to terminate the 
resetting.

➤ To change an assigned feature

1. Highlight the key 
assignment you wish to 
change and press F6. A 
feature pop-up list 
displays (shown right).

2. Highlight the feature you 
want to assign to the 
button and press Enter. 
Some entries (such as the 
CO Line feature) require 
you type a value when 
making an assignment. 
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xible 
The selected feature replaces the previous feature.

Notes

● You can only assign a feature to one button within a console. If you attempt to assign a 
feature already assigned, an error message displays.

● Press F8–Increment SD to add additional speed dial key assignments.

Important! You can only use this key when you are assigning more than one speed dial key at 
a time. If you have not just added a speed dial key assignment, the message Must 
Assign System/Station Speed Dial First displays.

If you leave the cursor in the same field and continue to press F8, the speed dial 
key number increments. To add consecutive speed dial key assignments, you must 
continue to highlight the next field before pressing F8.

3. After setting each key, press F10 to save your changes and return to the Flexible Key 
Program Administration screen.

➤ To make assignments to another console or console group

1. Scroll to another console/console group (+ scrolls forward, - scrolls backward).

2. Press Esc to close the DSS Console Button Assignments screen and return to the Fle
Key Program Administration screen.

Attendant Console Flexible Button Assignments

Note This option cannot be used by Strata DK Release 2 or below.

➤ To access the option
➤ Highlight the Attendant 

Console Flexible Button 
Assignments option and 
press Enter. The 
Attendant Console 
Flexible Button 
Assignments screen 
displays (shown right). 
This screen enables you 
to assign features to both 
left and right key 
assignments.
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turn 
➤ To edit your attendant console flexible button assignments

1. Highlight the key 
assignment you wish 
to change and press 
F6. A feature pop-up 
list displays (shown 
right).

2. Use the +/- keys or 
the Page Up/Page 
Down keys to scroll 
through the list. 
Highlight the feature 
you want to assign to 
the key and press 
Enter. The selected feature replaces the previous feature.

3. To move between the left and right key assignments, press F2.

♦ You can only assign a feature to one button within a console. If you attempt to assign a 
feature already assigned, an error message displays.

♦ Press F8–+ SD to add additional speed dial key assignments.

Important! You can only use this key when you are assigning more than one speed dial key at 
a time. If you have not just added a speed dial key assignment, the message Must 
Assign System/Station Speed Dial First displays.

If you leave the cursor in the same field and continue to press F8, the speed dial 
key number increments. To add consecutive speed dial key assignments, you must 
continue to highlight the next field before pressing F8.

4. After setting each key, press F10 to save your changes and return to the Flexible Key 
Program Administration screen.

➤ To reset all keys and return them to their default settings

1. Press F5. A message displays:

Are you sure you want to reset flexible keys?

2. Press Enter to reset the keys.

➤ To make assignments to another attendant console

1. Scroll to another attendant console (+ scrolls forward, - scrolls backward).

2. Press Esc to close the Attendant Console Flexible Button Assignments screen and re
to the Flexible Key Program Administration screen.
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Speed Dial Programming Section
The Speed Dial Programming Section option in the Administration Menu enables you to 
maintain system and station speed dial assignments.

➤ To access speed dial assignments
➤ Type d; the System & 

Station Speed Dial 
Administration screen 
displays (shown right).

System Speed Dial 
Numbers

➤ To edit system speed dial number 
assignments

1. Press Enter. The 
System Speed Dial 
Numbers screen 
displays (shown right). 
This screen enables 
you to assign or edit up 
to 800 system speed 
dial numbers for the
RCTUE/F processor, 
100 for RCTUBA/BB, 
RCTUC/D processors, 
and 40 for TMAU and 
RCTUA processors. 

2. Highlight the System 
Speed Dial No. field and type the speed dial telephone number, including area code, and 
press Enter.

3. Highlight the System Speed Dial Memo field and enter a description of the speed dial 
number (up to 12 characters). This memo displays on the telephones LCD when the Bin 
Number is selected by an LCD telephone using the MODE 8XXX function (where XXX 
is the speed dial bin number).

4. Press F9 to save the entries and upload the data to the DK or F10 to save the speed dial 
assignments and return to the System/Station Administration screen.
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Station Speed Dial Numbers

➤ To edit station speed dial number assignments

1. Highlight the Station 
Speed Dial Numbers 
option and press 
Enter. The Station 
Speed Dial Numbers 
screen displays (shown 
right).

Note To make entries or 
edit the Telephone 
Location, Log. 
Port No., Int/DN 
No. and Telephone 
LCD User Name fields, you must access the System/Station Administration screen 
under the System/Station Administration option.

2. Highlight the Physical 
Port No. field and 
press F7. The Port 
Speed Dial Numbers 
& Memos screen 
displays (shown right).

3. Highlight the Speed 
Dial Number field for 
the appropriate Speed 
Dial Bin Number. 
Type the telephone 
number (including area 
code) and press 
Enter.

4. Highlight the Speed Dial Memo field and enter a description of the speed dial number 
(using up to 12 characters). This memo displays on the telephones LCD when the Bin 
Number is selected by an LCD telephone using the MODE 8XXX function (where XXX 
is the speed dial bin number).

5. Press F9 to save the entries and upload the data to the DK

...or

press F10 to save the speed dial assignments and return to the System & Station Speed 
Dial Administration screen

...or

press Esc to return to the previous menu without saving. A pop-up box appears: Data 
modified. Save modified data?

Press Enter to save or N to return to the previous screen without saving.
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CAUTION! The DKAdmin PC must be connected to the Strata DK to upload any 
changes to this data (see Appendix A – Connecting to Strata DK for 
procedures on connecting the DKAdmin PC to a Strata DK).

6. Press Esc to close the System & Station Speed Dial Administration screen and retur
the Main Menu.

ACD Administration
The ACD Administration Section option in the Administration Menu enables you to main
your ACD and ACD Agent programs.

➤ To access ACD administration
➤ Type a. The DK Program 

File Selection screen 
displays (shown right).

ACD Programs

➤ To edit ACD programs

1. Press Enter; the ACD 
Programs screen displays 
(shown right). This 
screen enables you to 
edit ACD programs (you 
can edit any program 
with a check mark next 
to it).
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2. Highlight the program 
number and press F3. 
The Edit Program 
screen displays (shown 
right). The screen 
varies, depending upon 
the program selected.

Note You can also use 
the Find function 
to quickly move to 
a program by 
typing the first 
digit of the program number. DKAdmin highlights the first program number matching 
the entry. 

3. Highlight the field you wish to change and enter the information. Read only fields do not 
accept entries.

4. Press F9 to save the entries and upload the data to the DK, or F10 to save the speed dial 
assignments and return to the ACD Programs screen.

Important! The DKAdmin PC must be connected to the Strata DK to upload any changes to 
this data (see Appendix A – Connecting to Strata DK for procedures on 
connecting the DKAdmin PC to a Strata DK).

5. Press the Esc key to close the ACD Programs screen and return to the DK Program F
Selection screen.

➤ To view notes on a program
➤ Highlight the program and press F5.

Note You can also use the Find function to move quickly to a program by typing the fir
one or two digits of the program number. The program highlights the first program
number matching your entry.

♦ Use the Up/Down arrow keys to scroll the description.

♦ Press F10 to print the description.

♦ Press Esc to return to the ACD Programs screen.

➤ To use the Strata DK’s program files to edit

1. Press F2 and the DK Code dialog box displays.

2. Type the DK Code: XXXX, where XXXX is the DK level 1 security code set in Program 
00. The DK System Program File screen displays.

Note If the Problem: Unable to Establish Communications screen 
displays, follow the troubleshooting steps on the screen and/or refer to Appendix A – 
Connecting to Strata DK to correct the problem.

3. Press F2 to select (tag) all Program No. (data) files.

4. Highlight Yes and press Enter. DKAdmin establishes communications to the Strata D
turns on LED 10 in Program 77-1, and receives data blocks. This information display
the PC screen as it occurs.
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5. Follow Step 2 ~ Step 4 of “To edit ACD programs” on Page 70.

ACD Agent Programs

➤ To edit ACD agent programs

1. Highlight the ACD 
Agent Programs option 
and press Enter. The 
ACD Agent Programs 
screen displays (shown 
right). This screen 
enables you to edit 
ACD Agent programs.

2. Highlight the ACD 
Group Number field 
for the ACD Agent 
you wish to change. Type the new two-digit Group number (01 ~ 08) and press Enter.

3. Highlight the ACD Agent ID Code field and enter a four-digit ACD Agent ID Code 
Number (0000 ~ 9999). If you type less than four digits, the program zero fills the fie
Press Enter.

4. Highlight the ACD Agent Name field. Type the Agent’s name (up to eight characters)
press Enter.

5. Highlight the Auto Answer Assignment. Use the spacebar or +/- keys to toggle between
Auto Answer and No Auto Answer.

6. Press F9 to save the entries and upload the data to the DK, or F10 to save the speed dial 
assignments and return to the ACD Programs screen.

Important! The DKAdmin PC must be connected to the Strata DK to upload any changes to 
this data (see Appendix A – Connecting to Strata DK for procedures on 
connecting the DKAdmin PC to a Strata DK).

7. Press Esc to close the ACD Programs screen and return to the DK Program File Sele
screen.
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Program Administration Section
The Program Administration Section option in the Administration Menu enables you to 
maintain Strata DK programs. This includes pulling the program from the DK, editing the 
program, initializing the Strata DK processor, or sending the program to the Strata DK.

For complete information on Strata DK programs, including default definitions, refer to the 
Strata DK Programming Manual.

➤ To access a Strata DK program

1. Type p and the DK 
Program File Selection 
screen displays (shown 
right).

2. Highlight the option 
on the screen you wish 
to select and press 
Enter. The selected 
screen displays. See 
Table 4 for a list of 
available programs.

Table 4 Available Programs

Program Title  Program Title

View All Programs (Download, Edit, Upload) Toll Restriction Programs

View System Features by Subject Data Interface Unit Programs

System Number Plan & Port Locations Doorphone/Ext. Paging/BGM/Conference

System Wide Option Programs LCR Programs

Station Options Programs Multiple Directory Number Programs

Station (Gnd/Loop) CO Line Assignment Programs ANI Programs

Station Group Programs DNIS Programs

Security/Account/T.R. Ovr. Programs DKT/RPCI/OA Interface Programs

Voice Mail Integration Programs Class/Caller ID Programs

ACD Programs Distributed Hunt Programs

ACD Agent Programs Call Park Programs

DK Auto Attendant Programs Off Hook Call Announce Programs

Attendant Console Programs Standard Telephone MW/Camp-on Tone Programs

T1 Programs Enhanced 911/CAMA Trunk Programs

Ground/Loop Start CO Line Programs ISDN Programs

DID/TIE Line Programs Initialization Programs

IMDU or RMDS Modem/DID/DNIS Assignment
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After selecting the program, you have the following options:

♦ Press F2 to pull the program data from the DK. See “Restore Data” on Page 102 for 
procedures on downloading data.

♦ Press F3 to edit the program. Only programs displaying a check mark may be ed
by your password level. Options for editing programs differ depending on the sele
program. They may include:

♦ Press F5 to view notes on the program.

♦ Press Esc to return to the DK Program File Selection screen. Press Esc again to 
return to the DKAdmin Main Menu.

View All Programs (Download, Edit, Upload)

➤ To access the option

1. From the DK Program 
File Selection screen, 
press Enter and the 
View All Programs 
(Download, Edit, 
Upload) screen 
displays (shown right).

2. Highlight the desired 
program.

Note To find a program 
number quickly, 
type the number and the display screen “jumps” to the program number. If the nu
you have typed does not exist, a dialog box displays telling you the number was
found.

➤ To pull the program data from the DK
➤ Press F2 to pull the program data from the DK. See “Restore Data” on Page 102 for 

procedures on downloading data.

F2 - Reset Ports Resets the ports to their original configuration.

F2 - Range Enter a range to apply a change.

F9 - Save & Upload Save the change and upload the data to the DK.

F10 - Save Save the change in DKAdmin customer database an
return to the originally selected program screen.

F10 - Initialize Initialize the Strata DK processor with selected 
Program 90, 91, or 92; this does not affect DKAdmin
customer data files.
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➤ To edit a program

1. Press F3 and the 
Directory Numbers 
Assignments screen 
displays (shown right).

2. Highlight the logical 
port number and press 
F2 to reset the DN for 
the logical port 
numbers on a range of 
ports.

3. A change dialog box 
displays and you must 
enter the starting DN. A pop-up screen displays asking you to confirm the change:

This operation will modify DN numbers. Go ahead?

4. Press Enter to change the port numbers.

5. Press F9 to save the entries and upload the data to the DK, or F10 to save the changes in 
the DKAdmin customer database and return to the DK Program File Selection screen.

➤ To print programs

1. Press F4 and a printer pop-up dialog box displays. The default printer is checkmarked.

2. Press Enter to print or highlight another printer and press F2 to select.

3. If a printer is not designated for the selected port, press F2 again and a printer list displays. 
Highlight the appropriate printer and press Enter.

➤ To view notes on a program
➤ Highlight the program and press F5.

Note You can also use the Find function to move quickly to a program by typing the first 
one or two digits of the program number. The program highlights the first program 
number matching your entry.

The following keys can be used when viewing program notes:

♦ Use the Up/Down arrow keys to scroll the description.

♦ Press F10 to print the description.

♦ Press Esc to return to the ACD Programs screen.
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When using DKAdmin, Table 5 provides important information regarding specific 
programs:

Table 5 DKAdmin Program List

Program Comment

Program 03 On new or upgraded installations, Program 03 should always be checked and 
uploaded to make sure all PCB slots have the correct codes for PCBs and 
PCB options. Strata DK power must be turned off (5-seconds) and then on 
after uploading (restoring) Program 03 to enable its data to take effect.

Program 04 or *04 When editing Directory or DN/intercom numbers in Programs 04 or *04, 
DKAdmin checks for duplicate or conflicting numbers and stops them from 
being entered. When uploading Programs 04 or *04, DKAdmin downloads 
them from the processor, compares and arranges the data in an acceptable 
order and uploads it to the Strata DK.

Program *09 and 76-0 DKAdmin edits and uploads Programs *09 and 76-0 in the same manner as 
Programs 04 and *04.

CAUTION! ACD/DID assignments in Program *09 cannot be Restored 
(uploaded) with early ROM versions of Strata DK Release 2 
ROMs.

PRGALL Whenever PRGALL is uploaded (restored), Programs 04 and *09 are 
downloaded and checked, then uploaded prior to the PRGALL upload.

Program 38/39 To change a keystrip from 20 to 10 keys, or from 10 to 20, without changing 
the data in Program 39, select and edit Program 38 using Program 
Administration. To change a keystrip to a default value in Program 38 and 
overwrite Program 39 data, select and edit TELEPHONE KEYSTRIP TYPE 
(PRG38) from the System/Station Administration-PORT ATTRIBUTES screen 
for the selected station port. When changing a keystrip from 20 keys to 10 
keys, DKAdmin stores the pause (code 495) key in key 11~20 (unused keys). 
This is because there is no code for a blank key.

If using Strata DK Release 2 or lower, you must power off (5 sec)/on the 
Strata DK after sending the changes to the Strata DK from DKAdmin in order 
for the program changes to take effect.

Program 90, 91, and 92 All Initialization programs will initialize the data in the Strata DK processor 
(RCTU PCB), not the data in the DKAdmin PC customer files.

If initializing the system with 91-9 remotely, the customer DK TTY port must 
be connected to a modem that has a direct CO line as shown in Figure A-3 of 
Appendix A.

REPALL These two files will always be Up or Down loaded in pairs when either file is 
Up or Down loaded.

Program 04, *04, *09, and 
76-0

Unused ports in these programs will be blanked out when upgrading to an 
RCTU with more port number than the original RCTU. This is done to prevent 
inserting DN and DID number conflicts during an upgrade. For example, if 
upgrading from a RCTUB to and RCTU C/D, ports 80~239 will be blanked out 
in Program 04.
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The Security Maintenance Section option (level 9 password required to access this option) 
enables you to set up to three levels of security using:

♦ Passwords - defines the functions available to users using menu-specific passwords as 
described on Page 121.

♦ Program Access - defines the programs which can be used by each password level using 
the Security Maintenance Section option (see “Program Security (Default Levels)” on 
Page 78).

♦ DK Access Code - must be entered to enable a user to send and/or receive data to/
Strata DK. The default for this code is 0000 and may be changed (but not viewed) b
DKAdmin users that have an allowable password level.

➤ To limit the Strata DK programs a user may edit

1. From the 
Administration Menu, 
type u to display the 
DK Program Security 
Maintenance screen 
(shown right).

The screen lists the 
Strata DK programs 
available for 
programming or 
updating. You can 
limit programs a user 
can access by 
assigning a security 
level (which corresponds to the users assigned password level).

Note Program access security limits direct access of programs when using the Progra
Administration Section Option. When using the ACD Administration Section Opti
only Programs 01, 02, 04, *09, VMID, MWID, and Personal Speed Dial access can 
denied from the normal System/Station Administration functions.

2. Highlight the S/L field of the desired program. Type the password level (0 ~ 9, 
9=highest) you want to assign for accessing the program and press Enter.

Note For a complete list of Password/Program default levels, see “Program Security 
(Default Levels)” on Page 78.

...or

to assign all the programs to a particular password level, press F2-reset. A Security Level 
dialog box displays. Type the password level (0 ~ 9, 9=highest) you want to assign to al
the Strata DK programs and press Enter. A confirmation message displays. Highlight 
Yes and press Enter.

The Security Level for all programs are changed to the entered password level.

3. To close the DK Program Security Maintenance screen, press Esc.
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Note The password levels (0 ~ 9) are based on a hierarchal system. This means that 
password level 9 has access to all programs, but password level 5 (for example) has 
access to all programs tagged with 5 and below, but not 6 and above.

Program Security (Default Levels)
Program security is maintained by assigning access levels to each program. The access level is 
assigned to each User ID/Password so each User ID/Password can be allowed or denied edit/
view privileges to selected Strata DK programs. DKAdmin provides default levels for User 
IDs/Passwords and program security (listed below). These passwords and program security 
levels may be added or changed by logging onto DKAdmin with a level 9 (Master) password.

The default User ID/Password and Program Security levels are shown below:

User ID Password Program Security Level

ADMIN1 ADMIN1 2

ADMIN2 ADMIN2 5

TECH1 TECH1 8

MASTER MASTER 9

Table 6 Strata DK Program Security

Strata DK 
Program

Security Level Program Title

REPALL 2 All Station and System Speed Dial Numbers

NAMEALL 2 All User Names

VIDALL 3 All Voice Mail ID Codes (#656)

MIDALL 3 All Voice Mail Message Waiting Codes (#657)

ADMEMOALL 2 All Station and System Speed Dial Memos

MSGALL 2 All Station and System LCD Messages

CFALL 2 All Call Forward Settings

MWALL 2 All Message Waiting Settings

CLID 2 All Class/ANI Lost Call Number Storage Data

*03 0 Cabinet Compatibility (DK424)

*04 0 Directory Numbers Assignment (R3)

*05 0 Call Park Pickup Access Codes (R3)

*09 8 DID Digit Translation

*10 8 E911 Assignments (R3.1)

*11-0 0 CAMA Trunk Assignments (R4)

*11-1 0 CAMA Trunk Group Line Assignments (R4)

*11-2 0 CAMA Trunk Group Hunting Assignments (R4)

*11-5 0 CAMA Digit Sent on 911 Calls (R4)

*11-6 0 E911 Interdigital Timer (R4)
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*11-8 0 911 Special [DN] Notification Assignments (R4)

*12 0 ANI Station Information (R4)

*13 0 Station Group Information (R4)

*14-1 5 Auto Answer with Zip Tone Assigned to Agent ID

*14-2 5 DID/TIE Line After Shift & Overflow Substitution Destination

*15 8 CO Line Tenant Assignments

*16 8 ISDN Trunk Group Type Assignments (R4)

*17 8 DID Intercept Port Number (Caller Dials Vacant/Wrong Number)

*29 5 Add-On Module Button Assignments

*30 5 Group Page Assignments

*31 5 Group Pickup Assignments

*32 8 Voice Mail Message Center Port (RS-232)

*33 8 Phantom DN Owner Assignments (R3)

*34 8 Station Class of Service

*36 8 Night Transfer Lock Button “Password Change” Station (R3)

*37 8 Station Park Recall Timer (R3)

*40 8 Station Distributed Hunt Group Assignments (R3.1)

*41-1 8 T1 Span Frame and Coding Assignments

*41-2 8 T1 Channel Assignments

*41-3 8 T1 Span Transmit (Send) Level PAD Assignments

*41-4 8 T1 Span Receive Level PAD Assignments

*42-1~2 8 Primary & Secondary Clock Source Reference Assignments

*43-1~3 8 ‘D’ Channel Control and NFAS Assignment (R4)

*44 8 BRI SPID Parameters (R4)

*45-1 8 Office Code Toll Restriction (R3.0)

*45-2 8 Special Numbers that Do Not begin with */# (R3.0)

*45-3 8 Special Numbers that begin with */# (R3.0/R3.1)

*50 8 RCIU/RCIS Port Assignment

*51 8 Station Caller ID/ANI Lost Call Memory Allocation (R3)

*52 8 Common CO Line Caller ID Lost Call Owner (R3)

*60 0 BRI Assignment for Line/Station Operation (R4)

*61-1 0 ISDN Station Bearer Service (R4)

*61-2 0 ISDN Station Outgoing Call Pad Level (R4)

*61-3 0 ISDN Station Incoming Call Pad Level (R4)

*62-1 0 Non-ISDN Station Bearer Service (R4)

Table 6 Strata DK Program Security (continued)

Strata DK 
Program

Security Level Program Title
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*62-2 0 Non-ISDN Station Outgoing Call Pad Level (R4)

*62-3 0 Non-ISDN Station Incoming Call Pad Level (R4)

*63 0 ISDN Dialing Parameters (R4)

*64-1 0 Direct Inward Dialing Parameters (R4)

*64-2 0 Direct Inward Dialing Parameters (R4)

*65 0 ISDN Channel Group Assignment (R4)

*66-1 0 Channel Parameters (R4)

*66-2 0 Call-by-Call Trunk Group Codes (R4)

*66-3 0 Channel Group Parameters (R4)

*66-4 0 Call-by-Call Network ID (R4)

*66-5 0 Line Directory Number (LDN) Registration (R4)

*66-6 0 Line Directory Number (LDN) Channel Groups (R4)

*66-7 0 Line Directory Number (LDN) Trunk Groups (R4)

*67-1 0 Trunk Group Parameters (R4)

*67-2 0 Call Types for ISDN Trunk Group Supported (R4)

*67-3 0 Call Types for ISDN Trunk Groups (R4)

*67-4 0 Call Types for ISDN Trunk Groups (R4

*68-1 0 Calling Number ID Presentation Parameters (R4)

*68-2 0 Outbound Calling Number ID Presentation Parameters (R4)

*69-1 0 CNIS Presentation Parameters (R4)

*69-2 0 Special Number Assignment (R4)

*71 8 Ringing DN Assignment for Immediate Ring (R3)

*72 8 Ringing DN Assignment for Delay 1 Ring (R3)

*73 8 Ringing DN Assignment for Delay 2 Ring (R3)

*79 8 Doorphone Ring LED Assignments (R3)

*80 0 Call Forward Ringing Assignments (R3.2)

*81 8 DN LED Display Assignment (DAY Mode) (R3)

*84 8 DN LED Display Assignment (DAY2 Mode) (R3)

*87 8 DN LED Display Assignment (NIGHT Mode) (R3)

00 8 Software Check/Remote Password Assignments

01 8 Logical Station Ports

02 8 Physical Station Ports 

03 8 Flexible PCB Cabinet and Slot Assignments

04 8 Logical Port Intercom Number Assignments

05 8 Flexible Access Code Numbering

Table 6 Strata DK Program Security (continued)

Strata DK 
Program

Security Level Program Title
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09 8 Auto Attendant Prompt/Station Assignments

10-1 8 System Assignments

10-2 8 System Assignments

10-3 8 System Assignments

10-4 5 ACD Parameters

11 5 ACD Timing Assignments

12 8 System Assignments - Basic Timing

13 8 Defining the Message Center

14-0 5 ACD CO Line Assignments

14-1 5 ACD Agent Identification Code Assignments

14-2 5 ACD Supervisor Passwords

14-3 5 Announcement/Music Port Assignments

14-4 5 Overall Queue Time Out Destination

14-5 5 Overflow Operation/Destination Assignments

14-6 5 End of Shift Service Destination

14-71 5 Queue Size for Alarm (Immediate)

14-72 5 Queue Size for Alarm 1 (Timed)

14-73 5 Queue Time for Alarm 2 (Timed)

14-8 5 Alarm Pattern Assignments

14-9 5 Stroke Count Assignments

15 8 Assigning DP/DTMF, Tenant Service To Individual CO Line

16 8 Assign CO Line Groups (Dial 9 or 001~816)

17 8 DID/TIE Line Options

18 5 Agent ID Code Name for MIS Assignments

19 8 Alternate Background Music (BGM) Slot Identification

20 8 DIgital Data Port Configuration

21 8 Modem Pool Port Assignments

22 8 Data Interface Unit (DIU) Station Hunting (Data Calls Only)

23 8 Primary Auto Attendant Announcement Device Assignments

24 8 Secondary Auto Attendant Announcement Device Assignments

25-1 8 Incoming Auto Attendant Call Overflow Time

26 5 Built-In Auto Attendant Camp-On Busy Time

27 5 Digital Telephone Handset Receiver Volume Level

28 8 DSS Console/Attendant Telephone Assignments

29 5 DSS Console Button Assignments

Table 6 Strata DK Program Security (continued)

Strata DK 
Program

Security Level Program Title
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30 5 Station Class of Service

31 5 Station Class of Service

32 5 Automatic Preference

33 5 Station Hunting (Voice Calls Only)

34 5 Hold/Park Recall Timing

35 5 Station Class of Service

36 5 Fixed Call Forward (Voice Calls Only)

37 5 CO and TIE Line Ring Transfer (Camp-on) Recall Time

38 5 Digital and Electronic Telephone Keystrip Type

39 5 Flexible Key Assignment Button Codes

40 5 Station CO Line Access

41 5 Station Outgoing Call Restriction

42-0 8 CO Line to PBX/Centrex Connection

42-1~8 8 PBX/Centrex Access Code

43 5 Station/CO Line Credit Card Call Allowed

44-1~8 5 Toll Restriction Class Traveling Class Override Code

44-91~93 5 Emergency Bypass of Forced, Verified Account Codes

45-1 8 LCR/Toll Restriction Dial Plan

45-2 5 Toll Restriction Disable

45-3~6 8 Special Common Carrier (SPCC) and Auth. Code Digital Length

45-8~9 8 Toll Restriction Override Code

46-10~80 8 Toll Restriction Class Parameters

46-11~81 8 Toll Restriction Class Parameters

46-2~4 8 Toll Restriction Allowed/Denied Area Codes by Class

46-6~8 8 Toll Restriction Allowed/Denied Office Codes by Class

47 8 Toll Restriction Exception Office Codes by Area Code

48 5 Station Toll Restriction Classification

50-1 8 LCR Parameters

50-2 8 LCR Home Area Code

50-31~35 8 LCR Special Code

50-4 8 LCR Long Distance Information (LDI) Plan Number

50-5 8 LCR Local Plan Number

50-6 8 LCR Dial Zero Timeout

51 8 LCR Area Codes

52 8 LCR Office Code Exceptions for Specified Area Codes

Table 6 Strata DK Program Security (continued)

Strata DK 
Program

Security Level Program Title
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53 8 LCR Schedule Assignments for LCR Plans

54 8 LCR Route Definition Tables

55-0~2 8 LCR Modified Digits Tables

56 5 LCR Station Group Assignments

58-1 5 Attendant Console Overflow Timer

58-2 5 Attendant Console Display Type

58-4 5 Attendant Console Answer Key Priority Assignments

58-5 5 Attendant Console Overflow Destination Assignments

59 5 Attendant Console Flexible Button Codes

60-1 8 SMDR Printout data of CLASS/ANI/DNIS or Account Code

60-2~7 5 SMDR Output/Account Code Digit-Length

60-8 5 Call Forward External (Remote Change, Security) ID Code

69 5 Verified Account Codes

70 5 Verified Account Code Toll Restriction Assignments

70-0 8 DNIS Number Assignments (R3)

71-0 0 DNIS Number Assignments

71-1 8 DNIS Ringing Point Assignments (DAY Mode) (R3)

71-2 8 DNIS Ringing Point Assignments (DAY2 Mode) (R3)

71-3 8 DNIS Ringing Point Assignments (NIGHT Mode) (R3)

71-4 8 DNIS Voice Mail ID Assignments (R3)

71-5 8 DNIS Name Tag Assignments (R3)

72 8 DNIS Network Table (R3)

74 8 Night Transfer Lock Button Password(s) (R3)

76-1~2 8 Interface Port Type & Transmission Speed (R3)

77-1 8 Peripheral Options (Door Phones/IMDU/PIOU/PIOUS/PEPU/RM

77-2 8 Door Phone Busy Signal/Door Lock Assignments

77-3 8 Night Ringing Over Tenant External Page Zones

77-4 8 Open Architecture Interface Attributes (R3.2)

78 5 CO Line Special Ringing Assignments: DSS/IMDU, Night Ringing

79 5 Door Phone Ringing

80 5 Digital & Electronic Telephone Ringing Tones (CO Line Calls)

81 5 CO Line/Station Ringing Assignments (DAY Immediate)

82 5 CO Line/Station Ringing Assignments (DAY 12-Second Delay)

83 5 CO/Line/Station Ringing Assignments (DAY 24-Second Delay)

84 5 CO/Line/Station Ringing Assignments (DAY 2 Immediate)

Table 6 Strata DK Program Security (continued)

Strata DK 
Program

Security Level Program Title
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85 5 CO/Line/Station Ringing Assignments (DAY 2 12-Second Delay)

86 5 CO/Line/Station Ringing Assignments (DAY 2 24-Second Delay)

87 5 CO/Line/Station Ringing Assignments (NIGHT Immediate)

88 5 CO/Line/Station Ringing Assignments (NIGHT 12-Second Delay)

89 5 CO/Line/Station Ringing Assignments (NIGHT 24-Second Delay)

90 8 Initializing Program 00~*99

91-1 8 Automatic PCB Recognition/Port Renumber

91-2 8 System Power Off/On Simulation

91-9 8 System Initialization

92-1 8 Initialize Station Speed Dial Numbers & Memos, VM ID Codes

92-2 8 Initialize System Speed Dial Numbers & Memos

92-3 8 Initialize Station & System User Name/Number Display

92-4 8 Initialize Timed Reminders

92-5 8 Initialize Phone/Ring Vol., Tone/BGM, Busy Override, etc.

92-9 8 Initialize Call Forward Memory

93 5 CO Line Identification

97 5 Printing Program Through SMDR

Table 6 Strata DK Program Security (continued)

Strata DK 
Program

Security Level Program Title
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Directory Number Administration

Note This option cannot be used by Strata DK Release 2 or below.

➤ To maintain your directory number assignments for both your PDNs and PhDNs

1. Press r and the 
Directory Number 
Administration screen 
displays (shown right).

This screen enables you 
to assign and change 
PDN and PhDN user 
names, call forward ID 
codes and message 
waiting ID codes. You 
can also assign or edit 
DNIS detail features 
such as immediate ring, 
key numbers and delays.

Note The first column on the screen displays a P for a PDN and an F for PhDN.

2. Highlight the PDN/PhDN No. field of the desired port number.

Note You can also use the Find feature by moving the highlighter to the Port No. field, and 
typing a port number. 

3. Type a [PDN] or [PhDN], and press Enter. If there is a DN/Port conflict with the entered 
number, an error message displays: Conflict Found in Int./DN Numbering

If this message appears, retype the number and press Enter

...or

to change the PDN/PhDN numbers for a range of ports, highlight the PDN/PhDN No. field 
and press F5. A pop-up box displays.

♦ Type the desired starting [DN] number for your PDN ports (000-079) and press 
Enter.

♦ Type the desired starting [DN] number for your PhDN ports (500-579) and press 
Enter.

♦ A message displays: This operation will modify DN numbers. Go 
ahead?

Press Enter to change all the PDNs/PhDNs or press Esc to leave the screen without 
making the change.

4. Highlight the PDN/PhDN Owner User Name field and enter the name assigned to the 
station (up to 16 characters).

5. Highlight the Voice Mail Call Forward ID Code field and type an applicable call forward 
ID code (up to 16 characters). Press Enter

...or
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to change the range of numbers used for all the ports, press F5. A pop-up box displays, 
enabling you to specify a range of numbers.

♦ Type the desired range of Port Reference Numbers for the PDNs (000 ~ 079).

♦ Type the desired range of Port Reference Numbers for the PhDNs (500 ~ 579).

♦ Type a Voice Mail CF Prefix (up to four characters) and press Enter. A message 
displays: All ports will be reset to default values. Go 
ahead?

Press Enter to set/change all Call Forward IDs.

6. Highlight the Voice Mail Message Waiting ID Code field and enter an applicable message 
waiting ID code (up to 16 characters)

...or

to change the range of numbers used for all your ports, press F5. A pop-up box displays, 
enabling you to specify a range of numbers.

♦ Type the desired Port Reference Number for the PDNs (000 ~ 079).

♦ Type the desired Port Reference Number for the PhDNs (500-579).

♦ Type a Voice Mail MW Prefix (up to four characters) and press Enter. A message 
displays: All ports will be reset to default values. Go 
ahead?

Press Enter to set/change all Message Waiting IDs.

7. Press F9 to save the entries and upload the data to the DK, or F10 to save the assignments 
and return to the Main Menu.

➤ To set or change detailed information for the PDNs/PhDNs

1. From the Directory Number Administration screen, highlight the DN you wish to edit and 
press F2. The Directory Number Administration screen for the selected DN number 
displays.

This screen (shown 
right) enables you to 
turn on or off an 
immediate ring, or a 
12- or 24-second delay 
ring. You can also 
access your ringing 
lines and flexible keys 
from this screen.

2. Highlight the Imm. 
Ring field for the 
desired DN. The 
spacebar toggles the 
field between enabled 
and disabled. When the field is enabled a check mark is displayed in the field. 

3. Highlight the 12s Dly field for the desired DN. The spacebar toggles the field between 
enabled and disabled. When the field is enabled a check mark is displayed in the field and 
a 12-second delay before ringing occurs.
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4. Highlight the 24s Dly field for the desired DN. The spacebar toggles the field between 
enabled and disabled. When the field is enabled a check mark is displayed in the field and 
a 24-second delay before ringing occurs.

Note You cannot enable both the 12s Dly field and the 24s Dly field. Enabling either field, 
automatically disables the other.

➤ To specify your ringing options

1. From the Directory 
Number 
Administration for 
Primary DN XXX 
screen, highlight the 
desired DN number 
and press F2. The 
Directory Number CO 
Line Ringing 
Assignment screen for 
the selected DN 
displays (shown right).

For each of your CO 
lines, you can set/
change the following options for your day, day 2 and night operations:

♦ Immediate ring

♦ 12- or 24-second ring delay

♦ Specified DN LED to flash during a ring.

2. Highlight the DAY Imm. Ring field for the desired CO Line. The spacebar toggles the 
field between enabled and disabled. When the field is enabled a check mark is displayed in 
the field and DAY immediate ring occurs.

3. Highlight the 12s Dly field for the desired CO line. The spacebar toggles the field between 
enabled and disabled. When the field is enabled a checkmark is displayed in the field and 
a 12-second delay before ringing occurs.

4. Highlight the 24s Dly field for the desired CO line. The spacebar toggles the field between 
enabled and disabled. When the field is enabled a checkmark is displayed in the field and 
a 24-second delay before ringing occurs.

Note You cannot enable both the 12s Dly field and the 24s Dly field. Enabling either field, 
automatically disables the other.

5. Highlight the *81 LED field and press F6 or Enter. A pop-up box displays with your 
available choices. Highlight the [DN] LED you want to flash during a day ring and press 
Enter. 

6. Highlight the DAY2 Imm Rng and NITE Imm Rng fields and repeat Steps 2 ~ 5.

7. Press F10 to save you entries and return to the Directory Number Administration screen.
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➤ To set/change CO Line flexible key assignments

1. From the Directory 
Number for Primary 
DN XXX screen, 
highlight a [DN] and 
press F5. The Flexible 
Key Assignments 
screen for the selected 
Port/DN displays 
(shown right).

2. Highlight the desired 
Flexible Key 
Assignment and:

♦ Press F2 to change 
the assignment from a CO line to the PDN.

♦ Press F3 to change the assignment to the SDN. A pop-up dialog box displays. Type 
the [PDN]/[SDN] (0000 ~ 9999) you wish to assign and press Enter.

♦ Press F4 to change the assignment to a PhDN. A pop-up dialog box displays. Type the 
[PhDN] (0000 ~ 9999) you wish to assign and press Enter.

♦ Press F5 to deactivate or blank out a key assignment.

♦ Press F6 to display a pop-up dialog box showing the available key assignments. 
Highlight the desired assignment and press Enter.

♦ Press F8 to add multiple speed dial key assignments.

Important! You can only use this key when you are assigning more than one speed dial key at 
a time. If you have not just added a speed dial key assignment, the message Must 
Assign System/Station Speed Dial First displays.

If you leave the cursor in the same field and continue to press F8, the speed dial 
key number increments. To add consecutive speed dial key assignments, you must 
continue to highlight the next field before pressing F8.

3. Press F10 to save the entries and return to the Directory Number Administration (detail) 
screen.

4. Press F10 to save your programs and return to the main Directory Number Administration 
screen.

5. Press F9 to save the entries and upload the data to the Strata DK, or F10 to save the 
assignments and return to the Main Menu.
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DNIS Administration

Note This option cannot be used by Strata DK Release 2 or below.

This option enables you to maintain assignments for your DNIS/DID/ANI lines, change or add 
number/name/ringing/voice mail ID assignments, or network tables and tenant locks 
specifications.

➤ To access the option
➤ Type n. The DNIS 

Administration screen 
displays (shown right).

DNIS/DID/ANI Line Assignments

➤ To set/change your DNIS/DID/ANI line assignments

1. Press Enter and the DNIS/DID/ANI Line Assignments screen displays.

This screen (shown 
right) enables you to 
set/change options for 
the following items:

♦ Use of page and 
voice 
announcements on 
an incoming tie 
line

♦ Tie/DID wink start 
status 

♦ DID line camp-on 
status

♦ Second dial tone status

♦ Specify DNIS or DID line

♦ Specify ANI or DNIS priority

♦ Support (or not) ANI features

♦ Use (or not) ANI feature * key

2. Highlight the field of the tie/DID line with which you wish to work.
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Note Each field has only two selections. Use the spacebar or +/- keys to toggle between 
them.

3. Repeat Step 2 for each tie/DID line you wish to set/change.

4. Press F10 to save your entries and return to the DNIS Administration screen. 

DNIS Number/Name/Ringing/VM-ID Assignments

➤ To set/change the DNIS address reference numbers

1. Highlight the DNIS Number/Name/Ringing/VM-ID Assignments option and press 
Enter. The DNIS Number/Name/Ringing/VM-ID Assignments screen displays (shown 
below).

The following items for each of the DNIS address reference numbers can be set/changed:

♦ DNIS number

♦ DNIS name

♦ Day ringing point

♦ Day 2 ringing point

♦ Night ringing point

♦ DNIS Voice Mail ID 
number

Note To blank out any 
entry in these fields, 
highlight the field 
and press F4.

2. Highlight the DNIS No. field of the DNIS address with which you wish to work.

3. Enter the DNIS number, using 2 ~ 5 characters

...or

to enter a range for all your DNIS addresses, press F5. A pop-up dialog box displays. Type 
the DNIS address range in the From and To fields and a starting DNIS number. Press 
Enter.

4. Highlight the DNIS Name field and type a DNIS name, using up to 16 characters. Press 
Enter.

Field Selection

Tie Line
Voice & Page

Page & Voice/No Page & Voice

Tie/DID
Wind/Immed

Immediate/Wink Start

DID Line
Camp On Busy

Auto Camp-on/No Camp-on

DID/Tie Line
Second Dial Line

Second Tone/No Second Tone
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5. Highlight the DAY Ring field and enter the desired DAY ringing point.

♦ Press F2 to review the Ringing Point Identification codes.

♦ Press F6 to select a ringing point. Highlight the ringing point you wish to assign and 
press Enter.

6. Highlight the DAY2 Ring field and repeat Step 5.

7. Highlight the NIGHT Ring field and repeat Step 5.

8. Highlight the DNIS Voice Mail ID Number field and type a DNIS Voice Mail ID Number, 
using up to 16 characters and press Enter

...or

to enter a range for all your DNIS addresses, press F5. A pop-up dialog box displays. Type 
the starting voice mail ID number and press Enter. A message displays:

All ports will be reset to default values. Go ahead?

9. Press Enter to reset the default values or Esc to exit without resetting.

10. Press F10 to save your entries and return to the DNIS Administration screen.

DNIS Network Table Assignments

➤ To set/change CO line access codes and network telephone numbers

1. Select the DNIS Network Table Assignments option and press Enter. The DNIS 
Network Table Assignments screen displays.

This screen (shown 
right) enables you to 
set/change CO line 
access codes and 
network telephone 
numbers so that DNIS 
calls can be routed 
externally over the 
public telephone 
network.

2. Highlight the CO Line 
Access Code and 
Network Telephone 
Number field for the 
DNIS Network Table Reference number with which you wish to work.

3. Type the CO line access code and network telephone number, using up to 27 digits and 
press Enter. To remove an entry, with the field highlighted, press F4.

4. Press F10 to save your entries and return to the DNIS Administration screen.
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DNIS Tenant Lock Assignments

➤ To set/change passwords for station port numbers

1. Select the DNIS Tenant Lock Assignments option and press Enter. The DNIS Tenant 
Night Lock Assignments screen displays.

This screen (shown 
right) enables you to 
set/change passwords 
for station port 
numbers for each of 
your DNIS tenant 
night numbers.

2. Highlight the Current 
Password field of the 
Tenant number with 
which you wish to 
work.

3. Type the password, 
using up to four digits and press Enter.

4. Highlight the Set Password Station Port field and type the set password station port 
number (1 ~ 3 digits) and press Enter.

5. Press F10 to save your entries and return to the DNIS Administration screen. 

6. Press Esc to return to the Main Menu. Your files are saved and a message displayed:

Upload modified programs to DK now?

7. Press Enter to return to the Main Menu without uploading the information or highlight 
Yes and press Enter to upload the files.

Distributed Hunt Group Administration

Note This option cannot be used by Strata DK Release 3 or below.

➤ To maintain your distributed hunt group assignments (up to 32)

1. Type h. The 
Distributed Hunt 
Group Primary 
Directory Number 
Hunt-To Assignments 
screen displays (shown 
right).

2. Highlight the DH 
Group DN No. field of 
the Distributed Hunt 
Group number with 
which you wish to 
work.
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3. Type a DH Group [DN] (up to four digits) and press Enter. If the entered number 
conflicts with a DN/Port already assigned, an error message displays.

4. Highlight the Hunt PDN 01 field. Type the hunt [PDN] number and press Enter

...or

press F6 to select the number from a table. Highlight the desired number and press 
Enter.

5. Repeat Step 4 for each Hunt PDN field.

Note The Hunt PDN fields scroll once you reach the far right column. You can continue to 
access Hunt PDNs using the right arrow key.

6. Press F9 to save the entries and upload the data to the DK, or F10 to save the assignments 
and return to the Main Menu.

➤ To display and update your DNIS/DID Ringing assignments for a hunt group
➤ Press F2 and the DNIS/DID Line Ringing Assignments screen displays. See “To specify 

your ringing options” on Page 87 for procedures on working with this screen.

➤ To display and update your CO Line Ringing assignments for a hunt group
➤ Press F3 and the CO Line Ringing Assignments screen displays. See “To specify your 

ringing options” on Page 87 for procedures on working with this screen.

Call Forward Assignments

Note This option cannot be used by Strata DK Release 2 or below.

➤ To set/change the call forward assignments

1. Type w. The System 
Directory Number Call 
Forward Assignments 
screen displays (shown 
right).

2. Highlight the Upload 
field for the desired 
port number. To select 
a port number 
assignment for 
uploading to the DK, 
press the spacebar. A 
check mark (√) 
displays next to the 
port number. To de-select the item for upload, press the spacebar again.

3. Highlight the Call Forward To DN field and type the [DN] to call forward to and press
Enter

...or

press F6 to select the [DN] from a table. Highlight the desired number and press Enter.
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4. Highlight the next Call Forward Type field. A default value (All, Busy, No Answer, Busy/
No Answer) is entered in this field based on your selection in Step 3. To change the 
assignment, press + /- to toggle the selections and press Enter.

5. Highlight the Call Forward Timer field. A default value is entered in this field based on 
your selection in Step 3. To change the assignment, type the number of seconds (08-60) 
you wish to apply before the call forward executes for “No Answer” or “Busy/No 
Answer” conditions. Press Enter.

6. Press F4 to cancel a call forward assignment for a port.

7. Press F8 to save the entries and upload the selected data to the Strata DK, or F9 to save 
the entries and upload all the data to the Strata DK, or F10 to save the assignments and 
return to the Main Menu.

Important! If CF is set for a PDN using DKAdmin, the CF Button does not light unless the 
Strata DK power is turned off (five seconds) and then on.

➤ To use the Strata DK’s program files to edit

1. Press F2 and the DK Code dialog box displays.

2. Type the DK Code: XXXX, where XXXX is the Strata DK level 1 security code set in 
Program 00. The DK System Program File screen displays.

Note If the Problem: Unable to Establish Communications screen 
displays, follow the troubleshooting steps on the screen and/or refer to Appendix A to 
correct the problem.

3. Press F2 to select (tag) all Program No. (data) files.

4. Highlight YES and press Enter. DKAdmin establishes communications to the Strata DK, 
turns on LED 10 in Program 77-1, and receives data blocks. This information displays on 
the PC screen as it occurs.

5. Follow Step 2 ~ Step 4 of “To edit ACD programs” on Page 70.

Note For more information on downloading DK information, refer to the procedures in 
Chapter 7 – Backup Menu (DKBackup).

E911/CAMA Trunk Programs (R4 Only)

Note Programs *11~*13 cannot be used by Strata DK Release 3 or earlier.

The E911/CAMA Trunk Programs option in the Administration Menu enables you to main
E911 and Centralized Automatic Message Accounting (CAMA) trunk programs.

Program *10 provides two assignable RSTU, KSTU2, RDSU, PSTU, or PESU ports to 
interface with Central Office (CO) E911 trunks. This program is only used when CAMA 
trunks are connected to an E911 adjunct interface box, not when using Toshiba RMCU/R
CAMA trunks.

E911 enhanced operation provides locator information (i.e., more complete name and a
information, including building, floor, etc.) to the responding agency. This is done by sen
the station number of the 911 caller to the E911 emergency center. This locator informat
then cross-referenced with name/number/address data in the E911 central database, an
E911 operator receives the precise location along with the basic information.
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The Strata DK16e and DK424 accomplishes this with a special interface between the KSU and 
the CO. This special interface takes the station number information and sends it through the 
public network in a format compatible with the central E911 database. This special interface is 
required in addition to sending software within the Strata DK16e and DK424. The required 
interface is an external device (Telident or Proctor) that interfaces with up to two analog 
station ports.

Programs *10-11 and *10-12 assign which RSTU, KSTU2, RDSU, PSTU, or PESU standard 
telephone ports are connected to the E911 interface unit. Program 04 Directory Number data 
must be blank for E911 RSTU-KSTU2 ports.

Program *10-91 assigns the time allowed to dial each digit after dialing 9 when using the E911 
feature. This time will affect the time that LCR or CO Line dial tone is returned when dialing 
9. However, a user can dial a 9+ (non-911) calls normally before receiving LCR or CO line 
dial tone and the DK will route the call appropriately.

Program *10-92 assigns the time the DK will wait before sending the Station [PDN] to the 
E911 SLT port after the E911 SLT port answers.

➤ To access E911/CAMA Trunk Programs using RMCU/RCMS CAMA trunks

➤ From the 
Administration Menu, 
type 9. The E911/
CAMA Trunk 
Programs screen 
displays (shown right).

➤ To edit E911/CAMA trunk programs

1. Highlight the program number and press F3. The Edit Program screen displays. The 
screen varies, depending upon the program selected.

Note You can also use the Find function to quickly move to a program by typing the first 
digit of the program number. DKAdmin highlights the first program number matching 
the entry. 

2. Highlight the field you wish to change and enter the information. Read only fields do not 
accept entries.

3. Press F9 to save the entries and upload the data to the DK, or F10 to save the E911/
CAMA trunk assignments and return to the E911/CAMA Trunk Programs screen.

Important! The DKAdmin PC must be connected to the Strata DK to upload any changes to 
this data (see Appendix A – Connecting to Strata DK for procedures on 
connecting the DKAdmin PC to a Strata DK).

4. Press the Esc key to close the E911/CAMA Trunk Programs screen and return to the
Administration Menu.
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➤ To use the Strata DK’s program files to edit

1. Press F2 and the DK Code dialog box displays.

2. Type the DK Code: XXXX, where XXXX is the DK level 1 security code set in Program 
00. The DK System Program File screen displays.

Note If the Problem: Unable to Establish Communications screen 
displays, follow the troubleshooting steps on the screen and/or refer to Appendix A – 
Connecting to Strata DK to correct the problem.

3. Press F2 to select (tag) all Program No. (data) files.

4. Highlight Yes and press Enter. DKAdmin establishes communications to the Strata D
turns on LED 10 in Program 77-1, and receives data blocks. This information display
the PC screen as it occurs.

5. Follow Step 2 ~ Step 4 of “To edit E911/CAMA trunk programs” above.

➤ To view notes on a program
➤ Highlight the program and press F5.

Note You can also use the Find function to move quickly to a program by typing the fir
one or two digits of the program number. The program highlights the first program
number matching your entry.

♦ Use the Up/Down arrow keys to scroll the description.

♦ Press F10 to print the description.

♦ Press Esc to return to the E911/CAMA Trunk Programs screen.
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ISDN Programs (R4 Only)

Note This option cannot be used by Strata DK Release 3 or earlier.

The Integrated Services Digital Network (ISDN) Programs option in the Administration Menu 
enables you to maintain ISDN programs.

Release 4.0 provides the Primary Rate Interface (PRI) ISDN capabilities. Release 4.1/4.2 will 
introduce the ISDN Basic Rate Interface (BRI). PRI features apply to the following Release 4 
processors: RCTUBA3/BB4, RCTUC3/D4, and RCTUE3/F4. Like T1, ISDN PRI is not 
supported on the RCTUA4 small system processor.

➤ To access ISDN Programs

➤ From the 
Administration Menu, 
type i. The ISDN 
Programs screen 
displays (shown right).

➤ To edit ISDN programs

1. Highlight the program number and press F3. The Edit Program screen displays. The 
screen varies, depending upon the program selected.

Note You can also use the Find function to quickly move to a program by typing the first 
digit of the program number. DKAdmin highlights the first program number matching 
the entry. 

2. Highlight the field you wish to change and enter the information. Read only fields do not 
accept entries.

3. Press F9 to save the entries and upload the data to the DK, or F10 to save the ISDN 
assignments and return to the ISDN Programs screen.

Important! The DKAdmin PC must be connected to the Strata DK to upload any changes to 
this data (see Appendix A – Connecting to Strata DK for procedures on 
connecting the DKAdmin PC to a Strata DK).

4. Press the Esc key to close the ISDN Programs screen and return to the Administratio
Menu.

➤ To use the Strata DK’s program files to edit

1. Press F2 and the DK Code dialog box displays.

2. Type the DK Code: XXXX, where XXXX is the DK level 1 security code set in Program 
00. The DK System Program File screen displays.
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Note If the Problem: Unable to Establish Communications screen 
displays, follow the troubleshooting steps on the screen and/or refer to Appendix A – 
Connecting to Strata DK to correct the problem.

3. Press F2 to select (tag) all Program No. (data) files.

4. Highlight Yes and press Enter. DKAdmin establishes communications to the Strata D
turns on LED 10 in Program 77-1, and receives data blocks. This information display
the PC screen as it occurs.

5. Follow Step 2 ~ Step 4 of “To edit ISDN programs” on Page 97.

➤ To view notes on a program
➤ Highlight the program and press F5.

Note You can also use the Find function to move quickly to a program by typing the fir
one or two digits of the program number. The program highlights the first program
number matching your entry.

♦ Use the Up/Down arrow keys to scroll the description.

♦ Press F10 to print the description.

♦ Press Esc to return to the ISDN Programs screen.

Backup/Restore Data
For the Backup/Restore Data option, see “Backup Data” on Page 100 and see “Restore Data” 
on Page 102.

View/Print Data
For the View/Print Data option, see “View/Print Data” on Page 115.
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Note The Backup Menu is only available in the DKBackup program. The Check Processor 
Type, Backup/Restore Data, and View/Print Data appear in both the DKBackup 
Backup Menu and the DKAdmin Administration Menu. These functions are identical 
(e.g., screens, operations, commands, etc.) whether you use DKAdmin or DKBackup.

DKAdmin/DKBackup makes backing up and restoring Strata DK programs quick and easy 
and saves valuable time and labor when upgrading Strata DK software. You may use this 
function to:

♦ Download all customer data from a programmed Strata DK to the DKAdmin/DKBackup 
PC.

♦ Upload and restore an updated customer database from the DKAdmin/DKBackup PC to 
your customer’s Strata DK.

♦ Upgrade data from a Strata DK processor to a new higher level processor.

♦ View/print customer program ASCII files.

Notes

● When you create a new customer record using the Maintain Customer File option, 
DKAdmin/DKBackup creates a new PC disk directory, XXX.DK, and places the speci
files into this directory.

XXX = the customer directory which is named when creating a new customer, using the 
Maintain Customer File option in the File Menu.

The .DK extension is automatically added by DKAdmin/DKBackup when creating the 
directory in DOS.

● The Strata DK programming telephone (station 205 or 213) cannot be in the program
mode when backing up or restoring Strata DK program files.

● Anytime PRGALL is restored to a Strata DK, system power must be turned OFF (3 
seconds) and then ON. This is required to make Programs 03, *29, 39, 59, and *41~2 take 
effect in Strata DK Release 2. It is only required for Programs 03, 76-1, *41-2, and *50 in 
Strata DK Release 3~Release 4.

● Do not use Backup Data (F3) or Restore Data (F4) to upgrade processors.

● When upgrading processors, Primary, Phantom, and Distributed Hunt Group default
[DNs] that are not on the original processor are blanked out on the new processor to
prevent [DN] conflicts. This includes default data in Programs 04, *04, *09, and 71-0.
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Check Processor Type

➤ To check processor type

1. Select a customer using the Select Customer option in the File Menu.

2. From the Administration Menu/Backup Menu, press c to display a pop-up dialog box.

3. Enter the four-digit DK Code. The default is 0000. This is the “first level password” wh
is set in the Strata DK Program 00. The code does not display as you type it.

4. DKAdmin/DKBackup pulls Program 00 and displays the processor type, ROM/Flash
version and release numbers, along with the same information of the selected custo
database. Verify that the displayed information is the same as the processor installed
DK system.

Notes

● If the PC and Strata DK do not communicate, the Problem: Unable to Establish 
Communications screen appears. Follow the instructions on the screen and/or see 
Appendix A – Connecting to Strata DK to correct the problem.

● Make sure the programming telephone (station 205 or 213) is not in the programmin
mode.

Backup Data

➤ Prior to backing up

1. Select a customer using the Select Customer option in the File Menu.

Note Before you can select the customer, you must use the Maintain Customer File op
to create a customer.

2. Establish a communications path between the PC (running DKAdmin/DKBackup) an
Strata DK using the Dial DK option or by making a direct connection to the Strata DK 
Appendix A – Connecting to Strata DK).

3. After connecting the DKAdmin/DKBackup PC to the Strata DK, select the Administra
Menu/Backup Menu and run the Check Processor Type option to verify that the cust
file format is the same as the installed Strata DK processor. When checking the proc
you must enter the DK code programmed on the installed processor.

Important! Make sure the processor type, ROM/Flash release number (1~4) are the same as 
the customer database you are backing up. Release 3 and 4.X are considered the 
same for backing up and restoring databases.

If the Problem: Unable to Establish Communications screen displays, follow the step
the screen and/or see Appendix A – Connecting to Strata DK to correct the problem.

➤ To back up (download) a customer’s database

1. After checking the processor type, select the Administration Menu/Backup Menu and type 
b. The DK Code dialog displays.

2. Enter the four-digit DK Code (if prompted to do so).

Important! You must enter the code that is programmed on the installed processor.
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The DK System Program File screen displays listing the available data for backup (see 
screen in Step 3). For security, this code does not display on screen as you type it. The 
default code is 0000. This is the “1st level password” which is set in the Strata DK 
Program 00 (see the record sheet for Program 00 in the Strata DK Programming Manual).

Note If the Problem: Unable to Establish Communications screen displays, follow the 
troubleshooting steps on the screen and/or see Appendix A – Connecting to Strata DK 
to correct the problem.

3. Highlight the program file you wish to back up (download) and press the spacebar to
(checkmark) the program file (shown below). Repeat this step for as many program 
as you wish to back up. Press F2 to tag all program files (see Note “The DK System 
Program File...” on Page 102).

4. After selecting the programs, press F3. The screen prompts with the message “You 
will receive data from the DK. Are you sure?”

5. Highlight Yes and press Enter.

6. DKAdmin/DKBackup prompts you to enter the DK Code again. When the correct co
entered, DKAdmin/DKBackup turns on LED10 in Program 77-1 and then downloads
files selected in Step 3. The screen displays Download Complete when finished.

7. Press Esc twice and select the next desired function.

Notes

● When you back up PRGALL, the DK security code set in the DKAdmin/DKBackup 
customer database, is not sent to the processor. You must always enter the DK secu
code that is actually programmed on the processor installed in the Strata DK. You ca
change the DK security code using the DKAdmin Program Administration Section op
or manually using the programming telephone.

● Access to the DK Code should be considered highly confidential and only given to th
individuals with the security level which enables them to program or update DK data
changing the Strata DK Program 00 Passwords, always change both Level 1 and 2 
security. DKAdmin/DKBackup checks both codes and runs with either code.

DK System Program File

✔ Program No. Program Title

PRGALL All System Programs

REPALL All Station and System Speed Dial Numbers

NAMEALL All User Names

VIDALL All Voice Mail ID Codes (#656)

MIDALL All Voice Mail Message Waiting Codes (#657)

ADMEMOAL All Station and System Speed Dial Memos

MSGALL All Station and System LCD Messages

CFALL Directory Number Call Forwarding settings (R3)

MWALL Message Waiting Lamp settings (R3)

CLID Caller ID/ANI Lost Call telephone numbers (R3)

F1-Help SPACE-(Un)Tag F2-(Un)Tag All F3-Backup F4-Restore F5-Upgrade 
Esc-Exit

Select If Marked
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● The DK System Program File list is displayed (see Step 3 on Page 101). If this screen does 
not display, the DKAdmin/DKBackup PC and the Strata DK are not communicating. See 
Appendix A – Connecting to Strata DK for procedures to connect the PC COM port to th
Strata DK PIOU, RSSU, RSIS, RSIU, or PIOUS TTY port, or IMDU or RMDS modem

Important! If the PC screen does not display prompts such as Turning on LED 10, 
Program 77-1, XXX:LOGGING IN, etc., the PC and Strata DK are not 
communicating. When operating properly, DKAdmin/DKBackup logs off and on 
in between each program file it restores. If a communication failure exists, see 
Appendix A – Connecting to Strata DK. If the communication path between the 
PC and Strata DK is broken during Backup or Restore operations, it may be 
necessary to go in and out of the Program mode from the programming telephone 
(Station 205); or turn the Strata DK power off and on to resume communications.

Restore Data

➤ Prior to restoring data

1. Select a customer using the Select Customer option in the File Menu.

This should be the customer database which has been created or previously backed
using DKAdmin/DKBackup. This customer database must be the same DK Release
(e.g., 1, 2, 3, or 4.X) and processor type to which you are restoring data.

Although DK16e is considered Release 1, it contains the Release 3 features of RCT
with the exception of Distributed Hunt.

Note Release 3 data can be restored to Release 3.X data and vice versa.

2. Establish communications between the DKAdmin/DKBackup PC and the Strata DK u
the Dial DK option or by making a direct connection (see Appendix A – Connecting to 
Strata DK).

3. After connecting to the Strata DK, select the Administration Menu/Backup Menu and
the Check Processor Type option to verify that the customer file format is the same a
installed Strata DK processor.

Important!  Make sure the processor type, ROM/Flash release number is the same as the 
customer database you are restoring.

If the Problem: Unable to Establish Communications screen displays, follow the step
the screen and/or see Appendix A – Connecting to Strata DK to correct the problem.

➤ To restore (upload) a customer’s database

1. After checking the processor type, select the Administration Menu/Backup Menu and type 
b. The DK Code dialog displays.

2. Enter the four-digit DK Code (if prompted to do so).

Important! You must enter the code that is programmed on the installed processor.

For security, this code does not display on screen as you type it. The default code is 0000. 
This is the “1st level password” which is set in the Strata DK system Program 00 (se
record sheet for Program 00 in the Strata DK Programming Manual).
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Notes

● When you back up PRGALL, the DK security code, set in the DKBackup customer 
database, is not sent to the processor. You must always enter the DK security code that is 
actually programmed on the processor installed in the Strata DK. You can change the DK 
security code using the DKAdmin Program Administration Section option or manually 
using the programming telephone.

● Access to the DK Code should be considered highly confidential and only given to those 
individuals with the security level which enables them to program or update DK data. If 
changing the Strata DK Program 00 Passwords, always change both Level 1 and 2 for 
security. DKAdmin/DKBackup checks both codes and run with either code.

● After you enter the DK Code, the computer will display the DK System Program File list 
is displayed (see screen in Step 3 below). If this screen does not display, the DKAdmin/
DKBackup PC and the Strata DK are not communicating. See Appendix A – Connecting 
to Strata DK to verify that the PC COM port is connected to the Strata DK PIOU, RSS
RSIS, RSIU or PIOUS TTY port, or IMDU or RMDS modems.

● Make sure the programming telephone (station 205 or 213) is not in the programmin
mode if communications are not established.

3. After entering the DK code, the following screen displays.

Note If the PC and Strata DK do not communicate, the Problem: Unable to Establish 
Communications screen appears. Follow the instructions on the screen and/or s
Appendix A – Connecting to Strata DK to correct the problem.

4. Highlight the program file you wish to restore and press the spacebar to tag (checkm
the program file. Repeat this step for as many program files as you wish to restore. P
F2 to tag all files.

CAUTION! Do not restore the PRGALL file while the system is in use. Restoring the file, 
interrupts service by blanking out [DNs] temporarily.

5. After selecting the files, press F4. The pop-up window shown below displays. If you are
changing ROMs/Flash Memory or PCBs, follow the instructions on the screens to ad
change PCBs and reset the Strata DK communications port.

If you are changing from a PIOU/PIOUS/RSSU to a RSIU or RSIS, you are able to 
increase the DKAdmin/DKBackup PC COM port baud rate (for example, from 1200 
9600).

DK System Program File

PRGALL All System Programs

REPALL All Station and System Speed Dial Numbers

NAMEALL All User Names

VIDALL All Voice Mail ID Codes (#656)

MIDALL All Voice Mail Message Waiting Codes (#657)

ADMEMOAL All Station and System Speed Dial Memos

MSGALL All Station and System LCD Messages

CFAALL Directory Number Call Forwarding settings (R3)

MWALL All Message Waiting Settings (R3)

CLID All Class/ANI Lost Call Number Storage Data (R3)
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Important! These messages display

6. Press Enter and the following screen displays:

Processor Conversion

PLEASE READ THE FOLLOWING SCREENS AS THEY PROVIDE VERY IMPORTANT 
INFORMATION REGARDING THE UPGRADE AND INITIALIZATION PROCESSES.

Please turn DK system power off and add/change cabinets, processor ROM or 
RMSS memory and/or RCTU PCBs as required.

IMPORTANT: Do not add PCBs, other than RSIU or PIOU in between existing 
PCBs at this time as they will make station port and/or CO line numbers 
shift causing the upgraded data to be invalid.

The next screen provides step-by-step instructions for initializing the 
system.

Press any key to Continue

Processor Conversion

Step A: After changing the processor, you should initialize the new 
processor by running Program 91-9 manually from the Programming 
Telephone. Then you must reset the PIOU, PIOUS, RSSU, or RSIU/
RSIS/RMDS TTY port that is connected to DKAdmin PC by performing 
Step B and/or C.

Step B: From the Programming Telephone, use Program 03 to set code 41 for 
the cabinet slot that contains the new TTY/Maintenance PIOU, 
PIOUS, or RSSU PCB and proceed to Step D. If you added an RSIU/
RSIS/RMDS PCB, set code 49 for cabinet slot 11 and proceed to Step 
C.

Step C: From the Programming Telephone, use Program 76-1 and 76-2 to set 
the RSIU/RSIS/RMDS ports for their appropriate functions and baud 
rates. DKAdmin will pull Program 76 and adjust the DKAdmin 
customer database accordingly. Make sure the TTY/Maintenance port 
settings are correct to insure a successful Upgrade process. 
Proceed to Step D.

Step D: Turn DK off (5 sec) then on. From the Programming Telephone, test 
the RCTU (R3) RAM by running Program 00-(51,52/61, 62)

Press any key to Continue
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7. After completing the steps on the screen, press Enter (twice) and the Baud Rate 
Selection screen displays (shown below). This screen enables you to set the DKAdmin/
DKBackup PC COM port baud rate which must match the baud rate of the TTY or modem 
port set by the programming telephone.

8. Select the DKAdmin/DKBackup PC COM port baud rate and press Enter. The 
information screen below instructs you to pull Program 03 if you changed any PCBs 
during the Restore process. DKAdmin/DKBackup enables you to pull Program 03 
automatically.

Note If you are connected to the customer system, always have DKAdmin/DKBackup pull 
Program 03 when restoring data. If you are restoring data to an RCTU that is installed 
in a test system that is not loaded with the same PCBs as the customer database, do not 
pull Program 03 at this time.

DKAdmin/DKBackup will then download Program 03 and Program 76 to ensure a 
successful restore process.

Baud Rate Selection
Please adjust the baud rate of DKBackup PC COM port to match the new 
PIOU, PIOUS, RSSU or RSIU/RSIS you may have installed.

Baud Rate ...............
9600

Processor Conversion

If you added or changed any PCBs other than the RCTU PCB in the DK system, 
the customer database will need to be updated to reflect these changes. 
You can pull Program 03 from the DK to accomplish this.

If you pull Program 03 from the DK, you will override the existing 
customer database with the DK data.

If you do not pull Program 03 from the DK, the existing customer database 
will remain intact.

IMPORTANT: If you have upgraded the customer database offline, DO NOT pull 
Program 03 as it will override your changes.

IMPORTANT: Any time DK14/DK16e/DK40 is upgraded, Program 03 must be 
pulled so DKAdmin can update the new system’s cabinet drawing.

NOTE: If you pull Program 03 from the DK, the DK will be initialized with 
Program 91-1 automatically. This initialization program identifies the 
PCBs to the DK.

Press any key to Continue

300
1200
2400
4800
9600
14400
19200
38400
57600
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9. After reading the screen in Step 7, press Enter. The screen below displays.

10. Highlight Yes and press Enter. You are prompted for the DK Code.

11. Enter the four-digit DK Code.

Important! You must enter the code programmed on the installed processor.

DKAdmin/DKBackup turns on LED10 in Program 77-1 and then displays the message 
“You will send data to the DK. Are you sure?”

12. Highlight Yes and press Enter. You are prompted for the DK Code.

13. Enter the four-digit DK code.

Important! You must enter the code programmed on the installed processor.

DKAdmin/DKBackup begins the Restore process. After restoring data, the message
Upload Complete! displays

Note Before restoring data, DKAdmin/DKBackup pulls some programs (04, *04 and  *09) 
to arrange the data and prevent numbering conflicts.

14. Press Enter from the Process Complete screen. The information screen below displ

15. Turn the system off (five seconds) and then on, or highlight Yes when you are prompted 
with the message Perform automatic power OFF/ON simulation?

DK System Program File

✓ Program No. Program Title

✓ PRGALL All System Programs

REPALL All Station and System Speed Dial Numbers

NAMEALL All User Names

VIDALL All Voice Mail ID Codes (#656)

Pull Program 03 from DK to Update Customer Database?

Yes No

You have uploaded program(s) to the DK which require 
the DK to be powered off for 5 seconds and then on 
again for the modifications to take effect.

DK280 Release 3 and 4 allows you to perform this task 
automatically without physically turning the system 
off. If desired, the system can be shut down manu-
ally.
106 DKAdmin/DKBackup



––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Upgrade

 option. 

, 
16. Press Enter from the screen above. DKAdmin/DKBackup runs Program 91-2 and then 
displays the message Program 91-2 has been completed. The system 
has performed a power off/on simulation.

17. After the above screen displays, press any key. The restore process has been completed. 
You may use the Esc key to exit to the top menu.

Important!

● If you restore (send) PRGALL to the Strata DK, the DK security code that is programmed 
on the installed processor is not changed. You may change the DK security code using the 
DKAdmin Program Administration Section option or manually from the programming 
telephone.

● When uploading Program 35 or PRGALL, DKAdmin will pull MSGALL and ADMEMOAL 
to update any changes in Program 35, LED 05.

Upgrade

Upgrading a Customer’s Processor
See “Maintain Customer File” on Page 36 for information on upgrading a customer’s 
processor.

Strata DK Processor PCB Upgrade
You can upgrade processors and keep an old database using the Backup/Restore Data
Upgrades may be made as follows:

♦ DK14 to: DK16e, DK40, or any RCTU Release 3 or higher.

♦ DK16e, DK40 to: RCTUA3, RCTUA4, RCTUBA3/BB3, RCTUBA3/BB4, RCTUC3/D3
RCTUC3/D4, RCTUE3/F3, or RCTUE3/F4.

♦ RCTUA to: RCTUB, RCTUC/D, RCTUE/F, RCTUA3 or RCTUA4.

♦ RCTUB or B2 to: RCTUC/D, RCTUE/F, RCTUBA3/BB3, or RCTUBA3/BB4.

♦ RCTUC/D2 to: RCTUE/F, RCTUC3/D3 or RCTUC3/D4.

♦ RCTUE3/F3 to: RCTUE3/F4

Important! DK14, DK16e, and DK40, Release 1 software is identical (e.g., features, 
programs, etc.) to DK280/DK424 RCTUA3 or Release 3.0. You can, therefore, 
only upgrade DK14, DK16e or DK40 to an RCTU processor with Release 3.0 or 
higher software. DK14 can be also upgraded to DK16e and DK40. DK16e can 
interchangeably upload and download with DK40 databases and vice versa.

Notes

● It is not possible to go from a RCTUC/D to a RCTUA or RCTUB, from a RCTUB to 
RCTUA, etc., or from Release 4 back to Release 1~Release 3.

● In this procedure, the word “original” describes the existing processor and “new” 
describes the upgraded processor.
107Backup Menu (DKBackup)



Upgrade ––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––

 to the 
. Then 
lease 
to the 

 port 

t is 
● When upgrading from an RCTU Release 1 or 2 to an RCTU Release 3 or above, 
DKAdmin/DKBackup automatically converts Program 39 intercom code (000) to the 
appropriate Primary Directory Number code (##XXX) for each station port.

● When upgrading from DK16e and RCTUA to RCTUB or C/D (all releases), System 
Speed Dial numbers and buttons (060~099) are upgraded to (660~699).

● When upgrading to an RCTUE/F, station and system speed dial numbers *60~*99, 
*600~*699, and *10~*39 will be converted to *200~*999 and *100~*139 appropriately.

● When upgrading from RCTUB to RCTUC/D or RCTUE/F (all releases), the Program *09 
ACD Port assignments (090~097) are upgraded to (250~257) for RCTUC/D or (870~885) 
for RCTUE/F.

● When upgrading from RCTU Release 1 or 2 to RCTU Release 3 or above, Program *04 
and 71-0 are blanked out to insure that [PhDN], Distributed Hunt [DNs], and DNIS default 
values do not conflict with existing [DNs] (Program 04) and DID numbers (Program 
*09). All [DNs] not programmed on the original processor in Programs 04, *04, *09, and 
71-0 are also blanked out on the new processor to prevent numbering conflicts.

● When upgrading from RCTUA to RCTUB, RCTUC/D or RCTUE/F (all releases), the 
RCTUA Program *09 IMDU/RMDS Port 035 is upgraded to Port 085 (RCTUB), Port 
245 (RCTUC/D) or Port 340 (RCTUE/F); or, if upgraded from RCTUB to RCTUC/D or 
RCTUE/F (all releases), Program *09 IMDS/RMDS Port 085 is upgraded to Port 245 
(RCTUC/D) or Port 340 (RCTUE/F).

➤ To upgrade the processor

1. Select the Customer using the Select Customer option in the File Menu.

Notes

● If a customer database does not exist for the processor (original) that you are upgrading 
from, go to the Maintain Customer File option and create a customer, selecting the 
“original” processor and the original software release; then answer Yes to the question 
Backup From DK First during the upgrade process.

● Before upgrading, use the Backup option to backup the original processor database
designated customer so you can go back to the original processor type, if necessary
create a new customer for the upgrade database, selecting the original processor re
and processor type. The upgrade process converts the original processor database 
new processor database.

2. Establish a connection between the DKAdmin/DKBackup PC and the Strata DK TTY
- the original processor should be installed in the Strata DK.

Important! On-site upgrades should be completed when the DKAdmin/DKBackup PC COM 
port is connected directly to the Strata DK (per Appendix A – Connecting to 
Strata DK, Figure A-1), not while the system is in use or through modems. 
However, you can backup the customer database remotely via modems and then 
upgrade the database to another RCTU in your office. After the RCTU is 
upgraded in your office, you can install it in the customer’s DK.

3. After making a direct connection between the DKAdmin/DKBackup PC and the DK, use 
the Check Processor Type option under the Administration Menu/Backup Menu to verify 
that the installed (original) processor is the same type and software release as the selected 
customer file.

Important! When checking the processor type, you must enter the DK security code tha
programmed on the processor you are checking.
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If the following message displays: Problem: Unable to Establish 
Communications, follow the steps on the screen and/or refer to Appendix A – 
Connecting to Strata DK to correct the problem.

4. From the Administration Menu/Backup Menu, type b. The DK Code dialog box displays.

5. Enter the four-digit DK Code that is programmed on the installed processor. The DK
System Program File screen displays as shown below. For security, this code does n
display on screen as you type it. The default code is 0000. This is the “1st level passw
which is set in the Strata DK Program 00 (see the record sheet for Program 00 in the Strata 
DK Programming Manual).

If the Problem: Unable to Establish Communications screen displays (shown below)
check the items listed on the screen and/or refer to Appendix A – Connecting to Strata 
DK.

6. Press F5 (Upgrade). The screen below provides instructions regarding Program 03.

7. Press the spacebar to display the screen below (this is an sample upgrade RCTU-C
RCTU-EF Release 3 or Release 3.10).

DK System Program File

✔ Program No. Program Title

PRGALL All System Programs

REPALL All Station and System Speed Dial Numbers

NAMEALL All User Names

VIDALL All Voice Mail ID Codes (#656)

MIDALL All Voice Mail Message Waiting Codes (#657)

ADMEMOAL All Station and System Speed Dial Memos

MSGALL All Station and System LCD Messages

CFALL Directory Number Call Forwarding settings (R3)

MWALL Message Waiting Lamp settings (R3)

CLID Caller ID/ANI Lost Call telephone numbers (R3)

F1-Help SPACE-(Un)Tag F2-(Un)Tag All F3-Backup F4-Restore F5-Upgrade 
Esc-Exit

Select If Marked

Processor Conversion

Note:
After the data are upgraded, the new data will be sent to the DK. You 
will then need to modify Program 03 and upload to the DK.

Processor Conversion

Processor Currently in Use: DK, RCTU-CD, R3

Processor to Upgrade to: DK, RCTU-EF, R3

Backup From DK First: Yes
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8. Press Enter and then select the processor type you are upgrading to; press Enter after 
selecting the processor (RDTU E/F, Release 3 in this example).

9. If you haven’t backed up the customer database by downloading the original RCTU,
answer Yes to Backup From DK First; otherwise, answer No. Press the spacebar to
make your selection and then press Enter.

10. From the screen in Step 7 above, use the spacebar to change Backup From DK First 
from No to Yes to download the database from the original processor and press Enter.

Note If you already completed a backup and have a spare customer database for the o
processor, you can answer No to the prompt: Backup from DK First. 
DKAdmin/DKBackup upgrades the database files and displays the screen shown
Step 13. Steps 11 and 12 are skipped.

You are prompted with the message Upgrading to DK RCTU EF, R3. Are you 
sure? This database is then upgraded before sending it to the “new” processor

11. Use the arrow keys to highlight Yes and press Enter. You are now prompted with You 
will receive data FROM the DK. Are you sure?

12. Highlight Yes and press Enter. DKAdmin/DKBackup downloads the following files: 
PRGALL, REPALL, NAMEALL, VIDALL, ADMEMOAL, MSGALL, CFALL
(Release 3), MWALL (Release 3), CLID (Release 3). DKAdmin/DKBackup then 
upgrades and builds the database. After upgrading the database, the screen in Step 13 
displays.

13. At this point DKAdmin/DKBackup has upgraded the customer database; follow the 
instructions on the screens below to change ROMs/Flash Memory on processors an
cabinets and PCBs as required.

Important! Remember to turn power off before changing PCBs and cabinets. Then turn the 
system back on and perform the steps on the screen below to ensure the 
DKBackup and DK system TTY port communication link continues to function 
during the remaining upgrade process.

Processor Conversion

PLEASE READ THE FOLLOWING SCREENS AS THEY PROVIDE VERY IMPORTANT 
INFORMATION REGARDING THE UPGRADE AND INITIALIZATION PROCESSES.

Please turn DK system power off and add/change cabinets, processor ROM or 
RMSS memory and/or RCTU PCBs as required.

IMPORTANT: Do not add PCBs, other than RSIU or PIOU in between existing 
PCBs at this time as they will make station port and/or CO line numbers 
shift causing the upgraded data to be invalid.

The next screen provides step-by-step instructions for initializing the 
system.

Press any key to Continue
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14. Press Enter and the following screen displays:

15. Press Enter (twice) after completing the Steps above. The Baud Rate Selection screen 
displays (shown below). This screen enables you to set the DKAdmin/DKBackup PC 
COM port baud rate which must match the baud rate of the TTY port set by the 
programming telephone in Program 76 (if upgrading TTY port to RSIU).

Note This Step enables you to switch the TTY port from a PIOU (1200 bps) to an RSIU 
(9600 bps) TTY port to complete the upgrade process faster.

Processor Conversion

Step A: After changing the processor, you should initialize the new 
processor by running Program 91-9 manually from the Programming 
Telephone. Then you must reset the PIOU, PIOUS, RSSU, or RSIU/
RSIS/RMDS TTY port that is connected to DKAdmin PC by performing 
Step B and/or C.

Step B: From the Programming Telephone, use Program 03 to set code 41 for 
the cabinet slot that contains the new TTY/Maintenance PIOU, 
PIOUS, or RSSU PCB and proceed to Step D. If you added an RSIU/
RSIS/RMDS PCB, set code 49 for cabinet slot 11 and proceed to Step 
C.

Step C: From the Programming Telephone, use Program 76-1 and 76-2 to set 
the RSIU/RSIS/RMDS ports for their appropriate functions and baud 
rates. DKAdmin will pull Program 76 and adjust the DKAdmin 
customer database accordingly. Make sure the TTY/Maintenance port 
settings are correct to insure a successful Upgrade process. 
Proceed to Step D.

Step D: Turn DK off (5 sec) then on. From the Programming Telephone, test 
the RCTU (R3) RAM by running Program 00-(51,52/61, 62)

Press any key to Continue

Baud Rate Selection

Please adjust the baud rate of DKBackup PC COM port to match the new PIOU, 
PIOUS, RSSU or RSIU/RSIS you may have installed.

Baud Rate .............
9600

300
1200
2400
4800
9600
14400
19200
38400
57600
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16. Select the DKAdmin/DKBackup PC COM port baud rate and press Enter. The 
information screen below instructs you to pull Program 03 if you changed any PCBs 
during the upgrade process. DKAdmin/DKBackup can be used to pull Program 03 
automatically.

17. After reading the screen above, press Enter. The program displays: 
Pull Program 03 from DK to Update Customer Database?

Note If upgrading onsite and the new RCTU is in the customer’s DK, it is recommende
that you answer Yes. This will cause DKAdmin/DKBackup to pull Program 03 to 
ensure that the upgrade process is successful. If the RCTU you are upgrading is
installed in a test system (offsite), answer No. Program 03 will not be pulled and 
Program 03 data in the customer database (in DKAdmin) is sent to the new proc

18. Highlight Yes or No and press Enter. You are prompted to enter the DK code.

19. Enter the default DK Code 0000. DKAdmin/DKBackup initializes the processor with 
Program 91-1, and downloads Programs 03 (if Yes in Step 18) and 76. The program 
displays the message: You will send data to the DK. Are you sure?

20. Highlight Yes and press Enter. You are prompted to re-enter the DK Code.

21. Enter the default DK code 0000. DKAdmin/DKBackup begins the upgrade process.

Note Before restoring/upgrading data, DKAdmin/DKBackup pulls some programs (04, 
*04 and *09) in order to arrange the data and prevent numbering conflicts. The D
then sends the upgraded database to the new processor.

22. After sending the upgraded data to the new processor, the screen below displays. R
screen and press Enter. 

Processor Conversion

If you added or changed any PCBs other than the RCTU PCB in the DK system, 
the customer database will need to be updated to reflect these changes. 
You can pull Program 03 from the DK to accomplish this.

If you pull Program 03 from the DK, you will override the existing 
customer database with the DK data.

If you do not pull Program 03 from the DK, the existing customer database 
will remain intact.

IMPORTANT: If you have upgraded the customer database offline, DO NOT pull 
Program 03 as it will override your changes.

IMPORTANT: Any time DK14/DK16e/DK40 is upgraded, Program 03 must be 
pulled so DKAdmin can update the new system’s cabinet drawing.

NOTE: If you pull Program 03 from the DK, the DK will be initialized with 
Program 91-1 automatically. This initialization program identifies the 
PCBs to the DK.

Press any key to Continue

You have uploaded program(s) to the DK which require the DK to be powered 
off for 5 seconds and then on again for the modifications to take effect.

DK280 Release 3 and 4 allows you to perform this task automatically 
without physically turning the system off. If desired, the system can be 
shut down manually.
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Note For Release 2, only the following message displays: Turn the system OFF (5 
sec).

23. Turn the system off (five seconds) and then on.

...or

When the screen displays the message Perform Automatic Power OFF/ON 
Simulation?, highlight Yes (Release 3 or Release 4 upgrades only).

24. Press Enter and DKAdmin/DKBackup runs Program 91-2 and displays the screen below 
(Release 3 or Release 4 upgrades only).

25. Press any key. The upload part of the upgrade process has been completed.

26. Press the spacebar; the following message displays: To complete the upgrade 
process, you will receive data?

27. Highlight Yes and press Enter and you are prompted for the DK Code. It is necessary to 
download the upgraded processor database to complete the upgrade process.

28. Type the default DK Code 0000. DKAdmin/DKBackup downloads the upgraded database 
and saves it under the customer directory. When complete, the Processor Conversion 
screen displays (shown below).

29. Perform the steps displayed on the screen as required, using the programming telephone, 
and backup any data that you change, using DKAdmin/DKBackup.

30. Press Esc twice to return to the Main Menu.

Program 91-2 has been completed.

The system has performed a power off/on simulation.

Processor Conversion

Conversion Completed Successfully.

Program 03 may have been updated by the conversion process. This process 
only updates the installed PCBs but not the piggyback options. You must 
edit and upload Program 03 if such changes are required.

Program 76 may have been reset to ensure that the communication link 
between DKBackup PC and the Strata DK RSIU/RSIS/RMDS TTY port remains at 
the same baud rate. Check and adjust each RSIU/RSIS/RMDS port as 
required.

If you upgraded a Release 2 System with ACD to Release 3 system with ACD, 
you must perform the steps below for proper ACD operation:

1. Remove all ACD CO line and Pooled line buttons from Agent phones 
(PRG39).

2. Add a single appearing PhDN (ACD Call Button) to all Agent phones 
(PRG39).

3. Program each Agent ACD Call Button PhDN to ring at the Agent phone 
(PRG*71).
4. Program each Agent phone as the owner of its ACD call button PhDN 
(PRG*33).
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Important!

When using DKAdmin/DKBackup, the following list provides important information regarding 
specific programs:

● Program 00: DKAdmin/DKBackup does not upgrade the DK security codes in Program 
00-1 and 00-2. If required, change the code using the DKAdmin Program Administration 
Section option or manually from the programming telephone.

● Program 03: On new or upgraded installations, Program 03 should always be checked 
and updated using DKAdmin Program Administration Section option or manually from 
the programming telephone to make sure all PCB slots have the correct codes for PCBs 
and PCB options. Strata DK power must be turned off (five seconds) and then on after 
uploading (restoring) Program 03 to enable its data to take effect.

● Programs 04, *04 and *09: When uploading these programs, DKAdmin/DKBackup 
downloads them from the processor, compares and arranges data in an acceptable order 
and uploads the data to the Strata DK.

● When upgrading processors, [DNs] that are not programmed or do not exist on the 
original processor in Programs 04, *04, *09, and 71-0, are blanked out on the new 
processor. For example, when upgrading from Release 2 to Release 3, all [PhDNs] are 
blank on the new Release 3 processor. This is necessary to prevent numbering conflicts.

CAUTION! ACD/DID assignments in Program *09 cannot be restored (uploaded) with 
early ROM versions of Strata DK Release 2 ROMs; they must be restored 
using the programming telephone. ROM, RCA-6K(RCTUC/D2) and
RBA-6H(RCTUB2) and later, and Flash Memory versions provide the ACD/
DID assignments (Program *09) restore function.

Strata DK Release 3 Added Features: Strata DK Release 3 enables you to backup and restore 
Station Call Forward and Message Waiting status. However, when you upgrade from Strata 
DK Release 1 or 2 to Release 3, Call Forward and Message Waiting data are lost.

When upgrading from Strata DK, Release 3 to Release 3.10 or higher, station Call Forward, 
Message Waiting, and Lost ANI/Caller ID data are saved and restored from the original 
processor to the new processor.

CLID: To restore lost call number data, stations must have memory allocated in Program  *51.

Important! When backing up or upgrading Strata DK Release 1 Processors: The original 
release of Strata DK software version RCA-3U, 3X or 3Z; RBA-X3F (Release 1, 
June 1, 1993) stores station memory files (REPALL, MSGALL, VIDALL, 
MIDALL, ADMEMOAL, and NAMEALL) in a list format which uses a large 
amount of the PC’s memory and takes a long time to back up and restore.

Toshiba recommends using an MS-DOS edit program to edit out all lines of 
backed-up data (in each file) that do not contain actual speed dial numbers, 
names, etc. This should be done before restoring the customer database. T
editing process will not be necessary when backup/restore is used with Strat
software versions following the original June 1, 1993 release. Release 1 RO
RCA-4A (Released September 1, 1993) and later, and Flash Memory versio
store data in a compressed format and do not require the file editing.

Release 1 processors (shipped between June 1993 and August 1993) may 
during the download process. It may be necessary to download individual fil
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one at a time (for example: PRGALL), instead of tagging all files to download. If 
a Release 1 processor fails during the downloading process, retry the process or 
change the original Release 1 processor ROMs to NANP Release 1 upgrade 
ROMs and then download.

View/Print Data

➤ To access the option

1. From the File Menu, select a customer.

2. From the Administration 
Menu, type v. The View/
Print Reports screen 
displays (shown right).

Note If you attempt to 
choose this option 
before you select a 
customer, a message 
Please select 
a customer 
first displays.

➤ To view and print a customer 
program

1. Highlight the program/files you wish to view and press the spacebar to select them. To 
select all the programs/files, press F2.

2. Press Enter to view the program. The program data is displayed in the ASCII format 
required for uploading/downloading the Strata DK. This data can be useful to personnel 
that have knowledge of Strata DK program records.

3. Press F4 to print selected data (remember to press the spacebar to select the file to print).

4. Press Esc to return to the Report screen.

➤ To print a customer program

1. Highlight the program/files you wish to print and press the spacebar to select them. To 
select all the programs/files, press F2.

2. Press F4 to print the program(s). The Printer Selection screen displays (with the default 
printer highlighted).

3. Change the printer destination (by pressing F2 to select the printer, then F2 again to 
display the list of printers to select from) or press Enter to accept the default printer and 
print the report.

4. The program data is printed out in the Strata DK ASCII format required to upload/
download the Strata DK. This data may be useful to personnel that have knowledge of 
Strata DK program records.
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This chapter gives you step-by-step instructions on using the options available on the Options 
Menu. They are:

♦ System Installation

♦ Company General Information (DKAdmin only)

♦ Screen Type/Color Installation

♦ Printer Type Selection

♦ System Miscellaneous Variables

♦ User Password Level Setup

♦ Communications Setup

♦ System Utilities

♦ ReIndex Files

System Installation
These features enable you to change system parameters such as screen colors, printer, 
miscellaneous system variables, user password setup and communications setups.

Company General Information
This option appears only on the DKAdmin — Option Menu and is not applicable to these
programs.
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Screen Type/Color Installation

➤ To change your monitor or color setups (not available to password level 2)

1. From the Main Menu, type o. The 
System Installation Submenu 
displays (shown right). Press 
Enter.

2. Type s and a pop-up screen 
displays (shown right), enabling 
you to set monitor and screen 
specifications. 

Note Press the spacebar to toggle between available options.

Screen Mode This option enables you to increase or decrease the screen 
display text size. Select 25, 43 or 50 lines. After making a 
selection, press Enter.

Color/Monochrome Select the appropriate option (Color or Monochrome) for 
the type of monitor you are using and press Enter. 

Reset Colors Select Yes or No and press Enter. If you select Yes, 
any custom colors you have chosen in the Change Colors 
option revert to the default colors.

Change Colors If you do not want to change the display screen colors, 
toggle the Change Colors option to No and press Enter. 
The pop-up closes and the System Installation Submenu 
displays.

If you would like to customize your screen display, follow 
the instructions in “To change the color of an item”.
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➤ To change the color of an item

1. From the pop-up dialog box, highlight the Yes for the Change Colors option and press 
Enter. The Color Selection screen displays.

The Color Selection 
screen (shown right) 
consists of an item 
selection menu, a set 
of item color bars, and 
a sample screen 
display showing the 
result of your color 
selection. All three 
components work 
together to show an 
example of your screen 
selection. As you 
select an item and 
change its color, the sample screen changes to reflect your new color selection.

You can change the color of the following screen items:

2. Use the Enter key to choose the item you want to change from the Item Selector Menu at 
the left side of the screen. As you move the highlighter down the Item Selector Menu, the 
appropriate color bar is selected.

3. Use the up/down arrow keys to change the color on the color bar. Notice that as you move 
along the color bar, the sample screen changes to reflect the color selected.

4. When you have completed all of your color selections, press the Esc key. A Save 
Changes pop-up window displays.

5. To save your color selections, press Enter. The system returns to the System Installation 
Submenu and is displayed in the colors that you have specified.

Printer Type Selection
The Printer Type Selection option enables you to specify the printer you will be using to print.

♦ Menu Screen ♦ Data Title

♦ Menu Background ♦ Data Special (Special Text)

♦ Menu Items ♦ Browse Background

♦ Data Border ♦ Browse Item

♦ Data Screen (Text) ♦ Attention Background (error messages)

♦ Data Select (Selected Text) ♦ Attention Select (error message item selected)

♦ Data Unselect (Unselected Text)
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➤ To select printer

1. Type p. The Printout 
Destination Selection 
Matrix screen displays 
(shown right).

2. Highlight the 
appropriate printer 
destination and press 
the spacebar. The 
highlighter moves to 
the Printer field.

3. Press F2. The 
Available Printer 
Drivers dialog box 
displays.

4. Scroll the printer list using the up/down arrow keys, or type the first letter of your printer 
to “jump” to the printer selections which begin with that letter. For example, if you ha
Hewlett-Packard Laserjet printer, type h and the screen scrolls to the beginning of the 
Hewlett-Packard printers. 

5. Highlight your selection and press Enter. The Printout Destination Selection Matrix 
screen displays again.

6. Press Enter and the System Installation Submenu displays.

System Miscellaneous Variables
The System Miscellaneous Variables option (available to password levels 8 and 9) enabl
to control various system functions and conventions by changing the default entry.

➤ To change system variables

1. Type m. The System 
Miscellaneous 
Variables pop-up 
displays (shown right).

2. Use the Enter or up/
down arrow keys to 
move from field to 
field. Press the 
spacebar to toggle 
between Yes and No.

Confirm Entries When set to No, as you complete an input field (using
all the available field characters), the cursor 
automatically moves to the next field. When set to Yes, 
you must press the Enter key after field input to move
to the next field. 

Bell On When set to Yes, as you complete all the available 
characters of an input field, a beep sounds.
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3. When you have completed your selections, press Enter. A Save Parameters pop-up box 
displays.

4. Press Enter to save the entries and return to the System Installation Submenu.

User Password Level Setup
The User Password Level Setup option (available to password level 9) enables you to control 
access to certain DKAdmin/DKBackup features through the assignment of menu-specific 
passwords. For example, you can restrict users from backup and restore functions, or security 
assignment features. By assigning the correct password level, these options will not be 
available for selection.

➤ To access the user password level setup option

1. From the Main Menu, 
type o and press Enter 
to select the System 
Installation option.

2. Type u and the Password 
File Maintenance screen 
displays (shown right).

Proper Case Conversion Select Yes to have text appear in proper - upper/lower 
case. Select No to have text appear in all capital letters.

Shift-Function Keys To build up to 10 function keys which can hold a 
specified text entry in memory, such as a name, date, or 
address, type Yes and press Enter. A pop-up window 
displays (shown below) where you may designate the 
entries.

In this example, each time that you want to insert the 
date, press Shift+F2 and the date is inserted. Press 
Shift+F3 and “John Smith” is inserted.

Background Char Change the screen background to a desired shading
(five settings available).
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➤ To add users and assign passwords

Note See Table 7  for a list of password access levels for each menu option available in the 
DKAdmin/DKBackup programs.

1. Highlight the User ID field and press Ins. A pop-up dialog box displays enabling you to 
enter new user ID information.

2. Enter a User ID using up to eight characters and press Enter.

3. Enter the User Name and press Enter.

4. Enter a Password using up to eight characters and press Enter.

5. Enter a Password Level and press Enter. The password level defines which Strata DK 
Programs and DKAdmin/DKBackup menu items a user may access (up to 10 levels can be 
created).

There are currently four (default) levels for DKAdmin:

 There are currently two (default) levels for DKBackup:

6. To add another user ID, press Ins, and repeat Steps 2~5.

Note Any existing user/password data may be overwritten or deleted.

2 = Administrator Level I access. Access to Check System Processor, System/
Station Administration, ACD Programs (level 2 only) and Port Attributes 
only; no access to password set up, Program Administration, feature 
reference, security maintenance, backup/restore, or view/print/delete data 
functions. Default ID and password is “ADMIN1”.

5 =  Administrator Level II access. Access to programs with level 5 and below (se
DKAdmin/DKBackup Security, below, for more information). No access to
password set up, security maintenance, backup/restore, or view/print/del
data functions. Default ID and password is “ADMIN2”.

8 = Tech Level I access. Access to all programs. No access to password or security
setup. Default ID and password is “TECH1”.

9 = Master access. Full Access to all functions and screens. Level 9 is typically
used by managers to assign passwords for Technicians and end users.

6 = Tech Level I access. Access to all programs. No access to password or security
setup. Default ID and password is “TECH1”.

9 = Master access. Full Access to all functions and screens. Level 9 is typically
used by managers to assign passwords for Technicians and end users.
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––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– System Installation
Table 7 Password Level Menu Access

File Menu Password Access Level

Select Customer 0,1,2,3,4,5,6,7,8,9

Maintain Customer 6,7,8,9

Dial DK 0,1,2,3,4,5,6,7,8,9

Hangup Connection 0,1,2,3,4,5,6,7,8,9

Transfer DK Data 6,7,8,9

About 0,1,2,3,4,5,6,7,8,9

Exit 0,1,2,3,4,5,6,7,8,9

Administration/Backup Menu* Password Access Level

View Cabinet Diagram 2,3,4,5,6,7,8,9

Check Processor Type* 2,3,4,5,6,7,8,9

System/Station Administration 0,1,2,3,4,5,6,7,8,9

Flexible Key Programming Section 2,3,4,5,6,7,8,9

Speed Dial Programming Section 2,3,4,5,6,7,8,9

ACD Administration Section 2,3,4,5,6,7,8,9

Program Administration Section 3,4,5,6,7,8,9

Security Maintenance Section 9

Directory Number Administration 2,3,4,5,6,7,8,9

DNIS Administration 2,3,4,5,6,7,8,9

Distributed Hunt Group Administration 2,3,4,5,6,7,8,9

Call Forward Assignments 2,3,4,5,6,7,8,9

E911/CAMA Trunk Programs (R4 Only) 2,3,4,5,6,7,8,9

ISDN Programs (R4 Only) 2,3,4,5,6,7,8,9

Backup/Restore Data* 6,7,8,9

View/Print Data* 6,7,8,9

Options Menu Password Access Level

System Installation 2,3,4,5,6,7,8,9

Company General Information 2,3,4,5,6,7,8,9

Screen Type/Color Installation 0,1,2,3,4,5,6,7,8,9

Printer Type Selection 0,1,2,3,4,5,6,7,8,9

System Miscellaneous Variables 0,1,2,3,4,5,6,7,8,9

User Password Level Setup 9
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➤ To change user or password information for an existing user

1. Access the Password File Maintenance screen (under the User Password Level Set Up 
option).

2. Highlight the user you wish to change and press Enter to display the user information.

3. Change the information, as required.

4. After changing the information, press Enter.

Note Changes are lost if you press Esc before pressing Enter. The entry will return to its 
original form.

➤ To delete a user from the DKAdmin/DKBackup system

1. Access the Password File Maintenance screen (under the User Password Level Setup 
option).

2. Highlight the user you want to delete and press Delete.

3. A confirmation message is displayed. Highlight Yes and press Enter. The user is 
deleted from the system. 

4. Press Esc to close the Password File Maintenance screen.

Communications Setup
The Communications Setup screen enables you to select the computer serial communications 
port (COM 1 ~ COM 4) which will be connected to the Strata DK (for procedures on 
connecting to the Strata DK, refer to Appendix A). This setup also enables you to select baud 
rate, parity, data bits, stop bits, direct modem initialization and a modem/DIU initialization.

The communication parameters shown below are the settings that are required to connect to 
the Strata DK and should remain constant.

Communications Setup 6,7,8,9

Reindex Files 0,1,2,3,4,5,6,7,8,9

Baud Rate = 1200* Parity = Even

Data Bits = 7 Stop Bits = 1

*May be up to 9600 if using RSIU.

Table 7 Password Level Menu Access (continued)
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➤ To display the communication settings

1. Type o. The Option Menu displays.

2. Type i. The System Installation Submenu displays.

3. Type o. The Communications Setup 
screen displays (shown right).

4. To change the Communication port, 
press Enter. A pop-up ports 
window displays.

5. Highlight the desired port and press 
Enter.

6. Verify (change if required) that the communication parameters are correct per the first 
paragraph of this section.

7. Verify (change if required) that the modem and modem/DIU initialization strings are 
correct; these strings are sent to modems when using the DKAdmin/DKBackup Dial DK 
option:

♦ Direct Modem Initialization: AT; sent to modem connected directly to DKAdmin/
DKBackup PC COM port or modem installed in DKAdmin/DKBackup PC.

Note If using a fax/modem, you may have to enter &Q6 to the modem initialization string.

♦ Modem/DIU Initialization: ATS0=1 S2=43 E0 Q0 &C1 &D2 V1 &W0 8Y0; sent to 
modem connected to a PDIU-DS modem pool.

8. Press Esc to close the screen.

System Utilities

ReIndex Files

➤ To reindex files

1. From the Options Menu, type u. A pop-up box displays.

2. Press Enter to select ReIndex Files and the files are automatically reindexed.

3. Press Esc to return to the Options Menu.
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Connecting to Strata DK A

This appendix shows how to connect a DKAdmin/DKBackup PC to the Strata DK.

Hardware Requirements
The DKAdmin/DKBackup PC is required to edit or change a Strata DK customer database file 
with or without being connected to a Strata DK telephone system. A PC equipped with 
DKAdmin/DKBackup enables you to upload, download, upgrade and/or edit complete Strata 
DK databases. 

Note DKBackup does not provide the edit function.

The hardware requirements described below are necessary to exchange (send/receive) data 
between the DKAdmin/DKBackup PC and a Strata DK telephone system. Exchanging data 
enables the PC to pull customer configuration data from an operating Strata DK and save this 
data, and then send the data to the Strata DK (see Figures 16 to 22 for possible connecting 
configurations).

♦ The DKAdmin/DKBackup PC must be equipped with an available COM port to enable 
the PC to connect and exchange (send/receive) data with a Strata DK.

♦ The Strata DK must be equipped with an RSSU, PIOUS, PIOU, or RSIU/RSIS PCB for 
local and/or remote Administration.

♦ When DKAdmin/DKBackup must interface with a Strata DK remotely (more than 50 feet 
apart):

♦ The Strata DK PIOU, PIOUS, or RSIU must be equipped with an IMDU or RMDS 
built-in modem; or, the Strata DK RSSU, PIOUS, PIOU, RSIU/RSIS TTY port must 
be connected to an external modem or PDIU-DS data interface unit.

♦ The DKAdmin/DKBackup PC COM port must be connected to a modem or PDIU-DI 
data interface unit or have a built-in modem.

System Connection Configurations
Figures 16 to 22 show possible ways to connect the DKAdmin/DKBackup PC to the Strata 
DK. They provide installation guidelines and instructions for setting up and using the 
DKAdmin/DKBackup built-in auto dialer to call Strata DKs remotely or locally. These figures 
include the following configurations:
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♦ DKAdmin/DKBackup PC directly connected to the Strata DK – 50 feet maximum (se
Figure 16 on Page 130).

♦ DKAdmin/DKBackup PC connected to Strata DK via Toshiba Data Interface Units – 1
feet maximum (see Figure 17 on Page 131).

♦ DKAdmin/DKBackup PC remote modem connected to Strata DK system external 
modem/TTY port (direct modem to modem call)(see Figure 18 on Page 132).

♦ DKAdmin/DKBackup PC remote modem connected to Strata DK system built-in IMD
RMDS (or external modem) – voice call first, then modem to modem connection (se
Figure 19 on Page 133).

♦ DKAdmin/DKBackup PC remote modem connected to Strata DK modem pool – then
dial modem pool DIU to Strata DK DIU/TTY port (see Figure 20 on Page 135).

♦ DKAdmin/DKBackup PC DIU/DIU modem pool connected to Strata DK system mod
– voice call first, then modem to modem connection (see Figure 21 on Page 137).

♦ DKAdmin/DKBackup PC DIU/DIU modem pool connected to Strata DK system mod
– DIU to DIU connection, then modem to modem connection (see Figure 22 on Page 139).

PIOU/PIOUS/RSSU/RSIU Setup

➤ To check the DKAdmin/DKBackup communications setup

1. From the Options/System Installation/Communication Setup menu, verify that the pr
COM port is selected and that the communications parameters are set as follows:

2. PIOU or PIOUS PCB installed on Strata DK which is connected to DKAdmin/DKBac
PC: if using an IMDU, verify that the switch SW2 is set for 1200 bps (LED CD4 off) a
that SW3 is set to “MODEM.”

If connecting an external modem, PDIU-DS, or PC COM port directly to the TTY 
modular jack, verify SW2 is set to the “TTY” position.

3. RSSU does not support the IMDU built-in modem or SMDR, and it has no option 
switches. Its communication parameters (TTY port) are always 1200 bps, even parit
data bits, 1-stop bit.

4. Use Program 03 to identify the PCB slot that contains the PCB with the TTY port or 
modem that will be used (Code 41 for PIOU, PIOUS, or RSSU or Code 49 for RSIU)

5. Use Program 76 if RSIU/RSIS/RMDS is used to connect with the DKAdmin/DKBack
PC.

6. Use Program 77-1 (LED 14 and 15) if IMDU or RMDS is used to connect to the 
DKAdmin/DKBackup PC.

Communications port: COMX (X = 1, 2, 3 or 4)

Baud rate: 1200 (If using RSIU TTY port or RMDS, 
the Baud rate can be higher than 1200 bps.)

Parity: Even

Data bits: 7

Stop bits: 1
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Calling Strata DK Using the Dialer
The DK Dialer is used only to establish a modem-modem or DIU to DIU/modem connection 
between the DKAdmin/DKBackup PC and the DK maintenance modem. The DK Dialer is not 
used when connecting the DKAdmin/DKBackup PC directly to the Strata DK TTY port.

➤ To call Strata DK using the dialer

1. From the File Menu, type d to select the Dial DK option and the Customer List screen 
displays.

2. Highlight the Customer Strata DK you wish to dial.

Note It is not necessary to use the Select Customer option, when using the Dial DK option.

3. To set up DIU, modem, or “after connect” dialing strings for the selected customer, p
Enter. If the dialing strings were set previously, go to next step.

4. Press F2 to connect DIU to DIU (see Figure 17 on Page 131), press F4 or F5 to connect 
modem to modem (see Figure 18 on Page 132), or Press F4 to connect modem to modem
pool and then dial the PDIU-DS connected to the TTY port (see Figure 20 on Page 135), 
or press F3 to connect DIU to modem pool and then dial customer Strata DK (see Figure 
22 on Page 139).

5. When Function keys F2 ~ F5 are pressed after selecting a customer from the Dial DK
Option, DKAdmin/DKBackup sends the following with each of the Function Keys. On
one Function Key should be used to connect with the DK maintenance modem.

♦ Pressing F2 sends the Communication Setup DIU Initialization String and the 
Customer DIU String.

♦ Pressing F3 sends the Communication Setup DIU Initialization String, the Custom
DIU String, the Communication Setup Modem Initialization String, the Customer
Modem String, and, if a connection is established, the After Connect String.

♦ Pressing F4 sends the Communication Setup Modem Initialization String, the 
Customer Modem String, and, if a connection is established, the After Connect S

♦ Pressing F5 sends the customer Modem String, and, if a connection is established
After Connect String.

Notes

● The DK security code can be set on the After Connect line in each Customer File se
it will be sent automatically to the Strata DK after connecting the DKAdmin/DKBacku
PC to the Strata DK remotely via modems. Setting the DK security code in the After
Connect String is optional.

● In some cases, when connecting to older Release 1 processors or during heavy traf
conditions, the After Connect string may be sent and not recognized by the Strata D
this should occur, do not enter the DK security code in the After Connect string.

● After completing a DKAdmin/DKBackup session via modems or DIUs, always use th
Hangup Connection option in the File Menu to drop the connection. Once the option
activated, DKAdmin/DKBackup sends the modem escape sequence +++ and then the 
reset and hangup commands ATZ H, closing the communication link to the DK. Make 
sure the modem escape sequence is set to +++ (modem register, S2=43) before using the 
DKAdmin/DKBackup PC with modems or DIUs.
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Direct Connection to Strata DK

Important! DK Dialer Setup is not required for direct connection. Connection is always 
established; select customer and proceed with Administration or Backup.

PC COM Port

PPTC-9 (PC 9-pin Adaptor)
or PPTC-25F

DK Backup/Admin
Personal Computer

TTY
Port

RSSU, RSIU,
TSIU, WSIU
or RSIS

PIOU, PIOUS
(SW3 – TTY Position)

3-pair Modular Cord
(Telephone type, cross-pinned)

(50 Feet Maximum, 24AWG wire)

Customer Strata DK

Program 03 Code 41 for RSSU, 
PIOUS, or PIOU slot.
Program 03, Code 49 for RSIU
slot 11.

Program 76 for RSIU, RSIS, TSIU or 
WSIU TTY port setup

0918

Figure 16 DKAdmin/DKBackup PC Directly Connected to Strata DK—50 ft. Maximum
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Connection to Strata DK Via Toshiba 
Data Interface Units

Customer Dialer Setup
♦ DIU String: ATS2=43~~~ATDDYYY

(YYY is the intercom or directory number of the PDIU-DS connected to the TTY port)

Note ~~~ must be entered to send the carriage return signal following ATS2=43.

♦ Modem String: (nothing)

♦ After Connect String: (nothing)

To Make Connection
1. From File Menu, select Dial DK and press Enter

2. Highlight the customer form the customer list (scroll with arrow key or type initials)

3. Press F2 to establish the DIU to DIU connection. (The DIU string will be sent from the 
DKAdmin/DKBackup COM port.)

4. After connection is established, select desired function from the DKAdmin/DKBackup 
Main Menu.

5. After the DKAdmin/DKBackup session is complete, go to the File Menu and press h to 
hang up the connection.

PC COM Port

PC to Modem Type
Cable (Dealer Supplied)

Digital
Telephone with
PDIU-DI
or RPCI-DI
(integrated)

DK Backup/Admin 
Personal Computer

(2-pair - 1000 feet maximum, 24 AWG wire)

Station
DK Prog 20;
LED 01, 02, and 17 
ON for PDIU-DI
or RPCI-DI Port

(SW1-4 Off)

(SW1-4 
Off)

(SW3 – TTY Position)

PDKU

PDKU

PDIU-DS (YYY)
PPTC25MDM

TTY
Port

6-pair Modular Cord

Customer Strata DK

DK Prog. 20: LED 01, 
04 and 17 ON for PDIU-DS Port

1. Program 03 Code 41 for RSSU, PIOU, PIOU(S) slot.
Program 03, Code 49 for RSIU Slot 11. 
Program 76-1, 76-2 for RSIU, RSIS, TSIU, or WSIU TTY Port setup.

2. Program 03 Code 62 or 64 for PDKU slot.

3. PDIU-DS Jumper plugs (P1-P9) must be set to the B-C position when 
connected to the TTY port.

***

3093

(yellow)

(Telephone type,
 cross-pinned)

Notes

2

2

RSSU, RSIU, TSIU,
WSIU or RSIS1

PIOU, PIOUS 1

Figure 17 DKAdmin/DKBackup PC Connected to Strata DK Via Toshiba Data Interface Units—1000 ft. 
Maximum
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Remote Modem Connection to External 
Modem/TTY Port

Communication Setup
(See Communication Setup in Chapter 8 – Options Menu.)

♦ Use default values for direct modem init. If using a fax/modem, you may have to inc
&Q6 or &K0 into the modem initialization string to turn off data compression.

Customer Dialer Setup
♦ DIU string: (nothing)

♦ Modem string: ATDTX...X
(X...X is the telephone number of CO line that rings the external modem).

♦ After connect string: DK Security Code (optional)

To Make Connection
1. From the File Menu select the Dial DK and press Enter.

2. Highlight customer.

3. Press F4; DKAdmin/DKBackup causes remote modem to go off-hook and dial the 
external modem. (The Modem Initialization String and the Modem String will be sent
from the DKAdmin/DKBackup COM port.)

Note You may press F5 in this step to send the customer modem string only and not the
modem initialization string.

4. After remote modem and external modem establish communications (handshake), 
DKAdmin/DKBackup will flash back to the DK Dial Option. At this point you may 
proceed with DKAdmin/DKBackup.

TTY
Port

Remote
Modem

PC COM Port

Standard PC/
Modem Cable

External
Modem

CO Line or RSTU Port

CO Line

DK Backup/Admin 
Personal Computer

Public
Telephone
Network

RSSU,RSIU, RSIS,
TSIU, or WISU

PIOU, PIOUS
(SW3 – TTY Position)

3 Pair Modular Cord
(Telephone type, cross-pinned)

Customer Strata DK

PPTC25MDM
(yellow)

External modem must have the following AT
commands set:
(S0=1, B1,E0,L2,M1,Q1,V1,X4,Y0,&C1,&D2,&G0)
Turn off data compression.

External Modem or 
Built-in to PC Modem

0920

(assigned to ring modem)

Turn off data compression.

Figure 18 DKAdmin/DKBackup PC Remote Modem Connected to Strata DK External Modem/TTY Port 
(Direct Modem to Modem Call)
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lude 
5. After the DKAdmin/DKBackup session is complete, go to the File Menu and press h to 
hang up the connection.

Voice Call Transferred to Modem Connection
(Strata DK IMDU, RMDS, or External Modem)

Communication Setup
(See Communication Setup in Chapter 8 – Options Menu.)

♦ Use default values for direct modem init. If using a fax/modem, you may have to inc
&Q6 or &K0 into the modem initialization string to turn off data compression.

♦ Direct modem initialization should be: Default.

Customer Dialer Setup
♦ DIU string: (nothing)

♦ Modem string: ATX3 D

Note For some 14.4 or 28.8 fax modems, you may have to enter AT&Q6X3 D.

♦ After connect string: DK Security Code (optional)

RCOU

PDKU
Port

Remote
Modem 1

CO Line

PC to Modem Type
Cable (Dealer Supplied)

CO Line

Line

DK Backup/Admin 
Personal Computer

Public
Telephone
Network

PIOU / PIOUS
IMDU Modem
SW3, or RSIU
/RMDS modem 2

Customer Strata DK

Standard
Telephone

Voice Path
Data Path

Digital
Telephone

External Modem 2

RS-232

PPTC25MDM
(yellow)

TTY
3-Pair Modular

RSTU

Notes 1. External or Built-in to PC. Turn off data compression.

2. Either IMDU, RMDS, or External modem can be used to connect remotely. If IMDU 
is used, put SW3 in the Modem position; if an External modem is used, put SW3 in 
the TTY position. Refer to Progams 76 and 77-1 to setup RMDS modem.

0921

(Telephone type, cross-pinned)

External modem must have the following AT
commands set:
(S0=1, B1,E0,L2,M1,Q1,V1,X4,Y0,&C1,&D2, &G0)
Turn off data compression.

Figure 19 DKAdmin/DKBackup PC Modem Connected to Strata DK System Built-in IMDU, RMDS (or 
External Modem) Voice Call First, then Modem to Modem Connection
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To Make Connection
1. From File Menu, type d.

2. Highlight the customer from the customer list.

3. At the remote site, use the standard telephone (connected to the DKAdmin/DKBackup 
remote modem) to call a telephone (or attendant console) at the customer site.

4. When the call is answered, request that the call be transferred to the IMDU or RMDS by 
dialing Cnf/Trn + # 1 9; or, if using an external modem connected to the TTY port, by 
dialing Cnf/Trn + the external modem (RSTU) station number.

Important! The transferring party must hang up after transferring to the modem.

5. After the call is transferred and you hear modem tone from the IMDU, RMDS, or external 
modem, press F5, hang up the standard telephone when the DKAdmin/DKBackup PC 
modem goes off-hook. (The Modem String will be sent from the DKAdmin/DKBackup 
COM port.) The modems will handshake and connect, the After Connect String is sent to 
the Strata DK (if programmed).

Note If you press F4 in this step, DKAdmin/DKBackup will send the Modem Initialization 
String (from the Communications Setup Option) and then the Modem String (from the 
Customer File). If using a 28.8 fax/modem with you DKAdmin/DKBackup PC, it may 
be necessary to include &Q6 or &K0 in the Modem Initialization String to turn off data 
compression.

6. After the connection is established, select the desired function from the Administration 
Menu/Backup Menu and proceed.

7. After the DKAdmin/DKBackup session is completed, go to the File Menu and press h to 
hang up the connection. The DKAdmin/DKBackup PC sends +++ ATZ H to the 
DKAdmin/DKBackup PC modem, closing the communication link to the DK.

Important!

● When connected to an IMDU or RMDS modem, the Strata DK will drop the connection if 
an incorrect DK maintenance security code is entered during a DKAdmin/DKBackup 
backup session.

● You may put the DK maintenance security code on the After Connect line in the Customer 
File setup. DKAdmin/DKBackup sends the DK security code automatically after the 
modem in the Strata DK and the DKAdmin/DKBackup modem establish connection. The 
data set in After Connect is sent after modem connection is established whenever F3, F4, 
or F5 is used.

● If the DKAdmin/DKBackup PC/modem connects to the Strata DK modem but then 
DKAdmin/DKBackup closes the COM port immediately, perform the following steps and 
try again:

● Make sure DKAdmin/DKBackup modem baud rate is the same as the Strata DK 
modem baud rate.

● Run the ReIndex Files option from the DKAdmin/DKBackup Options/System Utilities 
Submenu.

● Remove the DK security code from the After Connect String.
134 DKAdmin/DKBackup



––––––––––––––––––––––––––––––––––––––––––––––––––––––––– Remote Modem Connection to Modem Pool
Remote Modem Connection to Modem Pool

Communication Setup
♦ DIU initialization string: use default values. Use default values for direct modem init. If 

using a fax/modem, you may have to include &Q6 or &K0 into the modem initialization 
string to turn off data compression.

♦ Direct modem init should be: default

Customer Dialer Setup
♦ DIU string: (nothing)

♦ Modem string: ATDTXXXXXX.
(XXXXXX is the external modem CO line number)

♦ After connect string: AT~~~ATDDYYY~~~
(YYY is the intercom number of the PDIU-DS connected to the TTY Port. (~~~ must be 
used to send carriage return signals.) The DKAdmin/DKBackup dialer sends this string to 
connect the PDIU-DS (XXX) to PDIU-D (YYY) when it detects (connect 1200) that the 
remote modem has connected to the external modem.

PDKU

PDKU

PDIU-DS (YYY)
PPTC25MDM

External
Modem Pool

Remote
Modem 1

CO Line

Standard PC / Modem
Cable

DK Backup/Admin 
Personal Computer

Public
Telephone
Network

PDIU-DS (XXX)

TTY
Port

RSSU, RSIU,TSIU,
WSIU or RSIS2 

CO LINE

3-pair Modular Cord

Customer Strata DK

See Figure A-7 for PDIU-DS 
modem pool configuration

(SW3 – TTY Position)
3

4

Notes 1. External or Built-in to PC.

2. Program 03 Code 41 for RSSU, PIOU, PIOU(S) slot.
Program 03, Code 49 for RSIU Slot 11. 
Program 76-1, 76-2 for RSIU, RSIS, TSIU, or WISU TTY Port setup.

3. Program 03 Code 62 or 64 for PDKU slot.

4. PDIU-DS Jumper plugs (P1-P9) must be set to the B-C position when connected to the TTY port.

0922

Turn off data compression.

PIOU, PIOUS2

(Telephone type, cross-pinned)

(yellow)

External modem must have the following AT
commands set:
(ATS0 = 1, ATB1_E0_L2_M1_Q1_V1_X4_Y0_&C1_&D2_&G0)
Turn off data compression.

Figure 20 DKAdmin/DKBackup PC Remote Modem Connected to Strata DK Modem Pool – Then Auto 
Dial Modem Pool DIU to Strata DK DIU/TTY Port.
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-DS 
To Make Connection
1. From the File Menu select Dial DK and press Enter.

2. Highlight the customer form the customer list.

3. Press F4 to establish remote modem to external modem connection; the Modem 
Initialization String, the Modem String, and the After Connect String will be sent from the 
DKAdmin/DKBackup PC COM port.

(After the modems connect, the “After connect” string will be sent out to cause PDIU
(XXX) to connect to PDIU-DS (YYY). DKAdmin/DKBackup goes back to the File 
Menu.)

4. Complete the DKAdmin/DKBackup administration functions.

5. After the DKAdmin/DKBackup session is completed, go to the File Menu and press h to 
hang up the connection.
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––––––––––––––––––––––––––––––––––––––––––––– PC DIU/DIU Modem Pool Connection to Strata DK Modem
PC DIU/DIU Modem Pool Connection to Strata DK 
Modem

Voice Call First, then Modem to Modem Connection

Communication Setup
♦ Use default values.

Customer Dialer Setup
♦ DIU string: (nothing)

♦ Modem string: ATD#42

♦ After connect string: (nothing)

Remote
Modem Pool

RS-232
Cable

COM
Port

CO Lines

Public
Telephone
Network

Customer Strata DKRemote Strata DK

See Figure A-8 for PDIU-DS/ 
Modem Pool Configuration 
Program 21 Assignment

Attendant
Digital
Telephone

PDKU

PDIU-DS

RS232

RCOU

RSTU

RCOU

RSTU

Voice Path
Data Path

• SW1-4 Off
• Prog 20: LED 01, 

02 and 17 ON for 
PDIU-DI Port

PIOU or 
PIOUS with 
IMDU Modem
SW3 Modem 
Position or 
RSIU with 
RMDS

1

DK Backup/Admin 
Personal Computer

Remote Digital 
Telephone with PDIU-
D2 or RPCI-DI

0923

2

Notes
1. Program 03 Code 62 or 64 for PDKU slot.
2. Program 39 The remote digital telephone must be equipped with 

the Data, Data Release, and Modem buttons.

Figure 21 DKAdmin/DKBackup PC DIU/DIU Modem Pool Connected to Strata DK Modem – Voice Call 
First, Then Modem to Modem Connection.
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To Make Connection
1. Select Customer from the Dial DK Option.

2. Call attendant at customer Strata DK from remote digital telephone (voice call using 
telephone handset).

3. From the remote digital telephone, press the Modem button to reserve the remote modem. 
The Modem button LED flashes.

4. When attendant answers, request to be transferred to the IMDU or RMDS (attendant must 
press Conf + # 1 9) and ask attendant to hang up.

5. When you hear IMDU or RMDS modem tone, press the Data button on the remote digital 
telephone and then press F5 (voice/modem) on the DKAdmin/DKBackup PC keyboard. 
The call is picked up by to the RSTU remote modem, disconnecting the voice path, and 
establishing the data path between the Strata DK modem, the PDIU-DS modem and the 
remote digital telephone PDIU/RPCI. The Data and Modem button LEDs are red steady.

6. After the IMDU or RMDS and remote modem communicate (handshake), proceed with 
DKAdmin/DKBackup.

7. After the DKAdmin/DKBackup session is complete, go to the File Menu and press h to 
hang up the connection.
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PC DIU/DIU Modem Pool Connection to Strata DK 
Modem

DIU to DIU Connection, then Modem to Modem Connection

Communication Setup
♦ Use default values.

Customer Dialer Setup
♦ DIU string: ATS2=43~~~ATDDXXX

(where XXX is the intercom or directory number of the PDIU-DS modem pool)

♦ Modem string: ATDTY...Y
(where Y...Y is the CO line access code plus the telephone number of the CO line that will 
ring the IMDU or RMDS modem)

♦ After connect string: DK security code (optional)

Remote
Modem

RS-232
Cable

COM
Port

CO Lines

DK Backup/Admin 
Personal Computer

Public
Telephone
Network

Customer Strata DKRemote Strata DK

2-pair
(1000 ft
maximum)

See Figure A-8 for 
PDIU-DS / Modem 
Pool Configuration

Digital
Telephone
with PDIU-D2
or RPCI-DI

PDKU

Directory
Number XXX
or Intercom
Number XXX

PDIU-DS

RS232

RCOU

RSTU

RCOU

• SW1-4 Off
• Prog 20: LED 01, 

02 and 17 ON for 
PDIU-DI, RPCI-DI 
Port

PIOU or 
PIOUS with 
IMDU Modem
SW3 Modem 
Position or 
RSIU with 
RMDS

*

*

Program code 62 or 64 in 
Program 03 for PDKU PCBs 
that support PDIUS.

Program 03 Code 41 
for PIOU or PIOUS.

Program 03 Code 49 
for RSIU with RMDS

Program 76 with 77-1 
for RSIU with RMDS 
setup

0924

Figure 22 DKAdmin/DKBackup PC DIU/DIU Modem Pool Connected to Strata DK Modem – DIU to 
DIU Connection, then Modem to Modem Connection.
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PC DIU/DIU Modem Pool Connection to Strata DK Modem ––––––––––––––––––––––––––––––––––––––––––––––
To Make Connection
1. Highlight Customer from the Dial DK Option and press Enter.

2. Highlight the appropriate customer, then press F3; the digital telephone DIU will connect 
to the remote modem PDIU-DS and then the remote modem will go off hook and seize a 
CO line and dial the CO line which rings the IMDU (normal ringing assignments in Strata 
DK Programs 81~89).

Pressing F3 causes the DIU Initialization String, the DIU String, the Modem Initialization 
String, and the Modem String to be sent from the DKAdmin/DKBackup PC COM port in 
the order described here.

3. After the IMDU or RMDS and remote modem communicate (handshake), proceed with 
DKAdmin/DKBackup.

4. After the DKAdmin/DKBackup session is completed, go to the File Menu and press h to 
hang up the connection.
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PDIU-DS Modem Pool Installation

To Make Connection
When connecting a PDIU-DS to a modem for modem pool operation (see Figures 20 to 22), 
set up the PDIU-DS and modem per Steps 1 ~ 7 below.

1. PDIU-DS P1 through P9 jumper connections/option switch settings:

a. Remove PDIU-DS cover.

b. Install all PDIU-DS jumper-plugs except P3 and P4 across B-C.

c. Remove jumper plugs from P3 and P4.

d. Solder on or wire wrap W6 and W8 jumper wires as shown (W6 and W8 are dealer-
supplied)

e. PDIU-DS SW1 option switch settings:

♦ SW1-2 and SW1-4 should be on (down).

♦ W1-1 and SW1-3 should be off (up).

Figure 23 External Modem to Strata DK TTY Port Connection

PDIU-DS
PCB

DTE/MODEM
JUMPER PLUGS
P1~P9

SW1

SIDE GROOVES

BOTTOM
PANEL

EX.
POWER

W2

W1PERCEPTIONW3

A B C
P5

P1

P2

P7

P4
W6

W8
P3

P6

P8

P9

0925DK
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2. PDIU-DS port Program 20 options:

LED 01, 02, 04, and 17 on; all other LEDs off for PDIU-DS port if connecting the modem 
to a CO line; if connecting the modem to an RSTU port, turn on LED 01, 02, 03, 04, and 
17 for the PDIU-DS port.

Notes

● LED 02 must be turned off until the AT commands shown in 3 below have been set on the 
modem connected to the PDIU-DS. After the listed AT commands are sent to the modem, 
LED 02 in program should be turned on for the PDIU-DS port.

● Only turn LED 03 on if the telephone/PDIU-DI modem pool key (Program 39-code 455) 
is required. Otherwise turn LED 03 off. If LED 03 is OFF, the PDIU-DS READY LED 
will indicate the modem carrier detect status; and, the PDIU-DS will beep when a PDIU-
DI connects to it. If LED 03 is ON, the telephone modem key will indicate modem pool 
status but the PDIU-DS READY LED will always be off and the PDIU-DS will not beep 
when a PDIU-DS connects to it.

3. The following AT command line must be sent to the modem (sent via DK Dialer Modem/
DIU initialization string):

ATS0=1 S2=43 E0 Q0 &C1 &D2 V1 &W0 &Y0 <CR> (See Note 1 above.)

4. If connecting the modem to an RSTU port, use Program 21 to assign the PDIU-DS port to 
the RSTU port. Use Program 39 to assign DATA, DATA RELEASE, and MODEM keys to 
digital telephones that use the modem pool.

5. Connect the modem “line” to a CO line or RSTU port.

6. Connect the PDIU-DS modular jack to the PDKU port assigned in Program 20.

7. Connect the modem RS-232 connector to the PDIU-DS RS-232 connector with a st
DB-25 to DB-25 (male to male) cable.

Important! Make sure all PDKU PCBs slots that support PDIU-DS or PDIU-DI are 
programmed with Code 62 or 64 in Program 03.

External Maintenance Modem Installation
See Figures 18 and 19, as applicable, and install the external modem in accordance with t
following steps:

Note The Toshiba PPTC RS-232 modular-to-DB25 adapter is factory configured for AS
terminal connection. Pins 2 and 3, and Pins 8 and 20 of the adapter must be rev
on the DB25 end for external modem connection (see wiring diagram below).

1. Connect the modular cord from the RSSU, PIOU or PIOUS TTY port to the PPTC ad
and then to the external maintenance modem RS-232 25-pin connector.

2. Connect the external maintenance modem line-side to a dedicated CO line, tip and 
(see Figure 18 on Page 132) or to a dedicated standard telephone port, tip and ring (se
Figure 19 on Page 133). Refer to Chapter 8 – DK16e/DK424 Universal Slot PCB Wirin
in the Strata DK Installation and Maintenance Manual for wiring/interconnecting details.

3. Set the PIOU or PIOUS SW2 switch to match the modem or terminal baud rate:

♦ Push in for 300 bps (baud rate indicator CD4 is lit); let out (by pushing again) for 1
bps (CD4 is not lit), RSSU is always 1200 bps. Use 1200 bps with DKAdmin/
DKBackup.
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4. Set the PIOU or PIOUS SW3 switch to the TTY position (RSSU is always TTY, SW3 is 
not required).

Note The PIOU or PIOUS SW3 switch is set to the MODEM position for IMDU operation 
only.

5. Set the P13 jumper plug on the PIOU to the BELL configuration, or cut the W4 jumper on 
the PIOUS (also for BELL configuration).

Note The P13 (PIOU) and W4 (PIOUS) CCITT configurations are not normally used in the 
USA.

6. Use Program 03, Code 41 for PIOU, PIOUS, or RSSU TTY port; or, Code 49 for RSIU/
RSIS, Slot 11. If using RISU or RSIS, set the appropriate TTY port and TTY port baud 
rate using Program 76.

7. Set the communication parameters of DKAdmin/DKBackup to: 1200, 2400, or 9600 BPS, 
7 data bit, even parity, and one stop-bit. This is done from the DKAdmin/DKBackup 
Options/System Installation/Communication Setup Option.

8. Use the DKAdmin/DKBackup “Dial DK” function to call the External modem from the
DKAdmin/DKBackup PC as follows:

♦ If the External modem is connected to a dedicated CO line, call the CO line numb
establish modem communication (see Figure 18 on Page 132).

♦ If the External modem is connected to a standard telephone port, call a Strata D
line that can be transferred to (or programmed to ring) the standard telephone m
port to establish modem communication. It is also possible to establish 
communications by calling in on a Strata DK DISA DID, or Auto Attendant, CO li
and dialing the intercom number of the modem connected to the standard teleph
port (see Figure 19 on Page 133).
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PPCT (Modular to DB25) Adaptor, Modified Wiring for Connecting TTY Jack to 
an External Modem (only if null-modem adaptor is not used with PPTC):

PIOU/PIOUS, TTY Jack
Modular Pin Number

1      to      RD

2      to      TD

3      to      DSR

4      to      DTR

5      to      DCD

6      to      SG

RD,

TD,

DSR,

DTR,

DCD,

SG,

6 to

5 to

4 to

3 to

2 to

1 to

2*

3*

6

8*

20*

7

4 Jumper to 5

TD

RD

DSR

DCD

DTR

SG

RTS to CTS

Modular Pin No.

PPTC1A-5M Adaptor

DB25 Pin No.

Modem
RS-232

Lead Name

0926

Important! *PPTC1A-5M, pins 2 & 3 and pins 8 & 20 must be reversed in the field, as 
shown, for modem connection. Set Hayes modem to track status of carrier 
detect signal (AT and C1) and to answer (ATS0 = 1).

Figure 24 External Modem to Strata DK TTY Port Connection
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DK424 RCTUE/F
Upgrade Using DKAdmin B

This appendix discusses considerations and steps for upgrading the Strata DK424 digital 
business telephone system to an RCTUE/F processor.

DKAdmin software is required to upgrade a DK14, DK16e, DK40 or any DK280/DK424 
RCTUA, RCTUB, RCTUBA/BB, or RCTUC/D database to an RCTUE/F processor. 
DKAdmin requires the red 280Admin software protection key installed on the PC LPT1 
printer port. This is the same red key used for running 280Admin.

For best results DKAdmin must be installed on a PC with a Pentium processor with 16MB of 
RAM. 

➤ To install DKAdmin

➤ See Chapter 2 – Installing DKAdmin for step-by-step instructions.

➤ To run DKAdmin

➤ At the DOS prompt or Windows Run command screen, change to the 280Admin pat
type: dkadmin and press Enter to run the program.

Upgrading to RCTUE/F
The upgrade can be completed on- or off-site. Before upgrading, use DKAdmin to creat
new customer file and download the existing RCTU database. This customer file can be
as a back-up for your existing RCTU processor and should not be used in the upgrade p

Off-site Upgrade
If you have a Strata DK280 or DK424 at your dealer office, you can save time and trave
downloading an existing database from the customer to your site via modem. Once initia
and upgraded you can then deliver and install the upgraded PCB at the customer site.

➤ To do an off-site upgrade

1. From the File Menu, type m to select the Maintain Customer File function.

2. Create a new customer database by selecting the existing DK16e or RCTU (A, B, BA
or C/D) and Release (Release 1/Release 2 or Release 3 version).

3. From the File Menu, type s to select the Select Customer function.

4. Highlight the new customer and press Enter.
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5. Using the Backup/Restore Data function on the Administration Menu, download the 
complete customer database via modem or disk by pressing F2 then F3.

After the customer database is downloaded and built, it can be upgraded to the RCTUE/F 
processor.

6. Install the RCTUE/F processor into the DK280 or DK424 base cabinet (see the Strata 
I&M Manual for more details). Remove the MBJU (DK424 Base only).

7. From the programming telephone, run Program 91-9 twice to initialize the RCTUE/F 
processor. 

8. From the programming telephone run Programs 03, 76, and 77-1 to set up the TTY 
interface port.

9. Turn the system power off for five seconds then turn the power back on.

10. Connect the DKAdmin PC to the system TTY interface port; check communication 
between the DKAdmin program and RCTUE/F processor is operating properly.

11. Using DKAdmin, select the customer database created in Step 2.

12. Check the PCB code for the TTY PCB (PIOU, RSIU, etc.) is set properly in Program 03.

13. From the Administration Menu, select the Back/Restore Data function and press Enter. 
Press F5 to select Upgrade.

14. Follow the upgrade steps in DKAdmin; select the RCTUE/F processor. Answer No to 
“Backup From DK First?” and No to “Pull Program 03?”.

15. After DKAdmin upgrades and uploads the customer database, it prompts you to “Pe
Automatic Power OFF/ON”; answer Yes. DKAdmin runs Program 91-2, then prompts 
you to receive data to complete the upgrade process; answer Yes. DKAdmin downloads 
the upgraded RCTUE/F database and builds the customer file.

16. The upgrade is now complete. Install the upgraded RCTUE/F at your customer site.

On-Site Upgrade
 If upgrading on-site, the DKAdmin upgrade process pulls the current existing customer 
database.

➤ To do an on-site upgrade

1. Connect the DKAdmin PC to the system TTY interface port; check that DKAdmin is 
communicating with the existing RCTU processor.

2. From the File Menu, type m to select the Maintain Customer File function.

3. Create a new customer database by selecting the existing DK16e or RCTU (A, B, BA
or C/D) and Release (Release 1/Release 2 or Release 3 version).

4. Select the new customer created in Step 3

5. From the Administration Menu, select the Back/Restore Data function and press Enter. 
Press F5 to select Upgrade.

6. Follow the upgrade steps in DKAdmin; select the RCTUE/F processor. Answer Yes to 
“Backup From DK First?” and Yes to “Pull Program 03?”. DKAdmin downloads the 
database from the existing RCTU processor. 

7. After DKAdmin downloads the database from the existing RCTU processor, DKAdm
prompts you to change the processors etc. (i.e., turn power off, remove the existing 
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processor, remove the MBJU from DK424 Base Cabinet per Chapter 5 – DK424 
Installation in the Strata I/M Manual, and install the RCTUE/F processor).

8. From the programming telephone run Program 91-9 (twice) to initialize the RCTU E
processor. 

9. From the programming telephone run Programs 03, 76, and 77-1 to set up the TTY 
interface port.

10. Turn system power off for five seconds then turn power back on.

11. Continue the upgrade by following the DKAdmin prompts.

12. After DKAdmin upgrades and uploads the customer database, it prompts you to “Pe
Automatic Power OFF/ON”; answer Yes. DKAdmin runs Program 91-2, then prompts 
you to receive data to complete the upgrade process; answer Yes. DKAdmin downloads 
the upgraded RCTUE/F database and builds the customer file.

The upgrade is now complete.

Important Things to Do After Upgrading to an RCTUE/F 
Processor

♦ Using DKAdmin, run Program *03 to identify DK424 cabinets.

♦ If installing line and/or station PCBs in slots 07 and 08 of a DK424 expansion cabine
circuit line and port numbers in slots that follow will shift. It is recommended you mo
the appropriate station and line cables back to the new installed PCBs. This insures
telephone and line programs match the physical ports and lines.

♦ Do not try to swap or relocate ports in Program 01 or 02 to match port programming
physical connections.

♦ When using an RCTUE/F processor in a DK424 Base Cabinet, you must remove the
MBJU from between the R11 and RCTU slot of the DK424 Base Cabinet.

♦ In the above configuration, only DK424 Expansion Cabinets provide eight universal 
slots (S_1 to S_8). DK280 Expansion Cabinets only provide six universal slots (S_1
S_6) in this or any other configuration of RCTU processor and Base Cabinet (see th
Strata I&M Manual for more configuration details).

♦ ACD overflow assignment codes in Programs 14-4, 14-5, and 14-6 have been upgra
the new codes in the RCTUE/F.

♦ Station speed dial codes *10-*49 have been upgraded to the new RCTUE/F codes *
*139, respectively, in REPALL and Programs 29, *29, 39, and 59.

♦ ACD and IMDU/RMDS port numbers have been upgraded to the new RCTUE/F cod
Programs *09 and 71.
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Upgrading Strata DK Systems to 
DK424 Release 4.0 C

The following important items must be considered when upgrading the DK14, DK16e, DK40, 
DK280, and DK424 Release 1~3 systems to a DK424 Release 4.0. 

A new feature in DK424 Release 4.0 is increased station capacity in systems containing Tie 
and Direct Inward Dialing (DID) lines. In Release 4.0, the station capacity of systems that 
contain Tie/DID lines increases due to Release 4.0 eliminating automatic assignment of station 
ports to DID and Tie lines. Tie and DID lines provided by RDDU, RDTU, RPTU, REMU, and 
PEMU circuit cards do not use station ports. 

This appendix provides instructions and examples of how DKAdmin/DK Backup, Release 4.0 
adjusts for station port shifting caused by Tie and/or DID lines when upgrading to DK424, 
Release 4.0 software and above. This phenomenon occurs only when upgrading to DK424 
Release 4.0 processors in systems that have station PCBs installed in higher numbered slots 
than Tie/DID line PCBs.

Table 8  shows the different DK upgrade possibilities using the Release 4.0 version of 
DKAdmin/DKBackup. For example, you can upgrade from an RCTUA, R3 to an RCTUBB, 
R4; however, you cannot upgrade an RCTUA, R3 to an RCTUD, R1/R2.

Table 8 DKAdmin or DKBackup, Release 4.0, Upgrade Configurations

Upgrade To ⁄ DK14 DK16e DK40 RCTUA RCTUB RCTUBB RCTUD RCTUF

Upgrade From‹ R1 R1 R1 R1 R3 R4 R1/R2 R3 R4 R1/R2 R3 R4 R3 R4

DK16e R1 X X X X X X X X X

DK40 R1 X X X X X X X X

RCTUA

R1 X X X X X X X X X X

R3 X X X X X X X

R4 X X X

RCTUB
R1/
R2

X X X X X X X

RCTUBB
R3 X X X X X

R4 X X

RCTUD

R1/
R2

X X X X

R3 X X X

R4 X

RCTUF R3 X

X = an upgrade is available.
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DK424 Release 4.0 Upgrade Procedure
1. Using DKAdmin or DKBackup Release 4.0, download the customer data from the 

currently installed processor. Save this “Customer” data as a backup in case you mu
install the current processor and/or processor ROM/Flash memory release level.

Note You must use DKAdmin or DKBackup Release 4.0 for this procedure. Prior relea
of these programs do not provide DK Release 4.0 Upload/Download/Upgrade 
capabilities.

2. Using DKAdmin or DKBackup, create a new customer for the upgrade.

Important! When creating the new customer, select the currently installed processor type and 
release level—not the R4.0 Release level.

3. Using DKAdmin or DKBackup, select the customer created in Step 2 (not Step 1).

4. Start the upgrade procedure, using the Upgrade (F5) function from the “Backup/Restore 
Data” menu.

5. Choose Yes when prompted to Backup From DK First.

6. After the current data is downloaded, follow the DKAdmin/DKBackup screen instruct
to change the processor and/or ROMs/flash memory and reinitialize. The procedure
changing ROMs and flash memory is provided in figures on the following pages of th
appendix.

Important! When changing the processor and ROM/flash memory for the “Upgrade to” 
processsor, you can add one RSIU to complete the upgrade at 9600 bps. 
However:

● Do not add a new station or Tie/DID line PCBs.

● Do not change the order in which the PCBs are installed in the slots.

● Be sure to reinitialize the “Upgrade to” processor twice and set the DK T
port with Programs 76 and 03.

7. Continue with the upgrade procedure as prompted by the DKAdmin or DKBackup screens 
until the process is complete.

Note An upgrade example, “DK424 Release 4.0 Upgrade Programming Example”
on Page 154, describes what changes take place in the customer data during the 
DKAdmin/DKBackup upgrade procedure to make the upgrade transparent to the end 
user.
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Upgrading Strata DK Systems to DK424 Release 4.0
1. Power down the system before removing and installing the processor card(s). Figure 25 

shows the slot placement of the processor cards. 

2. Remove only the RCTUA, RCTUBB, RCTUD, or RCTUF. 

3. Remove the MOH connection, if required.

4. Remove the RRCS DTMF PCB on the RCTU card, if equipped (see Figures 26~29).

RCTUBB,
RCTUA, 

or RCTUD

RCTUD only

To RSIU if installed

RCTUBA
or

RCTUC

Slot R11 Slot RCTU (Base Cabinet)

P3

P2

P11

P2

Heartbeat LED

1394

RCTUF

To RSIU if installed

RCTUE

Slot R11 Slot RCTU (Base Cabinet)

P3

P2

P11

P2

Heartbeat LED

1924

Figure 25 RRCU Removal and Component Placement
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Figure 26 RCTUA Printer Circuit
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Figure 29 RCTUF4 Printed Circuit Board with RMMS

CAUTION! When removing the RMMS 
from RCTUF, take off the 
RMMS slowly, rocking back 
and forth in the direction of 
the arrows in the diagram.
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5. Using a small screwdriver, carefully remove the four ROMs or flash memory (see Figure 
30). 

6. Replace with the equivalent ROMs or flash memory in the upgrade kit. Peel the labels 
(two locations) off the card.

7. Re-install the RRCS DTMF PCB, if required.

Note If there are battery straps on the PCB, make sure that they are placed in the “on
position for the processor card(s) to avoid losing your data.

8. Re-insert the processor card(s), reconnect the ribbon cables and MOH connection, i
necessary. If an RSIU card is being added, shift the card positions accordingly, add t
RSIU PCB in slot 11 and change the ribbon cable to connect the RCTU PCB(s) to th
RSIU.

Note any changes needed to accommodate the displaced card, if necessary. If this c
extensive changes, it may be better to upgrade without adding the RSIU, get the sys
working, and then adjust the card positions to add the RSIU card.

9. Turn the Strata DK system back on and follow the DKAdmin/DKBackup instruction 
screens for completing the upgrade.

(back)
Designates Front of Chip

Front Direction Marker
Silk-screened on PCB

IC Socket Mounted on
Processor's PCB

(front)

Turn Very Gently

2514

Do Not Break
IC Socket

Do Not Scratch PCB

CAUTION! Be careful not to break the IC socket 
or scratch the PCB trace.

Figure 30 ROM Removal
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DK424 Release 4.0 Upgrade Programming Example
Important! When upgrading to DK424 Release 4.0 from a lower release, it is highly 

recommended to use the DKAdmin or DKBackup Release 4.0 PC software 
program. Trying to upgrade to Release 4.0 manually from the programming 
telephone could take many hours. 

The following Release 3.0 to Release 4.0 upgrade example demonstrates some basic 
programming changes automatically performed by DKAdmin due to station port shifting. 
Station port shifting only occurs when station PCBs are in higher numbered slots than Tie and/
or DID lines.

This example does not give you every program change required, nor does it attempt to instruct 
you on how to re-program a system upgraded to Release 4.0, using the programming 
telephone. This is a simple system upgrade; an actual installed systems can be much more 
complex to upgrade.

Cabinet Station Port Counting Before/After Release 4.0 Upgrade
Figures 31 shows the DKAdmin cabinet drawing of a DK424 system with an:

♦ RCTUE3/F3 processor

♦ RSIU interface

♦ 16 Digital telephones

♦ 4 analog DID lines

Notice that the RDDU PCB increments the station ports by four ports.

Figure 31 Cabinet Drawing for RCTUE3/F3 Before Release 4 Upgrade

Figure 32 shows the same DKAdmin cabinet drawing after upgrading to an RCTUE3/F4 with 
DKAdmin. 

Notice that the telephones connected to the PDKU2 in slot 14 were on ports 012~019 but are 
now on ports 008~015, respectively. This phenomenon requires many programming changes 
to enable the DK system to operate the same as it did prior to the upgrade. DKAdmin/
DK Backup Release 4.0 is designed to make all programming changes automatically to enable 
the upgrade to be transparent to the system operation.

Figure 32 Cabinet Drawing for RCTUE3/F4 After Release 4 Upgrade

PCB Placement per Program 03

Cabinet 1 R11 RCTU S11 S12 S13 S14 S15 S16

PCB Type RCTUE3 RCTUF3 RSIU PDKU2 RDDU PDKU2

Port Nos. 000~007 008~011 012~019

Line Nos. 001~004

Option/Note

PCB Placement per Program 03

Cabinet 1 R11 RCTU S11 S12 S13 S14 S15 S16

PCB Type RCTUE3 RCTUF4 RSIU PDKU2 RDDU PDKU2

Port Nos. 000~007 008~015

Line Nos. 001~004

Option/Note
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System/Station Administration Screen Before/After Release 4.0 Upgrade
Figure 33 shows the DKAdmin System/Station Administration Screen of the same DK424 
Release 3 system shown in Figure 31. Figure 34 shows the same after upgrading to RCTUE3/
F4 with DKAdmin. 

The following table summarizes the changes in Figure 34 after the upgrade:

This type of phenomenon must occur on all DK Programs that contain port numbers to provide 
a transparent upgrade.

Before the Upgrade After the Upgrade

RDDU in Slot 13
Ports 008~011
as DL (or DID) ports

Deleted

Port Range of PDKU2 in Slot 14 Ports 012~019 Ports 008~015

Slot 14 User Names, PDNs, DID numbers, etc. Ports 012~019 Ports 008~015

Swapped Logical Ports in Slot 14 Ports 013 and 017 Ports 009 and 013
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Figure 33 System/Station Administration Screen for RCTUE3/F3 Before Release 4 Upgrade

Figure 34 System/Station Administration Screen for RCTUE3/F3 After Release 4 Upgrade

System/Station Administration

CSN 
(Cabinet 
Slot 
No.)

Phy. 
Port 
No. PT

Telephone
Location

Log 
Port 
No.

Int/ 
PDN 
No.

Telephone LCD
User Name

VM CF
Id Code

VM MW
Id Code

12 000 DT LOBBY 000 100 ATTENDANT NO:100 91100 92100

12 001 DT 001 101 NO:101 91101 92101

12 002 DT 002 102 NO:102 91102 92102

12 003 DT 003 103 NO:103 91103 92103

12 004 DT 004 104 NO:104 91104 92104

12 005 DT TELEPHONE ROOM 005 105 PHONE RM NO:105 91105 92105

12 006 DT 006 106 NO:106 91106 92106

12 007 DT KITCHEN 007 107 COOK NO:107 91107 92107

13 008 DL 008 108 NO:108 91108 92108

13 009 DL 009 109 NO:109 91109 92109

13 010 DL 010 110 NO:110 91110 92110

13 011 DL 011 111  NO:111 91111 92111

14 012 DT FRONT OFFICE 012 112 BOSS NO:112 91112 92112

14 013 DT PLAY ROOM 017 117 PLAY RMNO:117 91117 92117

14 014 DT 014 114 NO:114 91114 92114

14 015 DT 015 115 NO:115 91115 92115

14 016 DT 016 116 NO:116 91116 92116

14 017 DT 013 113 NO:113 91113 92113

14 018 DT 018 118 NO:118 91118 92118

14 019 DT BACK ROOM 019 119 BACK RM NO:119 91119 92119

System/Station Administration

CSN 
(Cabinet 
Slot 
No.)

Phy. 
Port 
No. PT

Telephone
Location

Log 
Port 
No.

Int/ 
PDN 
No.

Telephone LCD
User Name

VM CF
Id Code

VM MW
Id Code

12 000 DT LOBBY 000 100 ATTENDANT NO:100 91100 92100

12 001 DT 001 101 NO:101 91101 92101

12 002 DT 002 102 NO:102 91102 92102

12 003 DT 003 103 NO:103 91103 92103

12 004 DT 004 104 NO:104 91104 92104

12 005 DT TELEPHONE ROOM 005 105 PHONE RM NO:105 91105 92105

12 006 DT 006 106 NO:106 91106 92106

12 007 DT KITCHEN 007 107 COOK NO:107 91107 92107

14 008 DT FRONT OFFICE 008 112 BOSSNO:112 91112 92112

14 009 DT PLAY ROOM 013 117 PLAY RMNO:117 91117 92117

14 010 DT 010 114 NO:114 91114 92114

14 011 DT 011 115  NO:115 91115 92115

14 012 DT 012 116  NO:116 91116 92116

14 013 DT 009 113  NO:113 91113 92113

14 014 DT 014 118 NO:118 91118 92118

14 015 DT BACK ROOM 015 119 BACK RMNO:119 91119 92119
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Program Changes Before/After Release 4.0 Upgrade
The following examples show the type of programs and data that must change when upgrading 
from DK14/DK16e/DK40 Release 1 and DK280/DK424 Release 1~Release 3 to DK424 
Release 4.0. These program changes are required to make the Strata DK operate the same after 
the upgrade as it did before; thus making the upgrade transparent to the end user. The changes 
apply to all DK424 Release 4.0, RCTU processors: RCTUA, RCTUB, RCTUBA/BB,
RCTUC/D, and RCTUE/F.

Basically, any program that has station ports as data needs to change if the station port 
numbers are higher than the pre-upgrade DID/Tie line port numbers. The examples shown 
here represent the types of DK programs that require changes when upgrading to Release 4.0. 
They are not meant to show all programs since the principles of program changes are the same 
for each program type.

The program examples show required programming changes (when upgrading to a DK424 
Release 4.0 and above processor) can be complex when a system has DID and Tie lines.

The following examples show the program changes required when upgrading RCTUE3/F3 to 
RCTUE3/F4. The DKAdmin Cabinet Drawing and System/Station Administration Screen for 
this example are provided in Figures 33~34. 

Programs 01 and 02

These programs show the relationship between physical and logical ports. When upgrading to 
Release 4.0, these relationships remain the same unless ports have been swapped prior to the 
upgrade. If the swapped port numbers shift during the upgrade, they must be renumbered in 
Programs 01 and 02. If the swapped ports do not shift during the upgrade, they remain the 
same after the upgrade.

In this system configuration, ports 013 and 017 are swapped prior to the upgrade (see Figure 
33). After the upgrade, port 013 shifts to 009 and 017 shifts to 013 (see Figure C-4), therefore 
after the upgrade port 009 is swapped with port 013. Notice that before and after the upgrade, 
the Play Room telephone is on the second PDKU circuit in slot 14 and to call the Play Room 
Telephone you must dial 117 - making the upgrade transparent to the end user. 

Program 03 

There is no change to the data in this program when upgrading to Release 4.0; however the 
RDDU DID lines are not allocated ports after the upgrade (see Figures 31 and 32).

Program 04

Data in this program must be changed to adjust for port shifting caused by the RDDU DID line 
PCB in slot 13 (see Figures 33 and 34):

Before the Upgrade After the Upgrade

Port 000-007; Data 100-107 Port 000-007; Data 100-107

Port 008-015; Data 108-115 Port 008-015; Data 112-119

Port 016-019; Data 116-119 Port 016-019; Data Blank
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Programs *04, 05, 09

There is no change to the data in these programs when upgrading to Release 4.0. Note that 
DID/Tie ports do not cause Phantom DN ports to shift in Strata DK Release 1~Release 3 
systems, so they do not shift in Program *04 when upgrading to Release 4.0. Also, the data in 
Program 09 is DN numbers and not port numbers, so data in Program 09 does not change 
when upgrading to Release 4.0.

Program *09

Data in this program must be changed to adjust for port shifting caused by the RDDU DID line 
PCB in slot 13 (see Figures 33 and 34):

Programs 10-1 through 10-4

There is no change to the data in these system programs when upgrading to Release 4.0. Port 
numbers are not assigned to system programs so no adjustments are necessary.

Program 13

If the Message Center is the Front Office Telephone (PDN 112), data in this program must be 
changed to adjust for port shifting caused by the RDDU DID line PCB in slot 13 (see Figures 
33 and 34):

♦ Data for Program 13 before the upgrade = 012

♦ Data for Program 13 after the upgrade = 008

If the Message Center is the Lobby Telephone (PDN 100), data in this program must not be 
changed to adjust for port shifting caused by the RDDU DID line PCB in slot 13. This is 
because Port 000 did not shift after the upgrade (see Figures 33 and 34):

♦ Data for Program 13 before the upgrade = 000

♦ Data for Program 13 after the upgrade = 000

Programs 15, 16, and 17

There is no change to the data in these programs when upgrading to Release 4.0. These are CO 
line programs and port numbers are not assigned in them so no adjustments are necessary.

Program *17

If the DID Intercept Destination is the Back Room Telephone (PDN 119), data in this program 
must be changed to adjust for port shifting caused by the RDDU DID line PCB in slot 13 (see 
Figures 33 and 34):

Program *17 data for DID lines 001~004 before the upgrade = 019

Program *17 data for DID lines 001~004 after the upgrade = 015

Before the Upgrade After the Upgrade

Port 000-007; Data 100-107 Port 000-007; Data 100-107

Port 008-015; Data 108-115 Port 008-015; Data 112-119

Port 016-019; Data 116-119 Port 016-019; Data Blank
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If the DID Intercept Destination is the Kitchen Telephone (PDN 107), data in this program 
must not be changed to adjust for port shifting caused by the RDDU DID line PCB in slot 13. 
This is because Port 007 did not shift after the upgrade (see Figures 33 and 34):

Program *17 data for DID lines 001~004 before the upgrade = 007

Program *17 data for DID lines 001~004 after the upgrade = 007

Program 20

If the Front Office Telephone (PDN 112) is equipped with an RPCI-DI to display DNIS and 
Caller ID on a PC running a TAPI application, the data in Program 20 must shift. This enables 
the Front Office Telephone and RPCI to operate the same way after the upgrade as it did 
before. Notice that all Program 20 data for port 012 moves port to 008.

Program 30

If the Back Room Telephone (PDN 119) is programmed to dial forced and verified Account 
codes when making outside calls, the data in Program 30 must shift. This is to allow the Back 
Room Telephone to operate the same way after the upgrade as it did before. Notice that all 
Program 30 data for port 019 moves to port 015.

Program 33

If the Front Office telephone (DN 112) is programmed to hunt to the Back Room Telephone 
(PDN 119), the data in Program 33 must shift:

If the Front Office telephone (PDN112) is programmed to hunt to the Lobby Telephone 
(PDN 100), the data in Program 33 must shift:

Before the Upgrade After the Upgrade

Port 008
LED17 on, all others off (Program 20 
default)

LED 01,02,10, 11, and 17 on, all 
others off

Port 012
LED 01,02,10, 11, and 17 on, all 
others off

LED17 on, all others off

Before the Upgrade After the Upgrade

Port 015
LED 01, 05, and 07 ON, all others off 
(Program 30 default)

LED 01, 05, 07, 08, and 14 ON, all 
others off

Port 019
LED 01, 05, 07, 08, and14 on, all 
others off

LED 01, 05, and 07 on, all others off 
(Program 30 default)

Before the Upgrade After the Upgrade

Hunt-From Port 012 to Port 019 Hunt-From Port 008 to Port 015

Before the Upgrade After the Upgrade

Hunt-From Port 012 to Port 000 Hunt-From Port 008 to Port 000
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Program *33

If the Back Room telephone (PDN 119) is programmed as the Owner of PhDN 500, the data in 
Program *33 must shift:

Programs 39, 29, *29, and 59

When a port number shifts from XXX to YYY during an Release 4.0 upgrade, the following 
Program changes must be made:

♦ In Program 39, the data set for port XXX must be copied over the data set for port YYY.

♦ In all Telephone/Console button programs, the appearances of the XXX port PDN/SDN 
Button (##XXX) and DSS Button (#XXX) must be changed to ##YYY and #YYY, 
respectively, on all keystrips.

Example: The Front Office Telephone changes from port 012 to port 008 during the 
Release 4.0 upgrade (see Figures 33 and 34). 

As shown below, all the button functions of the Front Office Telephone do not change after the 
upgrade, but the Program 39 codes for PDN, SDN and DSS buttons change if the associated 
PDN/SDN or DSS port shifts. Also PhDN, Speed Dial, and Feature button codes do not 
change when ports shift.

Programs *42-1 and *42-2

Although this example does not include an RDTU (T1) PCB, it should be noted that these 
programs require an RDTU slot number entry with DK Release 4.0. DK Admin/DK Backup 
automatically inserts the correct slot number for these programs during the upgrade process.

Before the Upgrade After the Upgrade

PhDN Port 500 is owned by Port 019 PhDN Port 500 is owned by Port 015

10-Button Keystrip for Front Office 
Telephone on Port 012 -Before Upgrade

10-Button Keystrip for Front Office 
Telephone on Port 008 -After Upgrade

Key No. Code Name Key No. Code Name

K10 497 SDS K10 497 SDS

K09 498 DND K09 498 DND

K08 *103 SD103 K08 *103 SD103

K07 *102 SD102 K07 *102 SD102

K06 *101 SD101 K06 *101 SD101

K05 #017 DSS117 K05 #013 DSS117

K04 ##500 PhDN 500 K04 ##500 PhDN 500

K03 ##019 SDN 119 K03 ##015 SDN 119

K02 #000 DSS100 K02 #000 DSS100

K01 ##012 PDN 112 K01 ##008 PDN 112
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Index
A
ACD

administration, 70
agent programs, 72
edit ACD programs, 70
edit agent programs, 72
view notes on program, 71, 75

ACD/DID assignments, 114
add-on-module

change assigned feature, 64
clear port, 64
copy feature, 64
edit assignments, 63
make assignments to another port, 63

administration
ACD, 70
administration menu, 43
directory number, 85
distributed hunt group, 92
DNIS, 89
download data, 74
edit data, 74
program, 73
station, 44
system, 44
upload data, 74
view all programs, 74

after connect string, 38, 131–133, 135, 137
assignments

add-on-module buttons, 63
attendant console buttons, 66
call forward, 93
CO line, 55

ringing, 93
distributed hunt group, 92
DNIS

network table, 91
number/name/ringing/VM-ID, 90

tenant lock, 92
DNIS/DID ringing, 93
DNIS/DID/ANI line, 89
DSS console buttons, 65
flexible buttons, 54, 61
maintain directory numbers, 85
speed dial, 55
system messages, 56

attendant console
assigning features to another console, 67
edit flexible buttons, 67
flexible button assignments, 66
key default settings, 67
reset keys, 67

attributes
copy a range, 53
definitions, 50
program/update, 49

B
background char, 121
backup

data, 100
menu, 99

backup/restore option, 99
check processor type option, 100

basic operations, 2
baud rate

serial port, 124, 128
baud rate (serial port), 105
before you start, 27
button assignment

attendant console, 66
DSS console, 65
flexible, 61, 88
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C
call forward

assignments, 93
set/change assignments, 93
use system program files to edit, 94

calling Strata DK using dialer, 129
CAMA trunk programs (see E911/CAMA trunk

programs
check processor type option, 100, 102, 108
CO line, 55

access codes, 91
flexible key assignments, 88

COM port, 124, 127
communication

dialing strings, 41
unable to establish, 100, 102, 109
update dialing strings, 41

communication setup
display settings, 125
PC DIU/DIU modem pool to modem, 137
remote modem to external modem/TTY 

port, 132
remote modem to modem pool, 135
remote modem/Strata DK IMDU, 133

communications
setup, 124

connection
configurations, 127
direct, 130
DIU to DIU, 131
external modem to Strata DK TTY port, 144
hangup, 42
PC DIU/DIU modem pool to Strata DK 

modem, 137
remote modem to external modem/TTY 

port, 132
remote modem to modem pool, 135
remote modem to Strata DK IMDU (or external 

modem), 133
Strata DK telephone system, 15, 25

conventions
keyboard, 31

customer
address, 37
contact name, 37
dialer setup, 130–133, 135, 137
ID, 37
maintain file, 108
name, 37

on-screen information, 40
phone number, 37
record

create, 36
delete, 39
modify, 39

select, 39
upgrade processor, 37

D
data

backup, 100
download, 41, 100
upload, 41

data bits
serial port, 124, 128

dial DK, 131
dialing strings, 40
option, 40, 100, 102

directory numbers
administration, 85
maintain assignments, 85
set/change CO line flexible key 

assignments, 88
set/change information, 86
specify ringing options, 87

distributed hunt group, 92
display/update CO line ringing 

assignments, 93
display/update DNIS/DID ringing 

assignments, 93
maintain assignments, 92

DIU string, 37, 131–133, 135, 137
DK Admin

logging off, 33
DKAdmin

basic operations, 2
before you start, 27
capabilities, 1
connection to telephone system, 15
first time run, 12, 22
install program, 10, 20
keyboard conventions, 31
logging off, 33
logging on, 27
on-line help, 32
password, 12, 22
program list, 76
pull-down menus, 32
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screen conventions, 4
security, 78
software release, 38
system requirements, 7
using, 27

DKBackup
about, 42
backup/restore, 99
check system, 17
install program, 18
software release, 38

DNIS
address reference numbers, 90
administration, 89
network table assignments, 91
number/name/ringing/VM-ID 

assignments, 90
tenant lock assignments, 92

DNIS/DID ringing, 93
DNIS/DID/ANI line assignments, 89
documentation

conventions, viii
how to use this manual, ix
related, ix

download data, 41, 100
DSS console

assignments to another console/console 
group, 66

button assignments, 65
change assigned feature, 65
default key settings, 65
resetting all keys, 65

E
E911/CAMA trunk programs

access, 94
edit programs, 95
use Strata DK’s program files, 96
view notes on program, 96

error messages, 32
exit system, 33
external modem, 133, 143–144

TTY port connection, 141

F
file menu, 35, 115, 131, 133

about option, 42
dial DK option, 40
hangup connection option, 42

maintain customer file option, 36
select customer option, 39

find feature, 5
flexible buttons, 61

change assigned feature, 61
programming, 61
set/change CO lines, 88
view assignments, 54

H
hangup connection option, 42
hardware

key, 18
requirements, 127

help (on-line), 32

I
IMDU, 133
individual port

program, 46
program/update attributes, 49
update, 46

install program, 18
installation, 10, 20

system, 117
ISDN programs

access, 97
edit programs, 97
use Strata DK’s program files, 97
view notes on program, 98

K
keyboard, 31

L
LCD messages, 49
line

ringing options, 87
logging off, 33
logging on, 27

M
maintain customer file option, 36
menu

administration, 43
backup, 99
dial DK, 132
DK dial, 132
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file, 35, 115, 131, 133
item selector, 119
options, 117
password level access, 123
pull-down, 32
system installation, 118

menu options
about, 42
ACD administration, 70
ACD agent programs, 72
ACD programs, 70
add-on module button assignments, 63
attendant console flexible button 

assignments, 66
call forward assignments, 93
change colors, 118
check processor type, 100
communications setup, 124
company general information, 117
dial DK, 40
directory number administration, 85
distributed hunt group administration, 92
DNIS administration, 89
DSS console button assignments, 65
flexible button programming, 61
hangup connection, 42
maintain customer file, 36
printer type selection, 119
program administration, 73
program security maintenance, 77
reindex files, 125
screen/type color installation, 118
select customer, 39
speed dial programming, 68
station speed dial numbers, 69
system installation, 117
system miscellaneous variables, 120
system speed dial numbers, 68
system/station administration, 44
telephone flexible button assignments, 61
user password level setup, 121
view/print data, 115

message
error, 32
system, 32, 56

modem
connection to Strata DK IMDU, 133
direct modem initialization, 125
DIU initialization, 125
external maintenance modem installation, 142

external modem, 144
PC DIU/DIU modem pool connection, 137
port, 105
string, 37, 131–133, 135, 137

modem pool
DIU connection, 129
PC DIU/DIU, 137
PDIU-DS installation, 141
remote modem connection, 135

N
network telephone numbers, 91

O
on-line help, 32
options menu, 117

P
[PDN]

changing information, 86
parity

serial port, 124, 128
password, 12, 22

add users, 122
administrator level I access, 122
administrator level II access, 122
assign, 122
changing user/password information, 124
default levels, 77
deleting user password, 124
file maintenance program, 121
level, 122
level 1 and 2, 101
level 9, 78
level menu access, 123
master access, 122
set/change station port numbers, 92
setup, 121
station port numbers, 92
tech level I access, 122

PIOU/PIOUS/RSSU setup, 128
port

attributes
copy a range, 53
definitions, 50
program/update, 49

printing, 56
port assignments, 108
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print
customer program, 115
port/station information, 47
printer selection screen, 115
printer type selection, 119
select printer, 120

processor
upgrade, 37
upgrade RCTU processor, 107

program
*04, 76, 108, 112, 114, 158
*09, 76, 106, 108, 112, 158
*17, 158
*29, 160
*33, 160
*42-1, 160
*42-2, 160
00, 101, 114
01, 157
02, 157
03, 76, 105, 109, 112, 114, 128, 150, 157
04, 76, 106, 112, 114, 157
05, 158
09, 158
10-1, 158
10-2, 158
10-3, 158
10-4, 158
13, 158
15, 158
16, 158
17, 158
20, 159
29, 160
30, 159
33, 159
38/39, 76
39, 108, 160
59, 160
71-0, 108
76, 76, 105, 112, 128
76-0, 76, 150
77-1, 102, 106, 128
90, 76
91, 76
92, 76
92-1, 107, 113
ACD, 70
ACD Agent, 72
administration, 73

list, 76
PRGALL, 76
REPALL, 76
security maintenance, 77

programming
flexible button, 61
individual port attributes, 49
speed dial, 68

pull-down menus, 32

Q
quick-start procedure

new customer installation, 36

R
RCTU processor PCB upgrade, 107
reindex files, 125
remote modem

connection to modem pool, 135
external modem/TTY port, 132

restore
prior to restoring data, 102
restoring data, 102

ringing options, 87
RMDS, 133
running DKAdmin, 12, 22

S
screen

change colors, 118
change your monitor or color setups, 118
color installation, 118
color/monochrome, 118
conventions, 4
mode, 118
on-screen customer information, 40
password file maintenance, 124
printout destination selection matrix, 120
process complete, 106, 112
reset colors, 118
security maintenance, 77
system program file, 101
type, 118
variations, viii

security
change password, 12, 22
default levels, 78
program maintenance, 77
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select customer option, 39, 100, 102
select printer, 120
serial communications port, 124
serial ports

baud rate, 105
shift-function keys, 121
software release, 38
speed dial numbers

assignments, 55
change, 48
edit station assignments, 69
edit system assignments, 68
programming, 68
set, 48
station assignment, 69
system, 48
system assignment, 68

station
attributes

copy a range, 53
definitions, 50
program/update, 49

information, 47
speed dial numbers, 69

stop bits
serial port, 124
serial ports, 128

system
check requirements, 7, 17
connection, 25
connection configurations, 127
dial DK, 40
error messages, 32
exit, 33
hardware requirements, 127
install program, 10, 18, 20
installation menu, 118
logging off, 33
logging on, 27
messages, 32, 56
miscellaneous variable, 120
on-line help, 32
program file, 101, 109
program file screen, 101
run for first time, 12, 22
set/change LCD messages, 49
speed dial numbers, 48, 68, 108
Strata DK connection, 127

system/station administration, 44

T
telephone flexible buttons

assignments, 61
change feature, 61

transfer
DK program data screen, 42

TTY port, 105, 108, 129, 132, 141, 144

U
upgrade

DK system to DK424 R4, 149
important things to do after, 147
off-site, 145
on-site, 146
processor, 37
RCTU processor, 107
release 4 configurations, 149
release 4 program example, 154
to RCTUE/F, 145

upload data, 41
uploading programmed data, 56
user password, 121

V
variables

background char, 121
bell on, 120
change system variables, 120
confirm entries, 120
proper case conversion, 121
shift-function keys, 121

view
CO line assignments, 55
customer program, 115
flexible button assignments, 54
notes on ACD program, 71, 75
notes on E911/CAMA trunk programs, 96
notes on ISDN programs, 98
reports screen, 115
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